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Attributions: groov uses libraries and resources that individuals and groups around the world have made freely available
over the web, including:

Font Awesome by Dave Gandy - http://fontawesome.io

Entypo pictograms by Daniel Bruce - http://www.entypo.com

Momentjs - http://momentjs.com/ - License at https://github.com/moment/moment/blob/develop/LICENSE
jquery - https://jquery.com/ - License at https://github.com/jquery/jquery/blob/master/LICENSE.txt

Bootstrap 3 Datepicker - License at https://github.com/Eonasdan/bootstrap-datetimepicker/blob/master/LICENSE
GWT Bootstrap 3 - License at https://github.com/gwtbootstrap3/gwtbootstrap3/blob/master/LICENSE

GWT Bootstrap 3 Extras - License at https://github.com/gwtbootstrap3/gwtbootstrap3-extras/blob/master/LICENSE
Jamod - License at http://jamod.sourceforge.net/license.html

GWT DragDrop - License at https://github.com/fredsa/gwt-dnd/blob/master/DragDrop/LICENSE

GWT Log - License at https://github.com/fredsa/gwt-log/blob/master/Log/LICENSE

Joda Time - License at https://github.com/JodaOrg/joda-time/blob/master/LICENSE.txt
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1: Welcome

WHAT IS groov VIEW?

groov View is Opto 22's operator interface tool that is simple, browser-based, and connected to automation
systems, software, databases, and devices of all kinds. We call it Mobile Made Simple .

Simple: groov View requires only a web browser to connect to devices, build operator interfaces, and monitor
and control them. groov View puts ready-made gadgets at your fingertips; just drag, drop, and tag. Create
real-time trends up to 5 years; define events and operator notifications. Authorize users and groups. groov
View makes it simple to build, deploy, and view effective, scalable operator interfaces.

Browser-based: To view your groov View interface, use any brand computer or mobile device with a web
browser, from smartphones and tablets, to laptops and computers, to a web-enabled big-screen TV. For
mobile, get the free groov View app for Android or iOS. groov View can augment existing human-machine
interfaces (HMIs) and SCADA systems by making specific data available to authorized users at any time and in
any location. Use event notifications to alert selected personnel anywhere about system events based on one
or more conditions.
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WHAT IS GROOV VIEW?

Connected: In your groov View operator interface, you can use tags from all the sensors, equipment, and
software connected to your groov EPIC, groov Server for Windows, or legacy groov Box—which may be from a
wide variety of manufacturers and software companies. Mix data and controls from all of these connected
things in your operator interface in any way that suits your application. You can also test project ideas without
connecting to a live machine or system, using the built-in Data Simulator.

groov View brings key data from processes, sensors, OEM machines, manufacturing and building systems,
software, databases, and online services into the hands of those who need it.

Connecting Data and Users

groov View connects to a variety of data sources and presents that data to users for visualization and action.
Your groov View users may be human operators or software that uses the groov Data Store API.

The image below shows how groov View connects data sources and users. Automation data sources are on
the left; they interact directly with groov View. On the right are software users that write data to a groov Data
Store or read data from that store, via the API. (In a groov EPIC system or legacy groov Edge Appliance, you may
also have Node-RED and Ignition Edge® OPC-UA and MQTT tags as sources of data.)

At the bottom of the image are human operators who interact with your groov View interface; they can
securely view and act on data from automation sources, Data Stores, and other sources, as you determine. You
manage all users and control what each one can see and do.

groov EPIC®

Opto 22
SNAP PACs

"'Ml Ia Databases
yl \ Vo d 4 j

VIEW
Opto 22 groov RIO and

SNAP PAC I/0 units Data { }4—,.
/ A||:’| ‘\

Online
services
(Weather, maps)

Applications
like Excel or
custom software

Lo
UNIFIED Fﬁ[[ TURE

OPC UA Server

¢ Allen-Bradley and
Siemens PLCs,

® BAS,

® More

Operators

Build your Operator Interface

To build your groov View operator interface, you have a library of pre-built gadgets you can simply drag and
drop onto the screen. Then you import and use tags from systems and equipment, including Modbus/TCP
devices, Opto 22 groov EPIC processors and groov RIO units, SNAP PAC controllers and I/0 units, and many
other manufacturers’systems, equipment, and databases. You can also manage user accounts and set up
email or text message event notifications in Build mode.
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View your Interface

The groov View operator interface you build resides on a groov EPIC controller, groov Server, or a legacy groov
Box. Your human users access the interface using any device with a web browser and a network connection to
groov View running on one of those groov devices, or using the free groov View app on an iOS or Android
smartphone or tablet.

Read Only
e

Start-Stop

T @

groov View on a tablet and a smartphone

Mobile Device Apps

groov View for iOS and groov View for Android are free native apps for your tablet or phone. You can run
groov View in your browser, but these apps display your interface in full-screen mode.
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WHAT IS GROOV VIEW?

4

izon %+ 1047 AM

& 192.168.0.107

View in browser

View in app

These native apps add other advantages as well. You can add another layer of security by setting up passcodes
in the app. If you have more than one groov View project, you can easily access all of them from the app. The
i0S app is also ideal for OEMs and machine builders who want to use a tablet as an operator interface to a
machine. You can lock the device so it runs only groov View.

Get groov View for

iOS.

Get groov View for Android.

Comparing Build Mode and View Mode

The following chart shows some key points about building and viewing your operator interface.

Build mode View mode

What it’s for

Who uses it

Passwords and
API Keys

groov View User's Guide

Building an operator interface:

» Connect to devices and systems
+ Build screens

+ Create events and notifications
 Authorize users

« Back up projects

Authorized users:

* An Admin has full control

+ An Editor can change pages but cannot
authorize users

Password:

* An Admin sets the username and password
at first login to groov View.

* An Admin user can assign usernames and
passwords (and API keys, for software
users) to all users.

Viewing an operator interface:
» Monitor and control equipment/systems
» View or change data

Authorized users:

» An Operator can log in/out and change
password

« Kiosk users cannot log out or change
password

Password:
Ausername and password are assigned to
each user by an Admin.


https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://play.google.com/store/apps/details?id=com.opto22.aWD
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Build mode View mode

1. Open a web browser. For the URL, enter:  groov EPIC
groov Edge Appliance (Box) or groov 1. Open a web browser. For the URL,
EPIC enter:

https://[hostname]/ or
https://[IP address]/

groov Server
https://localhost/ or
https://[Server’s hostname
or IP address]/

2. From groov View, click Settings (gear in

upper right), and choose Switch to Build

https://[hostname]/ or
https://[IP address]/
2. Click groov View.

groov Edge Appliance (Box)

Open a web browser. For the URL, enter:
https://[hostname]/ or
https://[IP address]/

How to get
there

mode.

groov Server

Open a web browser. For the URL, enter:
https://localhost/ or
https://[Server’s hostname
or IP address]/

On a mobile device, use the free

groov View app for iOS or Android. Open
the app and log in with your username and
password.

For a groov EPIC or groov Box (does not apply

to groov Server for Windows):

* Click Search For Devices.

* Find the label on the groov device that
shows its serial number.

e For groov EPIC, click groov Manage and
then groov View. For a groov Box, click
groov View.

How to get
there in groov
Find (Windows
or Mac)

[Not normally used]

Products that Include groov View

groov View is part of the groov EPIC processor, the PC-based groov Server for Windows software, and the
legacy groov Edge Appliance (groov Box).

groov EPIC (edge programmable industrial controller, part number GRV-EPIC-PR1) is a system for automation
and industrial internet of things applications. groov EPIC provides real-time control, connectivity to industrial
and IT equipment and systems, data handling at edge of network, and visualization for your system. Learn
more about the groov EPIC system.

groov Server for Windows (part number GROOV-SVR-WIN-BASE) provides visualization only and can be
installed on a Microsoft® Windows® PC. Once installed, groov Server runs as a service on your computer.

groov Edge Appliance (part number GROOV-ART-BASE), also called the groov Box, is an industrially
hardened appliance that provides connectivity, data handling, and visualization. It is a legacy product as of
June 2021 and not recommended for new development. For new projects, choose groov EPIC.

No matter which of these groov products you use to serve groov View, your groov View operator interface can
be viewed on almost any mobile device or computer. And you can develop on one groov product and later
move your project to another: for example, develop on groov Server and then move the project to groov EPIC.

«  Formore information on groov EPIC, see the groov EPIC Data Sheet (form 2245).
«  Forgroov Server, see the groov Server for Windows User’s Guide (form 2078).
»  Formore on the groov Box, see the groov Box User’s Guide (form 2104).

groov View User's Guide 5
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SYSTEM REQUIREMENTS

SYSTEM REQUIREMENTS

To build operator interfaces with groov View, you'll need:
«  Any computer with a web browser (does not have to be a Windows PC)
«  One of the following:

- groov EPIC

- groov Server for Windows

- alegacy groov Box Edge Appliance

You can connect to any of the following devices or services to get and send data:

- AModbus/TCP device

- Adatabase, online service, or software program to get data from or put data into a Data Store using
the groov View API

- An Opto 22 groov EPIC processor or SNAP PAC controller (SNAP PAC S-series, R-series, or SoftPAC,
with firmware R9.2a or newer), running a PAC Control strategy

- AnOpto 22 groov EPICI/O unit

- AnOpto 22 groov RIO unit

—  An Opto 22 SNAP PACI/O unit

- (groov EPIC or legacy groov Box only) A database, cloud application, API, or serial device accessible
via a Node-RED node. (For a groov Box, see requirements in the user’s guide.)

- OPCUA-compatible automation system or equipment. Ignition Edge supplies an internal server and

drivers for groov EPIC or a legacy groov Box. An external OPC-UA server is required for groov Server;
an external server and additional drivers may be required for your equipment.

NOTE: Browser-based groov View software works on a large number of device/operating system/browser
combinations, including HDTVs, smartphones and tablets, and computers. If one browser is causing issues, however,
try another one and let us know what issues you've seen. For Product Support, see page /.

ABOUT THIS GUIDE
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This user’s guide teaches you how to build and view an operator interface with groov View.

This guide assumes that you have already set up your groov product and that you are already familiar with
your personal computer’s operating system and how to use your tablet or smartphone.

To set up groov EPIC, see form 2267, the groov EPIC User’s Guide.
To install groov Server for Windows, see form 2078, the groov Server for Windows User’s Guide.

To set up a groov Box, see form 2104, the groov Box User’s Guide for GROOV-AR].

In this Guide

Chapter 1: Welcome introduces this user’s guide and groov View.

Chapter 2: Building a Project walks you through building a sample project, and then describes how to
create pages, add devices and tags, and configure gadgets.

Chapter 3: Managing groov View describes how to manage user accounts, back up and restore your
project, and update groov View and your license.

Chapter 4: Gadget Reference provides details on how to configure gadget properties.

Chapter 5: Using Events and Notifications describes how to set up user accounts and event conditions in
groov so that users can be notified about system status. Events can also be used as tags with gadgets.
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CHAPTER 1: WELCOME

Chapter 6: Viewing Your Operator Interface describes how to open and use a groov View HMI on any
device with access to the Internet.

Chapter 7: Troubleshooting and Additional Help provides troubleshooting information and answers
questions you may have about groov View.

A: IP Cameras describes the IP cameras that work with the Video gadget.

B: OPC UA Data Types Supported lists the OPC UA data types supported in groov View and the
corresponding groov View names.

C: Data Simulator Tags lists the Data Simulator tags and briefly describes what they do.

OTHER groov RESOURCES

Get free online training for groov View and related products at training.opto22.com. For additional information
on related products, visit the Opto 22 website, www.opto22.com.

PRODUCT SUPPORT

If you have any questions about groov View, you can call, fax, or e-mail Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free NOTE: Email messages and phone calls
in the US. and Canada) to Opto 22 Product Support are
951-695-3080 grouped together and answered in the
Monday through Friday, order received.
7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: WwWWw.opto22.com

When calling for technical support, be prepared to provide the following information about your system to
the Product Support engineer:

«  groov product you are using (groov EPIC, Server, or Box) and license
«  groov version. In Build mode, select Help > About.
«  Adescription of your system equipment:

—  Computer type, speed, memory, and operating system

- Brand and model numbers for the controllers or devices you are monitoring and controlling through
groov

«  Adescription of the network
«  Specific error messages or other diagnostic indications

groov View User's Guide 7
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2: Building a Project

This chapter describes the basic aspects of creating an operator interface in groov Build mode, including how
to create pages, add devices and tags, and configure gadgets. The operator interface you build resides on the
groov EPIC processor or groov Box, or on the PC where groov Server is installed. Your authorized users can
access it from a computer, smartphone, tablet, or other device with a web browser.

In this chapter:

Opening Build Mode on groov EPIC 10
Opening Build Mode on a legacy groov Box 10
Opening Build Mode in groov Server for WiNdOwWs............oveeeevvessnnn 10
Building a Sample Project 11
Working with Pages 20
Working With a Device 27
Adding Gadgets 67
Editing Gadgets 69
Optimizing Layouts 72

OPENING BUILD MODE ON groov EPIC

These steps assume you have already installed and initialized your groov EPIC processor following the steps in
form 2267, the groov EPIC User’s Guide.

To create your groov View HMI, you must be on a computer. Once the HMI is built, you can use it on the
groov EPIC processor’s built-in high-resolution touchscreen.
1. From a computer, log into the groov Manage Home screen.
2. (lick the groov View button .
groov View opens first in View mode.
3. (lick Menu (gear icon) on the top right-hand side and click Switch to Build mode.

‘ Events £+ Menu

# Switch to 3uild@ocle

& Change password
B View logs

i About groov View
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OPENING BUILD MODE IN GROOV SERVER FOR WINDOWS

OPENING BUILD MODE IN groov SERVER FOR WINDOWS

The first time you open groov View, make sure to follow the instructions in form 2078, the groov Server for
Windows User’s Guide.

1. Open Firefox, Chrome, or Internet Explorer 10 or newer and do one of the following:

- If groov Server is installed on the same computer, type https://localhost in the address bar
of your browser.

> & £ [ [ https://localhost ~ —J———Address bar

- If groov Server is installed on a different computer, type https:// and the computer’s hostname. For
example, if the computer’s hostname is RStarr-w10, you type https://RStarr-wl0

You can use the IP address of the host PC instead of the hostname. However, if the PCiis on a
network with DNS and DHCP, the IP address is subject to change.
NOTE: If groov View does not open, see Chapter 7: Troubleshooting and Additional Help

2. When groov View opens, log in.
groov View opens first in View mode.
3. (lickthe gearicon (Menu) on the top right-hand side and click Switch to Build mode.

‘ Events £+ Menu

Gear icon

# Switch to 3ui|d@ocle
& Change password
B View logs

About groov View

OPENING BUILD MODE ON A LEGACY groov BOX

10

The first time you open groov View, make sure to follow the instructions in form 2103, the groov Quick Start for
GROOV AR1. For additional information, see form 2104, the groov Box User’s Guide for GROOV AR1.

NOTE: In order to use a URL hostname, your network must have a DNS. If it doesn’t, see page 156 for information on
how to use groov Find.

1. Enter https:// and your groov Box's hostname as the URL. The hostname is printed on the bottom of the
groov Box.

For example, if the hostname is opto-00-d2-dc, you type:
https://opto-00-d2-dc

NOTE: Ifyou've assigned a static IP address to the groov Box, use the IP address instead of the hostname to open
groov.
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CHAPTER 2: BUILDING A PROJECT

GROOV-AR1 Z C€
Serial Number: 888888

Default Hostname: opto-00-d2-dc
\ ETHO: 00-A0-3D-00-D2-DC ETHI: 00-A0-3D-00-D2-DD

Hostname

When groov View opens, enter your username and password.
groov View opens first in View mode.
Click Menu (gear icon) on the top right-hand side and click Switch to Build mode.

‘ Events £ Menu

Switch to 3ui|d@ocle

Change password
View logs

i About groov View

BUILDING A SAMPLE PROJECT

To get started, let's build a page using tags in the Data Simulator and then view it on the computer. Here's
what we'll do:

Add a page

Add a device (page 13)

Add device tags (page 14)

Add gadgets (page 14)

Save the project (page 17)

View the project on your computer (page 17)
Explore (page 17)

When Build mode opens, you see the workspace where you'll build your operator interface:
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Choose gadgets and tags. —
Page as viewed on computer or tablet Page as viewed on smartphone . )
Assign gadget properties.
File Edit View Configure Security | Help A
Desktop & Tablet
No page selected. Create a new page on the Pages panel.
List of all pages in your
interface >
Page you're working
on appears here. > Tags
Configure Device:
Events
Add pages and‘ ] 1| ® Local 7o
organize them into

. (Add Page...
categories. ————» | uia careqory,

.
See properties for the o
page highlighted in
the list,. ————»
Add a Page

1. Inthe Pages panel on the left side of the workspace, click Add Page.

Create Page

Page Configuration Page Permissions

Page Name: Pump Room Access Rights: | All Users v

Background Color: n Select groups that may access this page
EEEEN ] =

OK Cancel

2. Give the page a name and click the color block to choose a background color. For now, leave the page as
Uncategorized and leave Access Rights as All Users. Click OK.

The blank page appears in the center of the workspace.
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Add a Device

1. Inthe Gadget Palette panel (lower right), click Configure Devices & Tags.

Fle Edit View Configure Security Help

=N | oeskiop & Tabiet [T Gadget Properties

¥ Uncategorized

Main*®

Gadget Palette
Tags

&nnﬁgure Devices & Tags... )

Events

Add Page... ———— _ =
Add Category... | Increase Height | [ Zoom out to show page stash ] Show grid

Page Properties

Name Mazin

Color

Edit Page Permissions...

(] Hidden -

2. On the right side of the Configure Devices and Tags window, click Add New Device. Select Data
Simulator.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥

Local If/O Opto 22 I/O Unit localhost:2001 Idle Opto 22 I/0 Unit
Opto 22 Controller
OPC UA Server
Modbus Device
Data Simul@tjﬂr

System
Data Store

3. Click Close.

groov View User's Guide 13



BUILDING A SAMPLE PROJECT

Add Device Tags

1. Inthe Gadget Palette panel, click the plus sign next to Data Simulator.

Fle Edit View Configure Security Help A Groov
Desktop & Tablet [JEEU0IEE Gadget Properties.

¥ Uncategorized

Main*®

Gadget Palette
Tags

Configure Devices & Tags...

Data Simulator)
Events
[ i
Add Page...
Add Category...
Page Properties

Increase Height Zoom out to show page stash Show grid
Name | Main

Color

Edit Page Permissions...

Hidden

2. C(lick the plus signs in the tree to see the tags in the device.

Tags EeELLEE

Configure Devices & Tags...

& Data Simulator

& Basic
Variables
General
Square Waves
Sine Waves

& Advanced
Variables (Extra)
Arrays

Add Gadgets
1. Expand the tree to find bool Variable A. Click this tag.
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Alist appears showing all the gadgets that work with this tag.

bool Variable A
get Palette

O & | bes

Checkbox figure Devices & Tags...
Button Data Simulator
Command Button = Basic

B2 Variables

Momentary Button \

bool Variable A

Text Text Area bool Variable B
L:12 value bool Variable C
(8°4) 1mage Indicator bool Variable D
e bool Variable E
float32 Variable A -

Click the LED gadget and drag it to the page you're building.

Click the gadget to highlight it and notice that properties appear in the Gadget Properties panel (upper
right).

Tag

% | No tag selected

R
S
E

Visibility
% | Notag

Label

Default %
Alignment

- - %
Text Size

Auto %
Font

Arig v

Text Styling

B I

n X

Increase Height Zoom out to show page stash Show grid

Scroll down to see all the possible properties you can choose and adjust. Enter the following properties
and watch how the LED gadget changes after each one.

Property You choose... Result
Label Line 21 Tag name is replaced with label.
Alignment Right Label moves to right of gadget.
12 Label text becomes smaller (default is 16 pixels).
Text Size Button changes to show link broken. This means that the

Click % label text size you just chose (12) will affect only the Desk-
top & Tablet view, not the Handheld view.

Font Verdana Font on the label text changes.
Text Styling B Label text is boldfaced (thicker).
Text: Deep Green Text changes color.
Colors
Background: Silver Silver background appears in gadget area.
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Property You choose... Result
Graphic Size Uncheck Auto and LED becomes larger.
choose 6
True: Dark Green LED color changes.
On/Off Colors
False: [Leave as is] No change

5. Notice that part of the LED and its label text are hidden. Use your mouse to grab a corner handle on the
gadget and pull it out so everything is visible.

Desktop & Tablet

. Line 21

6. Inthe Gadget Palette, click bool Variable A again. Click Button and drag it to the page, next to the LED.
Click to highlight it. In the Gadget Properties area, enter the following:

Property You choose... Result

When someone pushes this button, they’ll be required

Confirm Writes  Check the box to verify the button’s action before it happens.

Display Mode [Leave as Button] No change
Label Turn ON/OFF Button text changes.
Text Size 12 Text becomes smaller on Desktop view.
Click link icon Text size remains the default on Handheld view.
Font Verdana Text font changes.
Text Styling B Text is boldfaced.
On indicator: Green LED embedded in the button changes color.
Off indicator: [As is (black)] No change.
Colors
Text: Deep Green Text color changes slightly.
Button: White Button color changes.

7. With the button highlighted, adjust its handles so it's about as large as the LED gadget. Make sure you
can see all the text.

Your page now looks something like this:

Desktop & Tablet

. Line 21 | Turn ON/OFF |
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Save the Project

From the File menu, choose Save All Changes and Switch to groov View.

View the Project on your Computer

Your saved project opens in groov View.

= Main y' SV ‘ Events ﬂMenu

. Line 21

. Turn ON/OFF

Try it out! Click the button and see what happens.

Explore

1. Go backto Build mode by clicking Menu in the upper-right corner of the window and choosing Switch to
Build mode.

2. (lick the Handheld tab, just above your page in the center of the workspace.

While you were building your page in the Desktop & Tablet tab, groov View automatically put the same
gadgets in the Handheld tab, which shows the page layout for a smartphone. However, you may want
the page to look different on a phone. Maybe some data or controls are more important and should be at
the top of the page. Or maybe some don't need to be on the phone at all. In this tab you can resize,
rearrange, change, or delete gadgets to suit your needs.

3. (lickto highlight each gadget and change its size and position the way you want.

Y —

YRl Handheld
. Lin¢ IJTurn ON
- J Line 21

) IJTurn ON/OFF

Remember that you made the text size smaller (12 instead of 16) for both the LED and the button? You
also broke the link between the two views for that property, which means you changed it for one view
only. So the text is smaller for Desktop & Tablet, but for Handheld it remains at the default of 16.

You can make the two views different in other ways as well. For example, suppose you want smartphone
users to be able to see the status of Line 21 but not be able to turn it on or off. You can stash the Turn
ON/OFF button so it's not visible in the Handheld view.
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4. Inthe Handheld tab, notice the area off to the right of the page with a dotted line around it. Drag the
Turn ON/OFF button into this area, which is called the page stash.

DEERGERENES  Handheld

. Line 21 IJTurn Q%!OFF <4—— Page stash

The button will still be shown on a computer or tablet but will not be visible on a smartphone. You can
also stash gadgets in the Desktop & Tablet tab if you don’t want them to appear on these devices, so you
can customize the view on large and small devices.

Now let's explore some more.

Images

When we added the Turn ON/OFF button, one of the properties was Display Mode. Let’s take another look at
that now.
1. Inthe Desktop & Tablet tab, select the Turn ON/OFF button and look in the Properties panel.
2. For Display Mode, choose Image.
As you can see, instead of a simple button, you could skin the button with images: one image indicates
that the button is On and the other that it is Off.

T e
On Image
— Click to open the Image Library and
choose or add the On Image.
Opacity: 100
Limits: 0 to 100
Off Image
4
Opacity: 100
Limits: 0 to 100

3. (lick a broken image to open the Image Library, where you can add images to your project.

All the images for your groov project are stored in the Library. You can add and delete images. You can
use the same image in multiple places, and if you change it, it's automatically updated everywhere it's
used. Compatible file types for images are BMP, GIF, PNG, JPG, and SVG. For more on the Image Library,
see page 82.
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Here's what the Image Library looks like before you've added any images:

- Change how yourimages are
€ Cancel E shown in the library.

For now, click Cancel to exit the |
Button.

Round Gauge

Let's look at a gauge.
In the Gadget Palette, expand the tag tree again. Under Basic > Variables, choose float32 Variable A. In the
gadget list, click Round Gauge and drag it to your page.

Highlight the new gadget and look at its properties. To understand all the options, see “Round Gauge
Gadget”on page 118. But for now, change only the following:

1.

A

After you add them, your
images appear here.

A

mage Library. In the Properties panel, change Display Mode back to

Property You choose... Result
Range Min value 0, Max value 100 The gauge changes to show 0-100.
Units Gallons Gallons” appears below the numeric value on the
gauge.
. Value will be shown in whole numbers (no digits after
Precision 0 . .
the decimal point).
Colors HOEEEE TS Colors change on the gauge.

Background: Dark Orange

Scroll down to Color Ranges and

Color Ranges
| Add Range... |

Invalid range .

Color: .7

Min Valus:
Max Value:

Close Editor Delete

click Add Range.

— Click to choose the color for this range.

Click the blue rectangle and choose Red. Enter Min Value 0 and Max Value 20.
Click Add Range again. For Color, choose Orange. Enter Min Value 20 and Max Value 40.
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6. Click Add Range again. For Color, choose Dark Green. Enter Min Value 40 and Max Value 100.
Your gauge now looks like this:

= This gauge is easy for an operator to understand at a glance. Anything
40 "y 60 in the green range is OK, but if the needle dips down into the red, you
\ /
30 \\0‘ ”/,/ 70 have a problem.
20 :: E_ 80 The numeric value appears in blue at the bottom of the gauge.
10 ;v "~ 90
p £
0 g 100
Gallons

What's Next?

Now that you have an idea of what groov View can do, you can get to work on your real project.

To connect to your systems and equipment, see these sections:
»  "Adding a Modbus/TCP Device”on page 33

«  “Adding an Opto 22 Controller”on page 27

«  “Adding an OPC-UA Server”on page 43

To add more pages, see “Working with Pages”on page 20.

To learn more about gadgets, see “Editing Gadgets”on page 69. For help on choosing gadget properties,
see Chapter 4: Gadget Reference on page 99.

To set up users and passwords and control who accesses your groov interface, see “Managing User Access”
on page /5.

To notify authorized people when events occur, see Chapter 5: Using Events and Notifications on page 127.

WORKING WITH PAGES

Your operator interface can consist of one or many pages, depending on your application’s needs. You may
have separate pages for different functions, different people, or different locations. You use the Page Navigator
gadget to provide a link so users can go from one page to another.

Adding Pages

1. InBuild mode, click Add Page in the Pages panel on the left side.

» Uncategorized

Add ntjfe...
Add kdtegory...

2. Type a name for the page.
3. Ifyou wish, choose any of the following options:
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- Click the Background Color square to choose a color for your page.

Create Page

Page Configuration Page Permissions

Page Name: Pump Room Access Rights: | All Users v

Background Color: [ Select groups that may access this page
EEEEEN O =

nn AEEEEN

ENEEEEENEN
oK Cancel

EEEEEEENEDN : JL

- Ifyou have added page categories (see page 85), select a category for this page.

- Limit access rights based on user security level (see “Creating a User”on page 76). Or, if you want
only specific users to see this page, choose Limited Access. If the page is Limited Access and you
have already added user groups (see page 75), select the groups that should see this page.

4, C(lick OK.
Your new page appears in the middle of the workspace.

Changing Page Properties

You can change an existing page’s name, permissions, or other properties.

NOTE: When you import a page, any permissions limitations it may have had are notimported. If you want the page
to be limited, you must change its permissions after importing.
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1. Inthe Pages panel on the left side of the workspace, click the page

you want to change.

In the Page Properties panel just below, you see the current page
properties. (Both panels are shown at right).

2. Change Name or background color as needed.
3. Tohide the page so no users can see it, click Hidden (useful when

you are building a new page).

4. To change user permissions for the page, click Edit Page

22 groov View U

Permissions.

Edit 'Line 1 KPIs'

Page Permissions

Access Rights: | All Users v |
Select groups that may access this page

#| Line operators

0K Cancel

You can limit access rights based on user security level (see

¥ Headquarters
Refrigeration
Pump room
Main
Tanks - Field
¥ Factory

Line 1 Operation

Line 2 Operation

Line 1 KPIs

Pumps

Add Page...
Add Category...

Page Properties

Name Line 2 Operatior

Color

Edit Page Permissions...

Hidden

“Creating a User”on page 76). Or, if you want only specific users to see this page, choose Limited Access.
If the page is Limited Access and you have already added user groups (see page 75), select the groups

that should see this page.
5. Click OK.

Page Size and Grid

As you fill your page with gadgets, you may find you need more room. Click the Increase Height button at the
bottom of the work area. If you switch to another page and then return, the page will shrink to fit the content

or return to the default page size, whichever is larger.
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When you place or move gadgets on the page, they automatically snap to a grid so they are aligned. If you
want to see the grid, at the bottom of the work area click “Show grid.”

Desktop & Tablet

Viewable area with
grid turned on

Increase Height | || Zoom out to show page stash ¥ Show grid

Click to make page longer.

Using the Page Stash

The workspace for each page has a page stash where you can put gadgets that are not yet part of the project.
Orif you don't want a gadget to appear in the Handheld layout, for example, you can move it to the page
stash; the gadget will still appear in the Desktop & Tablet layout.
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To see the page stash in the Desktop & Tablet view, select “Zoom out to show page stash” at the bottom of the
work area. In the Handheld view, the page stash is always visible to the right.

PSR EL S Handheld

ODegF
50=
45+
40+
as4
304
25+
20+
15+
104

2: | Page stash

Case 4

|-Increase Height | [Z] Show grid

Deleting a Page

1. Inthe Pages panel at left, hover over the page or category name, and then click the red X that appears.

¥ Processing

Final Phase @— Click the red X.

2. To verify, click OK.

Delete Page

Delete page "Final Phase"?

Warning: This action cannot be undone.

l OK”T'}J‘ Cancel ‘
<
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Renaming a Page

1. Inthe Pages panel, right-click the page name and select Rename.

Duplicate

2. Enteranew label, and press Enter or left-click in the work area.

Boilers|

Duplicating a Page

1. Inthe Pages panel, right-click the name and select Duplicate.

¥ Factory

Line

Rename

Ling Duplicate

Pump:

A copy appears in the same page category.

¥ Factory
Line 1 Operation
Line 1 KPIs

Pumps

Line 1 Operation
copy™*

2. Right-click the copy and select Rename to give the page a new name.

¥ Factory
Line 1 Operation
Line 1 KPIs

Pumps

Line 2 Operation™
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3. Ifyou want, you can drag it to a new position in the list or to a different page category.

¥ Factory

Line 1 Operation

Line 2 Operation™

Line 1 KPIs™

Pumps™®

Exporting and Importing Pages

You can move pages from one groov project to another by exporting and importing them. When you export,
only the page layout with gadgets is exported. Associated tags, images, and page navigators are not exported.
In addition, if you limited viewing permissions to specific user groups, those limitations are not exported.

The export file is downloaded to your PC with a date and time stamp as its filename.

Export a page
1. In Build mode, choose File > Export Page.

The file is immediately downloaded. The filename looks something like this:
Groov_Page D04242017.T211956.json

2. Save thefile with a filename you'll recognize in the location you want. Make sure you retain the json file
extension.

Import a page
1. Open the groov project you want to import the page to.
2. Choose File > Import Page.

Import Page

Please choose a groovpage file to import: groovpage files are exported
from the File menu.

Import Page (*.json): Browse...

Fage Mame:

Category: Uncategorized v
Tag references, page navigators, images, and limited access groups are

unlinked during an export. Please relink those items after a successful
import.

Import Cancel

a. (lick Browse and find the file you exported.
b. Inthe Page Name field, enter the name for the page in this project.
c. (Optional) Choose a category for the new page.
3. Click Import.
A new page is created in the project, containing the gadgets and layout from the imported page.
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4. Complete the new page by:

Adding tags for each gadget

- Replacing any images

- Adding page navigators appropriate for this project
Editing page permissions

5. Save the page.

WORKING WITH A DEVICE

When you first open groov View, only tags for the Data Simulator are available for use. Any other device,
system, or software you want to monitor, control, or exchange data with using your groov View operator
interface—including the groov EPIC, Server, or Box itself—must be added to groov View as a device. When you
add the device you also add its tags, so that you can connect the tags to the groov View gadgets to make
them operational.

With any groov View project, you can add as many groov EPIC processors and /0 units, groov RIO 1/0 units,
SNAP PAC controllers and I/0 units, Modbus devices, and Data Stores as you like. You can also add an OPC UA
Server—either the internal Ignition Edge® OPC UA server inside groov EPIC or the groov Box, or an external
OPC UA server with any groov product. In addition, any events you create (see Chapter 5: Using Events and
Notifications) automatically appear as tags in a device named Events.

NOTE: Devices cannot talk with each other directly. For example, a Modbus/TCP device cannot write data to a Data
Store; an Opto 22 controller cannot read groov System data. However, you can use Node-RED in groov EPIC, groov
RIO, or the groov Box to create a logical flow that exchanges data between devices that have Node-RED nodes. For
more on Node-RED, see nodered.org, developer.opto22.com, and the user’s guides:

groov EPIC User’s Guide (form 2267)
«groov RIO User's Guide (form 2324)
groov Box User’s Guide for GROOV-ART (form 2104)

This section includes:

«  "Adding an Opto 22 Controller,” page 27
«  “Adding an Opto 22 1/0 Unit"on page 29
«  "Adding a Modbus/TCP Device,” page 33
»  “"Adding an OPC-UA Server,” page 43

«  “Adding a Data Store”on page 62

«  "Adding System Tags,” page 51

«  "Adding a Computed Tag,” page 53

«  "Editing Device Information,” page 63

«  “Disabling Communication to a Device,” page 64
»  “Deleting a Device,” page 65

«  “Viewing Device Health,” page 66

Adding an Opto 22 Controller

Follow these steps to add an Opto 22 controller—either a groov EPIC processor or a SNAP PAC controller—
that the operator interface will communicate with. When you add a controller and the .idb.txt file associated
with the strategy that runs on the controller, the strategy’s tags become available in groov View for you to use.
Repeat the steps to add additional Opto 22 controllers.
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1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags. Or choose
Configure > Devices and Tags.

Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥

Opto 22 I/0 Unit
Opto 22 Controller
OPC UA i‘j\rer
Modbus Device
Data Simulator

System
Data Store

Close

2. C(lick Add New Device and then select Opto 22 Controller.

Add Opto 22 Controller

Controller Address: | | |

Controller Port: 22001
Connection Timeout: 5 seconds
Scan Interval: 1 seconds
Strategy File (*.idb.txt): Select file...
String Encoding: UTF-8 v

Maost users will be fine with the default string
encoding, UTF-8. The only reason to change this is if
you know your strategy is storing strings with a
different encoding.

Create Device Cancel

3. Inthe Controller Address field, enter the hostname or IP address of the controller running the strategy
you want to use. For a SoftPAC controller, use the full name of the computer running SoftPAC as in this
example:

JAlvarez-wl0.ACME.com
4. (Change the port, timeout, scan interval, or string encoding if necessary for your application.
5. For Strategy File, click Select file to locate the .idb.txt file you want to use.
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NOTE: When PAC Control compiles a strategy it automatically generates an .idb.txt file and places it in the same
directory as the strategy. If you are setting up groov on a computer other than the one used to develop the PAC
Control strategy, copy the .idb.txt file into a directory that is accessible to the computer you are using to set up
groov.

6. Navigate to the file and click Open.
7. When you've made all the changes you need to, click Create Device.

Build imports the .idb.txt file. In the Gadget Palette, you see the name of your strategy and the IP address
of your Opto 22 controller. Click the plus signs to expand the tree and see all the tags.

Updating a Strategy

If a controller's strategy has been changed, you need to update it in groov View by importing its new .idb.txt
file.

1. Select Configure > Devices and Tags.

2. Highlight the controller you want to update, and then click Update Strategy.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle -

Edit Device...
Delete...

Update Strateg%

Device Health...

Close

CAUTION: Be very sure you are updating the correct strategy. If you use the wrong one, all of the controller tag
connections will break. This is critical because re-importing the correct strategy will not fix the broken gadgets.
You can only fix the connections by restoring your project with a recent backup.

3. Browse to the strategy you want to use, select the new .idb.txt file, and then click Open.

NOTE: The..idb.txt file is in the same directory as the strategy. If groov is on a different computer than the strategy,
copy the .idb.txt file into a directory accessible to the computer you are using for groov.

4. (lose the Configure Devices and Tags dialog box.

Adding an Opto 22 1/0 Unit

Your groov View operator interface can read tags from the OptoMMP memory map in the following I/0 units:

«  Agroov EPICI/O unit or a groov RIO unit. Before adding it to your groov View project, configure the points
in PAC Control or groov Manage.

«  An Opto 22 SNAP PAC I/0 unit. Before adding it to your groov View project, configure the /O modules
and points in PAC Control or PAC Manager.

When you add an 1/0 unit, the unit's memory map tags become available in groov View. Some memory map

address tags are automatically imported (called Auto tags), and you can manually configure others. The

following directions add the Auto tags.

1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select
Configure > Devices and Tags.
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Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

2. C(lick Add New Device and then select Opto 22 1/0 Unit.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥

Opto 22 If0 Unit
Opto 22 C@tmller
OPC UA Server
Modbus Device
Data Simulator
System

Data Store

Close

3. Entera Name for the I/0 Unit and, in the Address field, its IP address or hostname.

Add Opto 22 IfO Unit

Name: | | |
Address:
OptoMMP Port: 2001
Connection Timaout: 5 seconds
Scan Interval: 1 seconds
String Encoding: UTF-8 v

Most users will be fine with the default string
encoding, UTF-8. The only reason to change this is if
you know your strategy is storing strings with a
different encoding.

Add Device Cancel

4. |leave OptoMMP Port at the default of 2001 unless you have changed it on the I/0 unit.
5. Change Timeout, Scan Interval, or String Encoding only if necessary for your application.
6. Click Add Device.
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7. Inthe Gadget Palette, notice the name of your 1/0 unit. Click the plus signs to expand the tree and see all
the tags that were automatically imported. The following images show two examples.

. | .
Line 1 LC-Rlisa

Tags

Configure Devices & Tags..

© Line 1 LC-R1 e =
Manual Tags

B Auto Tags
2 Module 0 (4-channel digital)

© State
diDoughLevelSwi STA”
diChipLevelSwitch ST2
dilnspectionPassFailSv

diEStop STATE

" SNAP PAC I/ unit with

several I/0 modules on the
rack. The image on the left
shows the tree for the first
module (Module 0)
expanded and four
configured points.

(RIO) isa
groov RIO unit. The image
on the right shows its tree
expanded and the first four
configured channels.

Line 2

Gadget Palette

Tags

Configure Devices & Tags...

Events -
B Line 2 (RIO)
User Configured
2 Modules
2 Module 0 (GRV-R7-MM1001-10)
FrontDoorStatus
BalconyDoorStatus
FrontDoorSwitch STATE
BalconyDoorSwitch STATE
Digital IN (0, 4)

Digital IN (0, 5)

NOTE: For SNAP PAC I/0 units, empty module slots on the I/O unit may appear as digital modules in the tree.

If the tag you need is not there, you can add individual OptoMMP memory map address tags. See

“Adding OptoMMP Memory Map Addresses Manually”on page 32.

Updating Auto Tags

If you add an I/0 module to an I/0 unit, to add the Auto tags for the new module:
«  Forgroov EPICI/O units, collapse and then expand the tree to see the new tags.

«  For SNAP PACI/O units, if you configured the points on the new module prior to adding it in groov View
(for example, through PAC Manager), then you can collapse and then expand the tree to see the new

tags.

If you remove an 1/0 module from the I/O unit, remove the missing tags from their associated gadgets, then

update or remove those gadgets:

1. Inthe Gadget Palette, click Configure Devices & Tags.
2. Highlight the name of the I/O unit in the list of devices.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle
Edit Device...

Edge sarver 0OPC UA Server 127.0.0.1:4096 Idle e e it i o M|
Data Simulator Data Simulator Delete...

Modbus power Modbus Device 10.192.55.208:502 Idle

System System Configure Tags...
Mysgl database Data Store e — —

- = ‘ Update Ayto Tags... ‘
Line 1 LCR1 Opto 22 I/O Unit 10.192.55.67:2001 Idle

Device Health...

Close

3. (lick Update Auto Tags. A report lists any deleted tags.
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4. (lick Update Auto Tags to confirm that you want to disconnect the deleted tags from their associated
gadgets.

5. (Click Close on the Configure Devices and Tags window. Now you can update or remove the associated
gadgets.

Adding OptoMMP Memory Map Addresses Manually
You will need to know the memory map address and data type for the tag you want. You can find these in

the OptoMMP Protocol Guide (form 1465) or:

«  Forgroov EPIC1/O units or groov RIO units, you can find memory map addresses through groov Manage.
Navigate to the I/0 Tools page to access the MMP Calculator.

«  For SNAP PACI/0 units, you can find memory map addresses by connecting to the I/O unit through
PAC Manager, then clicking Tools > Inspect.

Be aware that your groov View interface cannot show hexadecimal values. Hex values will be shown as their

decimal equivalents in your interface.

1. Inthe Gadget Palette, click Configure Devices & Tags. Highlight the name of the I/O unit in the list of
devices, then click Configure Tags.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle

Edit Device...
Edge server OPC UA Server 127.0.0.1:4096 Idle ———
Data Simulator Data Simulator Delete...
Modbus power Modbus Device 10.192.55.208:502 Idle
System System ‘ Configue Tags... ‘
Mysql database Data Store

Update Auto Tags...
Line 1 LG-R1 Opto 22 IfO Unit 10.192.55.67:2001 Idle

Device Health...

Close

2. (lick the plus sign in the upper left of the Configure Opto 22 I/0 Unit Tags window.

Configure Opto 22 I/0 Unit Tags

¥ Tag Name Data Type Length (hex) Destination Offset (hex)
Click + to create tags for this device.

3. Enteraname for the tag. From the drop-down list, choose the correct Data Type.
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Adding a Modbus/TCP Device

CHAPTER 2: BUILDING A PROJECT

Configure Opto 22 I/0 Unit Tags

+ @

¥ Tag Name Data Type Length (hex) Destination Offset (hex)

iden:ifying Name Boolean

Cancel | | Save | | Save & Add Another

In the Destination Offset (hex) field, enter the complete memory map address with no spaces.
For example, for Unit Type, you would enter FFFFF0300020.

Click Save, or click Save & Add Another to configure more tags manually.

In the Gadget Palette, the tag appears under the I/0 unit's name, in the User Configured folder.

Gadget Palette
Tags ReELLES

Configure Devices & Tags...

Events

2 Local I/O
B2 User Configured
I/O unit type
2 Modules
Module 2 (GRV-0ODCI-12)
B Module 4 (GRV-TACIHV-12Y

Manually added tags appear
under the I/0 unitin the
User Configured folder.

You can use manually added tags just like any other tag in your groov View interface. In this example, you
see that the hex value returned from the Unit Type memory map address is shown in the interface as its

decimal equivalent:

= Main A(:Nlla A Events B $Menu

Pump Room Time: 22:44

Date: 01 Mar 2018

Refrigeration s type: 122 Decimal equivalent of hex

value from the memory map

Modbus is an open protocol widely used in automation and other industries. Although it was originally
designed for a serial network, Modbus has since been adapted to work over Ethernet as well. Over Ethernet
the protocol is called Modbus/TCP. groov has a communication driver that allows groov to act as a
Modbus/TCP master and communicate with Modbus/TCP slave devices that have an Ethernet connection.
Note that groov does not support communication with serial devices via a Modbus serial-to-TCP gateway, due

to high latency in serial networks.

Follow these steps to add tags for a Modbus/TCP slave device for use in the operator interface.
Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select

1.

Configure > Devices and Tags.
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Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

2. Click Add New Device and then select Modbus Device.

Add New Device ¥

Opto 22 Controller

OPC UA Server

Modbus Device
&

3. Inthe Device tab, enter the following details:

Add Modbus Device

Name:
Address:
Port: 502
Unit ID: 0
Connection Timeout: 5 seconds
Scan Interval: 1 seconds
String Encoding: UTE-8 v
32-bit Value Order: First register is least significant v
64-bit Value Order: First 32-bit value is least significant v
#| Use base-one addressing Use function code 5 when writing
a single coil.
Use function code 6 when writing Use function code 22 when
a single register. writing a single register bit.
Add Device Cancel

Name: Enter a name to identify this Modbus device.

Address: Enter the Modbus device’s IP address or hostname. A hostname will be converted to an

IP address by the DNS server.

Your device may have a static IP address, which you can find in the device’s documentation. The device
may also come with software that allows you to set its IP address or view the address assigned to it by a
DHCP server.

Port: 502 is the standard Modbus port. Some Modbus devices may use a different port. Refer to your
device’s documentation to determine which port number it uses.
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Unit ID: Typically used to address individual devices or memory segments located at a single IP address.
Check your device's documentation to determine whether the slave ID is required for any reason. If it is
not, leave this box at the default of 0.

Connector Timeout, Scan Interval, and String Encoding: Change these only if your application
requires it.

32-bit and 64-bit Value Order: The Modbus protocol does not specify memory mapping. As a result,
devices that store multi-register data types store the data differently. Use these settings to set the byte
order of the data coming from your Modbus device for data types that span more than one 16-bit
register/address. See your device’s documentation to determine whether either of these settings needs
to be changed. The device’s manual may use terms like high or low order or registers, or MSB (Most
Significant Bit) or LSB (Least Significant Bit).

NOTE: Setting either of these settings incorrectly may result in garbage values for the affected data types. If you
receive data that makes no sense, try changing these settings.

- 32-bit: First register is least significant. For 32-bit data types that span two 16-bit registers, this
indicates that the first (lower) register read contains the least significant byte (LSB).

- 64-bit: First 32-bit value is least significant part of 64-bit values: For 64-bit data types that span four
16-bit registers, this indicates that the LSB is contained within one of the first two registers read.

Example: Assume register values are:

- register 1 =A
- register2=8
- register3=C
- register4=D

Here's how data will appear based on your settings:

Settings Results
32-bit value 64-bit value
from registers 1 &2  from registers 1-4
Second register ~ Second 32-bit value AB ABCD
First register Second 32-bit value BA BADC
Second register  First 32-bit value AB CDAB
First register First 32-bit value BA DCBA

Check boxes: Be sure to check the documentation that came with your Modbus device for additional
information about these settings. For more information about Modbus function codes, see
www.modbus.org/docs/Modbus_Application_Protocol_V1_1h.pdf.
—  Use base-one addressing
If your device documentation specifies zero-based addressing or you simply prefer zero-based
addressing, you can uncheck this option to make tag addressing easier.

- Usefunction code 06 when writing a single register
If your device does not support Modbus function code 06 (0x06, Write Single Register), uncheck this
option. If it is not checked, groov will use function code 16 (0x10 Write Multiple Registers) for
single-register writes.
If this option is checked in groov View and your device does not support function code 06, you may
receive errors. The error occurs with writes to any tag having a data type sized 16 bits or smaller.

—  Use function code 05 when writing a single coil:
If your device does not support Modbus function code 05 (0x05, Write Single Coil), uncheck this
option. If it is not checked, groov will use function code 15 (0xOF, Write Multiple Coils) for single coil
writes.
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If this option is checked in groov View and your device does not support function code 05, you may
receive errors.

Use function code 22 when writing a single register bit:

If your device supports Modbus function code 22 (0x16, Mask Write Register), you can check this
option to optimize writes. (Using function code 22 makes writes faster and ensures that the write
operation is atomic.)

If this option is not checked, groov will use other functions to first read the whole register, modify
the bit, and then write to the whole register. Note: Keep this option unchecked for an Opto 22 SNAP
PAC controller or brain

4. When finished, click Add Device.

The Modbus device appears in the list of configured devices. Now you'll add tags, either manually

(below) or by importing them from a file (page 42).

Adding Modbus Tags Manually through groov View

Use the steps below to manually add Modbus tags in Build mode. You can also add Modbus tags by importing
them from a file. See “Importing Modbus Tags from a CSV File” on page 42.

1.

Under Gadget Palette on the right side, click Configure Devices & Tags, or select Configure > Devices and

Tags.

Gadget Palette

Configure Devicgﬁ & Tags..!—\

T -—r 1
Configure Devices and Tags

4 Name Type Address Status
Cookies Opto 22 Controller 10.192.55.67:22001 Idle
Edge server OPC UA Server 127.0.0.1:4096 Idle
Data Simulator Data Simulator

Modbus power Modbus Device 10.192.55.208:502 Idle
System System

Mysql database Data Store

Line 1 LC-R1 Opto 22 I/O Unit 10.192.55.67:2001 Idle

36

Add New Device ¥
Edit Device...
Delete...
Configure Tags...

Device Health...

Close

2. Highlight the Modbus device and click Configure Tags.

Configure Modbus Tags

¥ Tag Name Data Type Tag Address

Access

Scaler

3. Click the Add button £ 3.
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Configure Modbus Tags

<+ 4 Import Export

¥ Tag Name Data Type Tag Address Access Scaler

|| |Bc>olean v Read/Write ¥ ||MNone v

Cancel | | Save || Save & Add Another

Enter the following attributes.
Tag Name: (Required) Give the tag a descriptive name.

Data Type: (Required) Select the tag’s data type. If your Modbus/TCP device's registers contain multiple
status or command bits or bit fields in a single register, choose Boolean to access individual bits.

Data Type

mme [

Unsigned Byte

16-bit Signed Integer
16-bit Unsigned Int=ger
32-bit Signed Integer
32-bit Unsigned Int=ger
&4-bit Signed Integer
&4-bit Unsigned Integer
BCD

LECD

Float

Double

Boolean

String

Tag Address: (Required) The Tag Address Builder helps you construct valid tag addresses. After you see
what a valid tag address looks like, you can enter the addresses manually in the text box in order to save
time. Available options depend on the data type.

Address Type: Identifies which memory segment will be accessed. Discrete Inputs and Coils are
single-bit registers that represent Boolean values only. Input and Holding Registers are 16-bit
registers that can be used for any data type.

Data types larger than 16 bits are mapped onto consecutive registers, starting at the register located
at Start Address. Coils and Holding Registers are default Read/Write, while Discrete Input and Input
Registers are Read Only.

To access individual bits in a register, choose Input Registers (Read Only) or Holding Registers
(Read/Write).

Start Address: Specifies where the tag value starts in memory. Strings may span multiple registers.
Data types larger than 16 bits always span multiple registers.

To configure 0- or 1-based addressing, click Edit Device on the previous dialog box (Configure
Devices and Tags) and then click the Access Config tab.

String Length: Determines how many registers will be accessed to read or write the full string.
Strings are composed of ASCII characters (1 byte), so a single register may hold up to 2 characters.
Byte Order: Specifies how the characters are ordered within each register. H—>L indicates that the
first character, when read left to right, starts at the most significant bit (MSB) and the last character
ends at the least significant bit (LSB). If you are unsure about order, you can play with this setting to
determine which one works.

Bit Index: Identifies the bit within a register to be accessed. Valid bit values are 0-15.
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Array Size: To access multiple (contiguous) values of this Data Type using the same tag, set this size
to 2 or more (up to a maximum of 65535, depending on the Data Type).

For example, if you want to access 10 contiguous floats that start with the specified Tag Address, set
Array Size to 10.

String arrays are not supported.

Access: (Optional) The options available depend on the data type. If you omit this value, the tag will assume
the register type default setting.

Scaler: (Optional) Use the Scaler if a read/incoming value spans a much larger data range than you require, or
to convert from one unit of measure to another. If you use this option, you must provide all components.

Scaler
. 400018 I Read Cmby |ZI None ¥
A4 Scaler: I Nons j ‘-3-)
B Raw Input Limits Scaled Result C
High: Data Type: I 16-bit Signed Integer
Lo Limit High:
Limit Lo
Megate the result ————— D
A Scaler

None: The raw input value is not modified in any way.

Linear Scaler: The raw input value is mapped linearly from the specified input range to the specified
output range and data type. To flip the sign of the result (negative to positive or positive to
negative), select “Negate the result” (D).

Here is the function used to scale the input:

Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw
Value - Raw Low)) + Scaled Low

Square Root Scaler: The raw input value is mapped from the specified input range to the specified
output range and data type using the following function:

Output = (\/ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled
High - Scaled Low)) + Scaled Low

Raw Input Limits

High/Low: The High and Low Raw Input Limits must be within the range of values that the tag data
type can store.

Scaled Result

Data Type: Select an available data type. Not all Modbus data types are valid output types for scaled
values, so some data types are not listed.

Limit High and Limit Low: These values must be within the range of values that the scaled output
data type can store.

Negate the result: Select this option to flip the sign of the result (negative to positive or positive to
negative).

Creating a Valid Modbus Tags Import File (CSV)

See also “Exporting a Modbus Tags Import File (CSV)"on page 41.

A valid Modbus CSV file contains one tag per line and has this form:
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Tag Name, Data type, Tag address [, [Read/Write setting] [, Value scaler
name, Scaled output data type, Input limit low, Input limit high, Output
limit low, Output limit high, Negate]]

When viewed in a text editor, a CSV file containing Modbus tags might look like this:

Tag Name DataType  Tag Address  Access

= ModbusTags_ModLus_Sla\re (1).cav |

1 Digital Input 0,Boolean,100000,Read Only

Digital Input 1,Boolean,l100001,Read Only

Digital output €,Boolean,000006,Read/Write

Digital output 7,Boolean,000007,Read/Write

Analog Input 16 (pot knob),Float,300032,Read Only

Analog Output 8 (meter),Float,400016,Read Only,Linear,lé-bit Signed
Integer,-3.4028235E38,3.4028235E38,-32768,327¢7, false

[ 2T 3 BT = WO T S

-]

Scaler

Here is the same file viewed in Microsoft Excel:

Tag Name DataType\ Tag Address  Access

8 Digital Input 0 Boolean 100000 Read Only

¥ Digital Input 1 Boolean 100001 Read Only

8 Digital Output 6 Boolean 000006 Read/Write

L8 Digital Output 7 Boolean 000007 Read/Write

8 Analog Input 16 (pot knob) Float 300032 Read Only

i Analog Output 8 (meter) Float 400016 Read Only  Linear 16-bit Signed Integer -3.40E+38 3.40E+38 -32768 32767 FALSE

Scaler

Tag Name: (Required) Give the tag a descriptive name.

Data Type: (Required)

Tag Address: (Required) Use a basic 6-digit address (exception: if you access individual bits within a register,
the address includes 6 digits plus a point and the bit number, for example: 302000.12).

The first digit defines the register type:

0= Coll

1 = Discrete Input

3 =Input Register

4 =Holding Register

The next five digits are the start address:
«  Fordevices with a base 0 addressing, the start address range is 0-65535.
«  Fordevices with a base 1 addressing, the start address range is 1-65536.

NOTE: The start address is decimal by default but may be expressed in hexadecimal format. For hex:
- Place an "H" or “h” character in front of the entire address (for example, H30009F).

- Follow the H with the address type byte plus a 0 (zero).

- Then show the hex address using 4 hex bytes. The most significant digit will always be 0.
Examples: 000001, 400203, H10FFFF
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40

Registers 0 (Coils) and 1 (Discrete Input) are single bit registers and may be used for Boolean data types only. All
other data types must use one of the 16-bit register types (3 or 4).

There are limits on the tag start address. The following formula is used to determine if the tag address is within
bounds of the registers:
OK if: 65536 <= Start Address + (ArraySize * Data Type Byte Size) / 2

u o

For the String data type: Use the basic address followed by a “.” and then a decimal number in the range 2-
240 to designate the number of characters in the string. Use either an “L” or “"H” to designate character
ordering within the registers. Only ASCII characters are supported (1 byte each); therefore each 16-bit register
can contain up to 2 characters. “L" indicates a Low-to-High byte ordering (the first character contains the LSB)
and “H" indicates the opposite.

Examples: 300001.20H, H4000F9.120L

For all other data types: Data types other than strings may be represented as arrays using a basic address
followed by a space, an opening bracket “[", a positive integer value in the range 2-65536, and a closing
bracket 1"

Examples: 100003 [50], 300045 [20])

The array starts at the start address and extends through the designated number of elements. The start
address + array size may not exceed 65536 registers. The size of the data type must also be factored in, as
many data types span multiple registers.

Access: (Optional) This setting must match one of the options available for this data type in Build mode (for
example, Read/Write, Read Only). It is not case sensitive. If this value is omitted, the tag will assume the
register type default setting. If a value scaler is set, the Read/Write setting must be provided or an empty place
reserved for it with commas (Tag address, ,Value scaler).

Scaler: (Optional) If this option is used, all components must be provided.

&= ModbusTags_Modbus_Slave (1).csv |

1

o= L b

..Linear,16-bit Signed Integer,-3.4028235E38,3.4028235E38,-32768,32767, false
L L I L 1L 1L

[sa]

Digital Input 0,Boolean,l100000,Read Only

Digital Input 1,Boolean,l100001,Read Only

Digital output €,Boolean,000006,Read/Write

Digital output 7,Boolean,000007,Read/Write Scaler

Analog Input 16 (pot knob),Float,300032,Read Only

Analog Output 8 (meter),Float,400016,Read Only,Linear,lé-bit Signed
Integer,-3.4028235E38,3.4028235E38,-32768,327¢7, false

\ \ \ | \
A B Cc D E

A Scaler Name: The scaler name must be None, Linear, or Square Root. The name is not case sensitive.
The Scaler allows you to modify and control raw data values. This may be necessary if for example a
raw value spans a much larger data range than you require. Or perhaps you need to digitize an analog
value that comes in as a floating point number. There are many reasons why a scaled value may be
useful or necessary. Below are the available scaling functions.

None: The raw input value is not modified in any way.

Linear: The raw input value is mapped linearly from the specified input range to the specified output
range and data type. Selecting “Negate the result” causes the sign of the result to be flipped
(negative to positive or positive to negative). Below is the function used to scale the input:

Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw
Value - Raw Low)) + Scaled Low
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Square Root: The raw input value is mapped from the specified input range to the specified output
range and data type using the function below:
Output = (\/ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled
High - Scaled Low)) + Scaled Low

Data Type: The scaled result data type must match one of those offered in the Ul. Not all Modbus
data types are valid output types for scaled values so check Build mode to see the current list of types.
Raw Input Limits: The Low and High Raw Input Limits must be within the range of values that the
tag data type can store.

Limit Low and Limit High: Must be within the range of values that the scaled output data type can
store.

Negate the result: True or False. Causes the sign of the result to be flipped (negative to positive or
positive to negative).

Exporting a Modbus Tags Import File (CSV)

If you already have tags attached to the device, you can export a CSV file containing all of the device tags.
Exporting some pre-configured tags is the fastest way to see what a valid tag CSV file looks like.

1. Under Gadget Palette on the right side, click Configure Devices & Tags, or select Configure > Devices and

Tags.

Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

2. Highlight the Modbus device and click Configure Tags.

Configure Devices and Tags

4 Name

Type

Address

Status

Add New Device ¥

Cookies

Edge server
Data Simulator
Modbus power
System

Mysql database
Line 1 LC-R1

Opto 22 Controller
OPC UA Server
Data Simulator
Modbus Device
System

Data Store

Opto 22 I/0 Unit

10.192.55.67:22001
127.0.0.1:4096

10.192.55.208:502

10.192.55.67:2001

Idle
Idle

Idle

Idle

Edit Device...
Delete...
‘ Configure Tags...

Device Health...

Close

3. Click Export to send the CSVfile to the default downloads directory. Or, right-click Export and select “Save

link as”to choose the target directory, and then click Save.
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Configure Modbus Tags

+ 7 & Import Exporf

Export tags to csv file

¥ Tag Name Data Type ag Addres
Analog Input 16

(pot knoh) Float 300032
Analog Output 8 Float 400016
(meter)

Digital Input 0 Boolean 100000
Digital Input 1 Boolean 100001
Digital Output 6 Boolean 000006
Digital Output 7 Boolean 000007

Configure Modbus Tags
I Import Expge
+ ﬁ 6 s Open link in new tab I

¥ Tag Name DataT Open link in new window

Analog Input 16 Float Open link in incognito window

(ot .
Copy link address

Analog Output 8 Float

(meter)
Inspect element

Digital Input 0 Booleal

Digital Input 1 Boolean 100001

Digital Output & Boolean

000006

A CSV file with the Modbus device tags is created and downloaded to the default or designated directory.
Importing Modbus Tags from a CSV File

If you have a comma-separated values (CSV) file in the proper format with Modbus tags you want to use, you
can import the tags directly into groov. See also, “Creating a Valid Modbus Tags Import File (CSV)”on page 38)

1. Under Gadget Palette on the right side, click Configure Devices & Tags, or select Configure > Devices and

Tags.

Gadget Palette

Configure Devicgﬁ & Tags...

T \f

2. Highlight the Modbus device and click Configure Tags.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle
Edit Device...

Edge server OPC UA Server 127.0.0.1:4096 Idle
Data Simulator Data Simulator Delete...
Modbus power Modbus Device 10.192.55.208:502 Idle
System System ‘ Configure Tags... ‘
Mysql database Data Store N

Device Health...
Line 1 LC-R1 Qpto 22 If0 Unit 10.192.55.67:2001 Idle

Close

3. (lickImport.
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Import tags f fil
Izl s SISO E——— Accass Scaler

Select Add... or Import Tags to creste tags for this device,

4. Browse to a valid comma-separated values (CSV) file that has a .csv extension, then click Open.
ATag Import Report appears.

Imported Tags

Tag Import Report:

Duplicate Tags (Not added)
Digital Input @

Digital Input 1

Digital Output 6

Digital Output 7

Analog Input 16 (pot knob)
Analog Output 8 (meter)

5. (Click Close. The tags appear in groov.

<+ i 4 mport Bxport

4. Tag Name Data Type Tag Address Access Scaler
Digital Input 0 Boclean 100000 Read Only None
Digital Input 1 Boclean 100001 Read Only None
Digital Crutput & Boclean 000005 Read/Write None
Digital Cutput 7 Boclean 000007 Read/Write None
Anzlog Input 16 (pot Flost § Only None
knob)

Al O t 8

R nalnf} T Float 400016 Read Only None

Adding an OPC-UA Server
Equipment that is neither a Modbus/TCP device nor manufactured by Opto 22 can still be monitored and
controlled in groov View if you have an OPC-UA server or if it is an OPC UA-compatible hardware device.

You can add both internal and external OPC-UA servers.

« Internal server: If you have groov EPIC or a groov Box, you can use the internal Ignition Edge OPC-UA
server and drivers for Allen-Bradley, Siemens S7, and other systems. See the groov EPIC User’s Guide or the
groov Box User’s Guide for more information.
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«  External server: You can also use an external OPC-UA server. If you don't have one, the KEPServerEX
communication platform is recommended by Opto 22 and tested to work with groov View. For more
information, go to www.kepware.com/Products/products_OPCServers.asp.

Also see www.kepware.com/Support_Center/doc_auto_tag.asp

Follow these steps to add an OPC UA-compliant server or equipment to groov.

1. Inthe Gadget Palette in the lower-right corner of Build mode, click the Tags tab, and then click Configure
Devices & Tags. Or select Configure > Devices and Tags from the menu bar.

Gadget Palette

Configure De\ficgﬁ & Tags...

T W 1

2. Click Add New Device and then select OPC UA Server.

Add New Device ¥

Opto 22 Controller
OPC UA Ser\;regj
Modbus Devic

3. Enter the Name of the OPC UA server.

Add OPC UA Server

Name: A human-friendly server name

Server URL: address: port[/path]

Example: MyHostname. MyDomain.com:49320 [?]
Connection Timeout: 5 z seconds

Scan Interval: 1 z seconds

Add Server Cancel

4. Forthe Server URL:
a. Ifyou're adding the internal Ignition Edge server in groov EPIC or the groov Box, enter:
127.0.0.1:4096
b. Forany external server, use the following format to enter the IP address or hostname of the
computer where the OPC UA server is installed, and the port (for Kepware the default is 49320). You
can also enter the path of the OPC server endpoint.

IMyComputer .MyCompany.com: 4 9|3'2 O/pa’?h

Computer hostname Port

Check your server for the correct values.
Example server URLs
10.20.30.40:49320
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10.20.30.40:49320/Path
MyServer:49320
MyServer:49320/Custom/Path
MyServer.MyDomain.com:49320
MyServer.MyDomain.com:49320/Path

Default ports
Different OPC UA servers use different ports. Here are the default ports for some servers:

KEPServerEX: 49320

TOP Server: 49380

Ignition Gateway: 4096

MatrikonOPC UA Wrapper: 21381

MatrikonOPC Universal Connectivity Server: 4846

Change Connection Timeout or Scan Interval only if required for your application.

6. Click Add Server.

Using Static Tags

When you add an OPC-UA Server, groov View accesses the controller's static tags and makes them available so
that you can directly browse the tags on the server. groov View keeps the server's tag hierarchy and displays
the tags in a tree format. As long as you are connected to the server you can browse to find the tag you need
in the Gadget Palette or by clicking dynamic link next to “Tag”on a gadget’s properties panel. The tags load
automatically as you expand the tree. (For more information on tags and folders for an internal Ignition Edge
OPC-UA server, see the groov EPIC User’s Guide or the groov Box User’s Guide.)

Expand a server's tag tree to
load its static tags

Update Tag for Gadget Gadget Palette

No Tag -
=] My OPC UA Server N Configure Devices & Tags...
Drynamic Tags O Static Tags -
B Static Tags e ¥
Server = System
Wit 2 ap
_ActiveTagCount : UInt32 : R . £
_ClientCount : UInt32 : R 7
_Diste : String : R 4 _System
_Date Day : UInt32 : R 2 Logix | 8
_Date_Month : UInt32 : R e
_Date_YearZ : UInt32 : R i
_Date_Yeard : UInt32 : R
_DateTime : DateTime : R © Global
_DateTimeLocal : DateTime : R diMomentaryInput : Boolean : RAW
_FullProjectMame : String : R diTegglelnput : Boolean : RfW
_OpcClientNames : String : R doBubbler : Boolean : RfW
_ProjectMame : String : R dolED : Boolean : RfW
_ProjectTitle : String : R - f32Setpoint : Float : RfW
= fi2Waveform : Float : RfW
Array index: -

Cancel
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Updating Static Tags

If you know that static tags have changed, or if a link to a tag is broken, you can update the static tags on an
OPC UA server. When you update the static tags, groov View displays a report that lists any deleted or modified
tags so that you can choose different tags as necessary.

To update static tags, select an OPC UA server in the Configure Devices and Tags dialog, and then click Update

Static Tags.

Configure Devices and Tags

Selectan
OPC UA server —

‘ 4 Name

Type

Address

Status

Cookies

Edge server
Data Simulator
Modbus power
System

Mysql database
Line 1 LC-R1

Opto 22 Controller
OPC UA Server
Data Simulator
Modbus Device
System

Data Store

QOpto 22 IfO Unit

10.192.55.67:22001
127.0.0.1:4096

10.192.55.208:502

10.192.55.67:2001

Idle
Idle

Idle

Idle

Add New Device ¥

Edit Device...

Delete...

‘ Update Static Tags... +— C||Ck Update
@ Static Tags

Configure Dynamic
Tags...

Device Health...

Close

46

Any deleted or modified tags will be listed in the Update Static OPC UA Tags dialog box.

Update Static OPC UA Tags

Report:

Deleted Tags
Mo tags were deleted.
Maodified Tags

Mo tags were modified.

Using Dynamic Tags

NOTE: This section on Dynamic Tags does not apply to the internal Ignition Edge OPC-UA server in groov EPIC or the
groov Box. See the groov EPIC User’s Guide or the groov Box User’s Guide for how to configure individual tags in the
Edge server.

Dynamic Tags are tags used with an external OPC-UA server that you enter manually one at a time in groov.
They are not configured on the OPC-UA server. Dynamic tags allow you to add as many or as few tags to groov
as you want, making it easier to find the tag you want.

Follow these steps to add dynamic tags to groov:

1. Inthe Configure Devices and Tags dialog, select the OPC UA server, and then click Configure Dynamic
Tags.
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Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller DScarr-w7:22001 Idle

T T Edit Device...
L SR laptop.opto22.com:49320/

Delete...

DScarr- —_—

My QPG Seney DR e W7.0PTO22.com:49320/ ke
Update Static Tags...

Modbus Slave Modbus Device 10.192.54.110:502 Idle

Configure Dynamic Tags. ‘

Click Configure
Dynamic Tags

Close

In the Configure Dynamic Tags dialog box, click Add.

In the Add Dynamic Tag dialog box, enter a Name and select the Data Type.

You must also make sure the Data Type selected in groov matches the type retrieved from the device.
If this tag is an array of objects with the same data type, select Array and enter the array size.

Choose the Access Read or Write attributes as needed.

Leave this dialog box open while you identify the Nodeld Value in the next step.

Add Dynamic Tag

Name: A human-readable name for the tag
Nodeld Value: | The tag's address as defined by the server's documentation [?]
Namespace 5 [?]
Index:
Data type: 32-bit Signed Integer v
Array: |
Array size:
Access: [VIRead [VIWrite
Add Dynamic Tag Cancel

To find the Nodeld Value for your device, open your OPC UA server configurator and find the configured
device associated with this tag.

You'll find part of the Nodeld information here. The remainder comes from the device itself. The
addressing syntax is different for each type of device, so you'll need to check the OPC UA server’s
documentation for this tag's device type.

As an example, here's how you find the Nodeld for a Rockwell Automation Logix tag on a KEPServerEX 5
server:

a. Open the KEPServerEX 5 Runtime configurator.
b. Locate the device and tag from which the dynamic tag in groov will obtain data.
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E KEPServerEX - Runtime [C:\Users\dscall\DocumenlS\Kepwale\KEPSewe!D(\VS\LDGD(.o...EIIEI
File Edit View Tools Runtime Help

* || Tag MName Address | Data Type

I & Click to add a static tag. Tags are not required, but are bre

m

EF Data Type Examples
Channel name —2 DTOL

tp ModbusChannel
E| Ei—‘ My Channel

PR il b el o i

Device name  —

Use this format for the Nodeld Value:

[Channel name].[Device name].[Tag group name].[protocol specific address]

So now you can extract the information you need from the server’s configurator and the device
itself:

[Channel name]=DTOL

[Device name]=Cmplx5370

[protocol specific address]=Program:MainProgram.i32Counter@Long

NOTE: The protocol-specific address is obtained from the device. If you have a Kepware server, the help file
provides the protocol-specific addressing information. To access help for a specific tag, click the device
name in the Kepware configurator, choose Properties, and click the Help button.

In this example, the “@Long” portion specifies the data type as an unsigned 32-bit integer. This forces the
server to report data to this type. If the default data type on the Kepware server is different from the tag’s
data type, the link will fail in groov unless you specify the data type in the Nodeld Value. For more
information on your specific data type, see the server’s documentation.

Putting it all together, here’s the Nodeld Value for this dynamic tag:
DTOL.Cmplx5370.Program:MainProgram.i32Counter@Long

7. Inthe groov Add Dynamic Tag dialog box you left open in Build mode, enter the Nodeld Value.

8. Inmost cases, the Namespace Index should stay at 2. However, for some servers (such as Ignition by
Inductive Automation) you should change the Namespace Index to 1.

Atag's Namespace Index is an integer (0 or higher) that tells groov how to find the tag on the server.
9. (lick Add Dynamic Tag.
10. Close the open dialog boxes.

The new dynamic tag appears in the Gadget Palette.

Gadget Palette

Tags |REELLERS

Configure Devices & Tags...

= KepServer

' Dynamic Tags | _—New dynamic tag

ABCounter/
[# Static Tags

# groov_Example

11. Now you're ready to add gadgets to a page using the new tags you just created. For instructions, see
“Adding Gadgets”on page 67.
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12. After you've added some gadgets and associated tags to them, select File > Save All Changes and Switch
to groov View.

[t might take a few moments for the OPC UA connection to be established and live values to appear.

Configuring the Windows Firewall for an OPC UA Server

Use this section only if:
«  You are using groov Server for Windows and the OPC-UA server is installed on a different computer, OR

«  You are using an external OPC-UA server with the groov Box. (Do not use this section for the internal
Ignition Edge server in groov EPIC or groov Box.)

If your OPC UA server is not on the same computer as groov View, inbound traffic to the OPC UA server needs
to be able get through the firewall on the port used by the server. To allow access through the firewall requires
adding an Inbound Rule to the Windows Firewall on the computer where the OPC UA server is installed.

As an example, the following instructions describe how to add in Windows 7 the Inbound Rule for port 49320,
the default port for the KEPServerEX 5 server.

1. After you have successfully installed the server, open the Windows Control Panel.

2. [Ificons are displayed in the Control Panel, click Windows Firewall. If categories are displayed in the
Control Panel, click System and Security and then click Windows Firewall.

3. Inthe left panel, click Advanced settings.

File Edit View Tools Help

Control Panel Home

Allow a program or feature

through Windows Firewall
'5' Change notification settings

'5' Turn Windows Firewall on or
off

'E‘;' Restore defaults

» 'E‘;' Advanced Wings

Troubleshoot my network

The Windows Firewall with Advanced Security dialog box opens.
4. Inthe left panel, click Inbound Rules.

E&9 Windows Firewall with Advance
&3 Inborqd Rules
Y Outbound Rules
®a Connection Security Rules
B Monitoring

5. Inthe right panel, click New Rule.

Actions

Inbound Rules -

MNew Rule... {b

Filter by Profile

=

Filter by State

44 <E

Filter by Group

v v v w

View
|G Refresh
|5+ Export List...

E Help
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6. ForRuleType, select Port. Click Next.

What type of rule would you like to create?

Rule that controls connections for a program.
» @ Port
Rule that controls connections for a TCF or UDP port.
1 Predefined:

BranchCache - Content Retrieval {Uses HTTF)

Rule that controls connections for a Windows experience.

() Custom
Custom rule.

7. ForProtocol and Ports, select Specific local ports and enter 49320 (the default Kepware port). Click Next.

Does this rule apply to TCP or UDP?

@ 1CP
©) upP

Does this rule apply to all local ports or specific local ports?

) All local ports

» @ Specific local ports: 49320
Example: 80, 443, 5000-5010

8. For Action, select “Allow the connection.” Click Next.

What action should be taken when a connection matches the specified conditions?
» @ Allow the connection
This includes connections that are protected with IPsec as well as those are not.
1 Allow the connection if it is secure
This includes only connections that have been autherticated by using IPsec. Connections

will be secured using the settings in IPsec properties and nules in the Connection Security
Rule node.

1 Block the connection

9. For Profile, select Domain and Private. Click Next.

When does this rule apply?

Domain
Applies when a computer is connected to its corporate domain.

[¥] Private
Applies when a computer is connected to a private network location.

7] Public
Applies when a computer is connected to a public network location.

10. For Name, enter a descriptive name such as “Kepware OPC-UA Server.”
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11. Click Finish.
12. Exit the Windows Firewall and Control Panel dialog boxes.

Adding System Tags

You can get tags for information about a groov product itself and use them in your mobile interface. For
example, you might want to show operators the current time and date. Or an Admin page might include
system uptime, number of current user sessions, and so on.

To make these tags available, you add System as another device.

1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags, or select
Configure > Devices and Tags.

Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

2. C(lick Add New Device and then select System.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle Opto 22 I/0 Unit
Edge server 0OPC UA Server 127.0.0.1:4096 Idle Opto 22 Controller
Data Simulator Data Simulator OPC UA Server
Modbus power Modbus Device 10.192.55.208:502 Idle Modbus Device
Mysgl database Data Store Syste:

Line 1 LC-R1 Opto 22 I/0 Unit 10.192.55.67:2001 Idle Data Sudre

Close

3. System appears in the list of devices.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle

Edge server OPC UA Server 127.0.0.1:4096 Idle &
Data Simulator Data Simulator Delete...

Modbus power Modbus Device 10.192.55.208:502 Idle -
Mysql database Data Store

Line 1 LC-R1 Opto 22 If0 Unit 10.192.55.67:2001 Idle

System System

4. C(lick Close, and notice that System tags are added in the Gadget Palette. Click the plus signs to expand
the tree and see all the tags.
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Gadget Palette

Tags

Configure Devices & Tags...

PTG o
= System
= groov
Admin Version
App Version
groov CPU Usage (%)
groov Uptime
Heap Usage (MB)
Number of Active Sessions
Time

Date

Operating System

System tags
Tag

groov > Admin Version

groov > App Version

groov > groov CPU Usage (%)

groov > groov Uptime

groov > groov Heap Usage (MB)

groov > Number of Active Sessions

Time >

Date >

Operating System* >
System CPU Usage (%)

Operating System* > System Uptime

All possible tags are shown in the list, but some may not apply to
your groov product. For example, groov Admin version applies only
to a groov Box, not to groov EPIC or a groov Server.

The table below shows information about the tags.

NOTE: It's possible to choose an LED or Image Indicator gadget for Time
or Date, but since time and date values are strings, you cannot set a
numeric range for these gadgets. For example, you can set an LED to be
blue at exactly 8:00 and black at any other time, but you cannot set it to
be blue between 8:00 and 12:00.

Meaning

(groov Box only) Version of groov Admin running on the Box. (This
information is also available in groov View; click the gear icon and
choose About.)

Version of groov View software running on this groov product. (This
information is also available in groov View; click the gear icon and
choose About.)

Current CPU usage by the groov View software on either the

groov EPIC processor, the PC where groov Server is running, or the
groov Box, shown as a percentage. A negative value means the cur-
rent CPU usage is not available.

How long groov View software has been running

Amount of memory allocated within groov View software. Normal val-
ues depend on the size of your groov View project.

Number of user sessions currently viewing your groov View interface.
Typically the number of current users, but one user logged in through
two devices or browsers will be counted twice.

Time of day. For groov Server, the time on the PC groov Server runs
on. For groov EPIC or a groov Box, see the product’s user guide to set
time, set time zone, or synchronize with a time server.

Choose the format you want. HH indicates a 24-hour clock; hh indi-
cates a 12-hour clock.

From the groov EPIC processor, the PC groov Server runs on, or the
groov Box. Choose the format you want. MM means the month is
shown in digits; MMM means the month is written out. For example,
DD MMM YYYY might appear as 26 Jul 2017.

Current CPU usage for the whole system, shown as a percentage. A
negative value means the current CPU usage is not available.

How long the hardware (the groov EPIC processor, the PC groov
Server runs on, or the groov Box) has been running.

* Operating System refers to the hardware the groov View software runs on, either the groov EPIC processor,
the PC that groov Server runs on, or the groov Box.
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Computed Tag

tag is a tag you create that is the result of a JavaScript function performing a calculation on one

or more source tags. A source tag can be a tag from another device or a data store. For example, you might
want to create a computed tag to:

«  Convert a temperature value from Fahrenheit to Celsius

«  Sum the number of gallons in multiple tanks to get a total value

You will need to know JavaScript to create computed tags. (Many references and training are available online;

for example,

https://www.w3schools.com/js/.)The data type of the final output of the JavaScript function

(which becomes the data type of the computed tag) can be boolean, integer, float, or string.

Creating a Computed Tag

Before you create a computed tag, make sure you add the devices or data stores that contain the source tags.
1. Open up your groov View project and switch to Build mode.
2. Inthe Gadget Palette, click Configure Devices & Tags.

3. C(lickCo

mputed Tags, then Configure Tags.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥

Computed Tags Computed Tags § i

Data Simulator Data Simulator w

LC 1 Opto 22 1/0 Unit 10.192.57.90:2001 Scanning Delete...

System System -
‘ Configure Tags... ‘
—@7

4. C(lick Add New Tag. groov View displays the Add Computed Tag window. (For a description of the fields,
see page 60.)

Add Computed Tag

Nome: | |

Inputs:

input1 Choose Tag...
Add Input
Output Type: Boolean v
Script: function evaluateTag(inputl) {

return inputil;

Save Tag Cancel
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5. Inthe Name field, type a name for the computed tag.

In the next few pages, we will create two computed tag examples to help explain the instructions. The first
one (converting a source tag) will be named Temp (Celsius). Thesecond one (summing several source
tags) willbe named Sum A1l Tanks.

To create a computed tag that converts a source tag to another value:

a. C(lick the text box in the Inputs section (by default, the text box has the word input followed by a
number). Type in a name that will identify the source tag in the JavaScript function.

This name must comply with the syntax rules of pre-Javascript 1.5, which limits the range of
characters to ASCII. In the following example, we named the input degreesFahrenheit.

Add Computed Tag

Name: Temp (Celsius)
Inputs:
o | degreesFahrenheit ‘ Choose Tag...
Add Input

b. Click Choose Tag. Navigate through the Update Tag for Gadget window to find your desired tag.
After you select the tag, click Update Gadget.
In the following image, we selected the Store_Temperature tag as the source for degreesFahrenheit.

Update Tag for Gadget

~

No Tag
® Computed Tags
® Data Simulator
Events
BLC1
User Configured
© Modules
# Module 0 (4-channel digital input)
@ Module 1 (4-channel digital output)
& Module 2 (SNAP-AOV-27)
© Module 3 (SNAP-AICTD)
Store_Temperature VALUE
Office_Temp VALUE
@ Module 4 (SNAP-ALV)
® Module 5 (SNAP-AQV-7)
@ Module 6 (SNAP-ATV-4)
& Module 7 (SNAP-AIMA)
# Module 8 (4-channel digital input) d

Array index: Bit index:

‘ Update Gadget | Cancel
dy =
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c. (lick on the drop-down list for Output Type and select the data type that your JavaScript function
will return.

This is the data type of the computed tag and determines which gadgets can use it. For the
temperature example, we selected float.

d. Inthe Script box, click in the white space to type in the JavaScript function that converts the source
tag to your desired output, making sure the type it returns matches the Output Type.

In the example we started in step a, we can convert the store temperature from Fahrenheit to
Celsius with the following function: return (degreesFahrenheit - 32) / 1.8;

The following image shows the completed window:

Name: Temp (Celsius)
UL degreesFahrenheit Store_Temperature VALUE...
Add Input
Output Type: Float v
Script: function evaluateTag(degreesFahrenheit) {

return (degreesFahrenheit - 32) / 1.8;

Save Tag Cancel

e. C(lick Save Tag.
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To create a computed tag that uses multiple source tags:

a. (lick the text box in the Inputs section (by default, the text box has the word input followed by a
number). Type in a name that identifies the source tag.

This name must comply with the syntax rules of pre-Javascript 1.5, which limits the range of
characters to ASCII. The following image shows the name we assigned to the first input: Tank_ 1.

Add Computed Tag

Name: Sum All Tanks
Inputs:
- Choose Tag...
Add Input
Output Type: Boolean ¥
Script: function evaluateTag(Tank_1) {

return inputil;

b. Click Choose Tag.
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c. Navigate through the Update Tag for Gadget window to find the tag you want to use.

No Tag
® Computed Tags
® Data Simulator
Events
B1C1
User Configured
= Modules

Array index:

® Module 0 (4-channel digital input)
® Module 1 (4-channel digital output)
@ Module 2 (SNAP-AQV-27)
@ Module 3 (SNAP-AICTD)
= Module 4 (SNAP-ALV)
Fuel_Level VALUE
Analog IN (4, 1) VALUE
® Module 5 (SNAP-AOV-7)
® Module 6 (SNAP-ATV-4)
® Module 7 (SNAP-AIMA)
# Module 8 (4-channel digital input) v

~

Bit index:

‘ Updatergadget ‘ Cancel
J

4

d. After you select the tag, click Update Gadget.

e. (lick Add Input to add another input. Repeat the previous steps to configure the new input with a
name and another source tag, then repeat this step until you have added all your source tags.
The viewable area of the Inputs section is limited, so if you specify more than two inputs, you will
have to scroll through the box to see the other inputs. The following image shows the scroll bar to
the right of the Inputs box:

Add Computed Tag

Name:

Inputs:

Output Type:

Script:

Sum All Tanks

Tank_2 Fuel Level VALUE...
i

Tank_3 Fuel Level VALUE...

o
Boolean v

function evaluateTag(Tank_1, Tank_2, Tank_3) {

return inputl;
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f.  Click the drop-down list for Output Type and select the data type that your JavaScript function will
return.
For our example, we selected float.

g. Inthe Script box, click in the white space to type in the JavaScript function that manipulates the
source tags into your desired final value, making sure that the type of the final value matches the
Output Type.

For our example, adding the three inputs gives us the desired final value:

Name: Sum All Tanks
Inputs: Tank_2 Fuel Level VALUE... .
i}
Tank 3 Fuel_Level VALUE...
m v
Output Type: Float N
Script: function evaluateTag(Tank_1, Tank_2, Tank_3) {

return (Tank_1 + Tank_2 + Tank_3);

Save Tag Cancel

h. Click Save Tag.
After you have finished creating a computed tag, groov View displays the tags in the Configure
Computed Tags window.
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Configure Computed Tags

4 Name Output Type Ready? Add New Tag...

Sum All Tanks Float Ok =

Temp (Celsius) Boolean Ok It...
Duplicate Tag...

Delete Tag...
Export Tag
Import Tags...
Close

6. Click Close to close the Configure Computed Tags window. Click Close to close Configure Devices and

Tags window.

In the Gadget Palette, you can expand the Computed Tags branch to view the computed tags you created, as
well as click a tag to view the gadgets you can use with it:

Tags

Configure Devices & Tags...

Gadget Palette

F

B Computed Tags
Sum All Tanks
Temp (Celsius)

Data Simulator
Events

LC 1

System

Click on the name of a
computed tag to view
gadgets that can use the
tag.

Gadget Palette
Gadgets

Configure Devices & Tags...

Tags

2 Computed Tags
Sum All Tanks

Temp (Celsius)

O e

Text Text Area

L:12 value

@ Image Indicator
@ Trend

Auto  auto Navigator

)—|_||
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Add Computed Tag Window

Add Computed Tag

Name: New Computed Tag A
Inputs:
B P input1 Choose Tag... C
D Add Input
Output Type: Boolean N E
Script: function evaluateTag(inputl) {

moo

return inputl;

Save Tag Cancel

Name for the computed tag. groov View displays this name under the Computed Tags branch of the
tag tree.

Name of the input to the JavaScript function. This name must comply with the syntax rules of
pre-Javascript 1.5, which limits the range of characters to ASCII. groov View updates the first line (in
gray) of the Script box with this name.

Click Choose Tag to identify the source tag for this input.

Click Add Input if you need to add more than one input.

Select the data type of the computed tag, which determines which gadgets can use it.

- Boolean

- Integer

- Float

- String

Clickin the white space of the Script box to add your JavaScript. You cannot edit the first line (in gray)
of the Script box. If you want to change any of the names in the first line, edit the corresponding
input.

groov View User's Guide



CHAPTER 2: BUILDING A PROJECT

Configure Computed Tags Window

You can add, edit, duplicate, delete, export, and import computed tags through the Configure Computed Tags

window:

Configure Computed Tags

mo OwW>»

M

4 Name Output Type Ready? Add New Tag... —A
Sum All Tanks Float 0Ok

: Edi... —B
Temp (Celsius) Boolean 0Ok

Duplicate Tag... ———— C

Delete Tag... ——— D

Export Tag S E

Import Tags... —— F

Close

For instructions on how to add a computed tag, see “Adding a Computed Tag” on page 53.

Select a tag from the list on the left, then click Edit.

Select a tag, then click Duplicate Tag. groov View makes a copy of the tag and lists it immediately
below the original tag.

Select a tag, then click Delete Tag. To confirm, click Delete Tag.

Select all the tags you want to export, then click Export Tag. In the Save As window, navigate to the
folder where you want to store the file. To change the name, type the new name in the File Name
field. Click Save.

Click Import Tags. In the Open window, navigate to the folder where the file is stored. Select the file,
then click Open. groov View imports the tags found in the file and adds them to the Configure
Computed Tags window, highlighting them and indicating any changes you need to make. In the
following example, two tags were added that need inputs configured:

Configure Computed Tags

4 Name

Output Type Ready? Add New Tag...

Sum All Tanks
Sum All Tanks
Temp (Celsius)
Temp (Celsius)

Float Ok

Edit...
3 tags are unconfigured. :

Duplicate Tags...

1 input is unconfigured.

Delete Tags...

Select a tag and click Edit to make the changes needed.
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Adding a Data Store

A Data Store provides a way in which users of your groov View operator interface can interact with data from
an online service, a database, or another software application. For example, your company’s SQL database
could place production or maintenance data into a groov Data Store for users to see. Or your groov View users
could enter production or service data for the database to pull in.

Your application uses the groov View REST API to either put =

data in groov View or get data from groov View. View logs...

groov User's Guide
groov Server for Windows User's Guide

To see the full groov View REST API, in Build mode choose Help >

groov Public API, as shown at right. You can also find the APl on Guide to Networking groov
developer.opto22.com. Readme Notes

groov Server for Windows Readme Notes
You add a Data Store for each application that will interact with groov Public APL |\
groov View, and then add the tags you want the application to Check for Updates
read or write to. About...

NOTE: A groov View Data Store is another device in groov View, like a Modbus/TCP serial device or a SNAP PAC
controller. Devices cannot talk with each other directly. Forexample, a SNAP PAC cannot read data from a Data Store.
However, you can use Node-RED in groov EPIC or the groov Box (or on your PC) to create a logical flow that exchanges
data between devices that have Node-RED nodes. For more on Node-RED, see nodered.org and the user’s quide for
your groov EPIC or groov Box.

Here's how to add a Data Store in groov View:

1. Under Gadget Palette on the right side, in the Tags tab, click Configure Devices & Tags. Or select
Configure > Devices and Tags.

Gadget Palette

Configure De\ficgﬁ & Tags...

T _ 1

2. Click Add New Device and then select Data Store.

Add New Device ¥

Opto 22 I/O Unit
Opto 22 Controller
OPC UA Server
Modbus Device

Data StoIrE

<

3. Give the Data Store a name and click Create.
The Data Store appears in the list of devices.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle
Edge server 0OPC UA Server 127.0.0.1:4096 Idle w
Data Simulator Data Simulator Delete...
Modbus power Modbus Device 10.192.55.208:502 Idle —
Line 1 LC-R1 Opto 22 I/O Unit 10.182.55.67:2001 Idle Configure Tags...
System System

S e

groov View User's Guide


https://nodered.org/
http://developer.opto22.com/

CHAPTER 2: BUILDING A PROJECT

Highlight the Data Store and click Configure Tags. Click the Add button in the upper left.

Configure Data Store Tags

¥ Tag Name Data Type Table Length

‘ dentifying Name ‘ |Boo|ean "| || Table 4

Cancel | Save || Save & Add Another

Enter the following tag attributes:
Tag Name: (Required) Give the tag a descriptive name.
Data Type: (Required) Select the data type that will be written to or read from this tag.

Boolean v

Integer
Decimal Number

Boolean

String

Table: (Optional) If the tag is an array, check the Table box and enter the table length. From a practical
standpoint, table length can be whatever you need (within the limits of your system'’s capacity).

Click Save, or click Save & Add Another to add another tag.
When your tag appears in the list, note the Tag Id; you will use it when accessing the tag.

Configure Data Store Tags

¥ Tag Name / Tag Id \ Data Type Table Length

Part # guantity W Integer

When you've finished adding tags, click Close. Click Close again and notice that your Data Store appears
in the Gadget Palette with the name you gave it. Click the plus sign to see the tags in the store.

Editing Device Information

If a device's hostname or static IP address has changed, you'll need to edit the hostname or address in Build
mode. You can also change other information for a device, such as its port, timeout, or scan interval.

Select Configure > Devices and Tags.
Select the device and click Edit Device.
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Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller B W WSS Idle

Edge server OPC UA Server " Idle ‘ SR ‘
Data Simulator Data Simulator Delete...

Modbus power Modbus Device 5 n Idle S ——
Line 1 LC-R1 Opto 22 I/0 Unit Idle Update Strategy...
System System

Device Health...
Mysqgl Database Data Store S

Close

3. Change the information as needed and click Edit Device.
4. C(Close the Configure Devices and Tags dialog box.

Disabling Communication to a Device

Disabling communication to a device can be helpful in situations where a device incurs communication costs,
as well as while testing when a device is not installed yet or is not available. You can disable communication
during time periods when you don't need to communicate to the device.

1. Select Configure > Devices and Tags.
2. Select the device and click Edit Device.

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller B W WSS Idle

Edge server OPC UA Server " Idle ‘ SR ‘
Data Simulator Data Simulator Delete...

Modbus power Modbus Device 5 n Idle S ——
Line 1 LC-R1 Opto 22 I/0 Unit Idle Update Strategy...
System System

Device Health...
Mysqgl Database Data Store S

Close

3. (lick the Enabled box to remove the check.

For example, the following image shows the location of the Enabled box in the “Edit Opto 22 Controller”
dialog box.
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Edit Opto 22 Controller test

Controller Address:

Controller Port:

Connection Timeout:

Scan Interval: seconds

@ Enabled _

String Encoding: UTE-8 v

Most users will be fine with the default string
encoding, UTF-8. The only reason to change this is if
you know your strategy is storing strings with a
different encoding.

Edit Device  Cancel |

4. Click Update Device to close the Edit Device dialog box.

When you return to View mode, any gadgets that refer to tags from that device display an error message
similar to the following:

& This device is disabled.

Deleting a Device

You can a remove a device from your project. However, be aware that any tags from the removed device will
be removed from all gadgets.

1. Choose Configure > Devices and Tags.
2. Highlight the device you want to remove and click Delete.
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Configure Devices and Tags

Mysqgl Database

Data Store

4 Name Type Address Status Add New Device ¥
Cookies Opto 22 Controller 10.192.55.67:22001 Idle
Edit Device...

Edge sarver OPC UA Server 127.0.0.1:4096 Idle st it

Data Simulator Data Simulator Delete... ‘
Modbus Device 10.162.55.208:502 Idle

Line 1 LC-R1 Opto 22 If0 Unit 10.192.55.67:2001 Idle Configure Tags...

System System

Device Health...

Close

3. C(lick Delete Device.

4. C(Close the Configure Devices and Tags dialog box.

Viewing Device Health

The Configure Devices and Tags dialog box shows you the status of each device connected to groov View.
1. Choose Configure > Devices and Tags.
2. Highlight the device you're interested in and notice the Status column:

Configure Devices and Tags

4 Name Type Address Status Add New Device ¥
Opto 22 Controller 10.192.57.110:22001 Scanning -
Weather Station Opto 22 Controller 127.0.0.1:22002 Idle %
Data Store Data Store Delete...
Learning Center Opto 22 1/0 Unit 10.192.57.110:2001 Idle —
Data Simulator Data Simulator Update Strategy...
System System Device Health...
Close
Possible status notations are:
Status Meaning
Idle groov View is not currently connected to the device; nothing is being scanned on it.
Scanning groov View is reading tag data from the device: everything's working fine.
Degraded groov View is reading tag data from the device, but it isn't responding fast enough
to keep up with all requests.
Error groov View encountered an error while connecting to the device. This status

usually means the device is offline, or there's a network issue.

3. Tosee more information about this device, click the Device Health button at the right.
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Convenience Store - Device Health

Response Times over the last 5 minutes
Average Minimum Maximum 75th Percentile 99th Percentile

4.02ms 3.01ms 8.49ms 4.23ms 4.84ms

Request and Error Rates per minute

Last Minute Last 5 Minutes Last 15 Minutes
Read Requests 60.0 61.6 66.1
Write Requests 0.0 0.0 0.0
Dropped Requests 0.0 0.0 0.0
Errors 0.0 0.0 0.0

Done

Response Times—Tracks how long a device takes to fully respond to a request. A typical request would
be reading a batch of tags (up to 20 at a time), or writing a single tag. Response Times are tracked over
the last 5 minutes and show Minimum, Maximum, and Average response times. Values in the 75th and
99th percentiles mean that, for example, 75% of your requests finish in the reported time.

Request and Error Rates—Tracks the number of read and write requests sent to the device over the
last 15 minutes, and reports the average requests per minute over the last 1, 5,and 15 minutes. Read
requests typically involve more than one tag, while writes are typically one tag at a time.

Dropped Requests result from too many requests in the queue. If the queue is too full, the oldest read
requests may be dropped. If Dropped Requests are more than 1.0 for the last minute, device health status
changes to Degraded.

Errors indicate connection errors and are also reflected in the health status column until either the
connection is successful or the device no longer needs to be scanned (for example, if no one is viewing a
page that includes tags from that device).

ADDING GADGETS

There are two basic methods for adding a gadget and associating a tag. You can start with a gadget and add a
tag to it. Or you can start with a tag and then add the tag’s gadget.

See "Method 1: Add a Tag to a Gadget,” page 67
See "Method 2: Add a Gadget to a Tag,” page 68

Method 1: Add a Tag to a Gadget

Drag a gadget from a toolbox onto the page, and then assign it a tag.
1. Select the Gadget tab in the Gadget Palette.
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Gadget Palette

Gadgets
Ly

C] Group Header

ADBC_ |ine Header

— Divider

Page Ppage Navigator

Auto  Auto Navigator

Either double-click a gadget or drag it to the work area.
3. Selectthe gadgetin the work area and look at the Gadget Properties panel (upper right).

Round Gauge Properties

Tag

L 3 Mo tag t\:_c:e\.
Visibility

% | No tag selected %
Range

Min value: 0

Max value: 10

4, C(lickthe little tag next to No Tag Selected.

5. Inthe Update Tag for Gadget dialog box, click the plus signs to browse to the tag you want to use, select
it, and then click Update Gadget. (Or just double-click the tag in the list))

6. Configure the gadget's properties. See “Configuring Gadget Properties”on page 69.
7. Choose File > Save All Changes.

Method 2: Add a Gadget to a Tag

Click a tag and assign an available gadget.

1. Click the Tags tab in the Gadget Palette panel, then click the plus signs to expand the tree and locate the
tag you want.

Gadget Palette

ET LN Gadgets

Configure Devices & Tags...

2 'MainTest' at 10.192.54.11(
& Nurmneric Variables
& String Variables
& Numeric Tables
® String Tables

| »

m

Expand the tag's @ Digital Input Points
category & Digital Qutput Points
Alarm =

Freezer oor_Status
Inside_ﬂt
Qutside_Light

@ Analog Input Points

# Analnn Antnut Dainte

2. (lick the tag to see a list of gadgets that work with the selected tag.
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Freezer_Door_Status

0 o |

Checkbox
Button
Command Button
a=1 Text Area

Plat

3. Either double-click a gadget or drag it to the work area.
4, Configure the gadget’s properties. See “Configuring Gadget Properties”on page 69.
5. Select File > Save All Changes.

EDITING GADGETS

Resizing and Moving Gadgets

When you resize or move gadgets in either the Desktop & Tablet layout or the Handheld layout, the change
does not affect the other layout. See “Optimizing Layouts”on page 72 for more information on layouts.

— Resize

Move

«  Tomove a gadget, grab it with the left mouse button and drag it. To move multiple gadgets, click on an
empty part of your page and drag a box around the gadgets. Or hold down the CTRL key while selecting
gadgets.

«  Toresize a gadget, click it, grab a graphic handle, and drag to the new size.

If a gadget is behind another gadget, you can make its sizing handles available by clicking on an exposed
portion of the gadget.

. Sizing handles

Run

Configuring Gadget Properties
To configure a gadget, click the gadget to display its Properties panel (in Tag .
the upper right corner of the workspace). % | Mo tag selected
Fach gadget has its own specific properties. For example, part of the LED Ve
Gadget Properties panel is shown at right. hl |- R o
See Chapter 4: Gadget Reference for information on specific gadget i
properties. Default 9%
Alignment
= %
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Properties and Layouts

Any property with a linkicon = % | next to it can be changed in one layout (Desktop & Tablet, or Handheld)
without affecting the other layout. See “Optimizing Layouts”on page 72 for more information on layouts.

Depending on the gadget, you can change the gadget's visibility, label name, text size, alignment, color of text
and its background, value precision, indicator colors, whether it is oriented vertically or horizontally, and more.

For example, suppose you want a gadget's label to appear on the left side of the gadget in the Desktop &
Tablet layout, but on the right side in the Handheld layout. Here’s how to change it.

1. Click the Desktop & Tablet tab, and then click the gadget you want to change.

2. Inthe Properties panel, make sure Alignment is to the left.

Alignment

- = 5, <4— Linkicon

; Label alignment: left of gadget

only the current layout.
Click the Handheld tab and click the same gadget.
5. Inthe Properties panel, notice that the link is broken. Change Alignment to the right.

Alignment

|- - 5 <— Broken link

B

6. Checkboth tabs to see how the label on this LED will appear in the two layouts:

Desktop & Tablet m Deskiop & Tablet ENTGLTL]

<—— Label on left
Pump 2 0 Label onright — o Pump 2

Languages in Buttons and Labels

When adding text to a gadget, groov has full Unicode support and uses very common fonts such as Arial with
broad support for most languages.

N -~ ‘
7 \g / ‘Buttongadget

Cutting and Pasting Gadgets

« Tocutor copy a gadget, right-click it to open the popup menu, and then select Delete, Duplicate, Copy,
or Cut.

«  To paste a copied or cut gadget, left-click the workspace, then right-click and select Paste from the
popup menu.

«  To select more than one gadget at a time, hold down the CTRL key as you click them. Or draw a box
around multiple gadgets.
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As indicated on the popup menus, you can also use keyboard shortcuts for Copy (CTRL + ¢), Cut (CTRL + x), and
Paste (CTRL + v). Or choose Copy, Cut, or Paste from the Edit menu.

Making a Gadget Visible Based on a Tag

You can change a gadget's visibility in groov View based on:

« Aninteger variable. A value of O will hide the gadget, any non-zero value will show the gadget. To
indicate which integer variable:

a. C(lickthe Tag symbol.
b. Navigate through the Update Tag for Gadget window to select the integer variable.
c. Click Update Gadget.

«  Aboolean tag. A value of 0 will hide the gadget, a value of 1 will show the gadget. To indicate which
boolean variable:

a. (lick the Tag symbol.
b. Navigate through the Update Tag for Gadget window to select the integer variable.
c. (lick Update Gadget.

«  Thebit of an integer variable or element of an integer table. A value of 0 will hide the gadget, a value of 1
will show the gadget. To indicate which bit:
d. Clickthe Tag symbol.
e. Navigate through the Update Tag for Gadget window to select the integer variable or integer table
(array).
f.  Specify the bit:
- Forinteger variables, specify the bit number in the Bit field.

—  Foranelement of an integer table, specify the element number in the Array index field, then
the bit number in the Bit field.

g. Click Update Gadget.

Moving a Gadget to the Front or Back

If gadgets overlap and you want to change the order of the stack, right-click a gadget and select Bring To
Front or Send To Back.

If you don't want a gadget to move, choose Lock Position.

Or choose Bring To Front, Send To Back, or Lock Position from the Edit menu.

Aligning Gadgets

To align multiple gadgets, click on an empty part of your page and drag a box around the gadgets (or hold
down the CTRL key while selecting them), then right-click and choose the alignment type. The Align
commands are also available in the Edit menu.
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Dispense Valve

Uptake Valve

\

Dispense Valve

Uptake Valve

Delete
Duplicate

Copy
Cut
Paste

Select All

Bring To Front
Send To Back

Lock Position
Unlock Position
Align

Size

Ctrl+C
Ctrl+X
Ctrl+Vv

Ctri+A

» Align Left
) Align Right

Adjusting the Size of Multiple Gadgets

| Align Top
| Align Bottom

To make multiple objects the same size, drag the cursor around the gadgets (or hold down the CTRL key while
selecting them), then right-click and choose how to size them. The Size commands are also available in the
Edit menu.

Dispense Valve

4

Uptake Valve M

\

Dispense Valve

Uptake Valve m

OPTIMIZING LAYOUTS
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Delete
Duplicate
Copy

Cut

Paste

Select All
Bring To Front
Send To Back
Lock Position
Unlock Position
Align

Size

Ctrl+C
Cirl+X
Ctrl+V
Ctrl+A

»
b Width to Widest

| Width to Narrowest

| Height to Tallest
| Height to Shortest

| Default Size

In Build mode there are two different layouts: Desktop & Tablet and Handheld. The Desktop & Tablet layout
shows you how gadgets will appear when viewed on a computer monitor or a tablet. The Handheld layout is
for viewing on a smaller handheld device such as a smartphone.

groov View automatically shows the appropriate layout for the device being used. Or, if you are using the groov
View app for iOS or Android on a mobile device, you can choose which layout to view.
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If most of your users will view your groov operator interface on a smartphone, you may want to start building
your project in the Handheld layout tab. No matter where you start, you can adjust both layouts to optimize
them for the people who will use them.

For any given page, by default both layouts contain identical gadgets and properties, but you can make the
layouts different in several ways.

To work on a layout, click the tab for either Desktop & Tablet or Handheld at the top of the page.

Click tab

|
BEEAGLERELE S Handheld

0.00
100=1
90-5
30—5

70-

60-=

50-"o

m

You can switch between tabs as needed to make each layout the way you want. You can:

Change a gadget's size and position in one layout without affecting the other one. For example, you can
move the most important gadgets to the top in the Handheld layout. See “Editing Gadgets”on page 69.

Hide a gadget in one layout and show it in the other. See “Using the Page Stash”on page 23.

Change the size, color, and alignment of gadget text in one layout only, for example to fit more on a
smaller screen. But be careful not to make text too small to read or controls too small to use with your

finger. See “Properties and Layouts”on page 70.

Show a different gadget label on one layout than on the other. See “Properties and Layouts”on page 70.
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«  Orient a gadget horizontally in one layout and vertically in the other. See “Properties and Layouts”on
page 70.

Fach gadget has individual properties that may limit or expand what you can do with it in a layout. See
Chapter 4: Gadget Reference for information on each gadget.
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3: Managing groov View

This chapter describes how to manage user accounts, back up and restore your project, update groov View
and your license, and more.

In this chapter:

Managing User Access 75
Managing Images in the Image Library 82
Adding a Page Category 85
Viewing the Tags in Use 87
Viewing Log Messages 88
Changing the General Project Settings 89
Saving Your Project and Opening groov View 92
Backing Up and Restoring Your Project 92
Resetting your groov Project 94
Updating groov 94
Updating Your License/Renewing groov Maintenance................. 96

MANAGING USER ACCESS

When you build or change your groov View project, you have specific ideas in mind about which people will
use the mobile operator interface and which software applications will have access to groov data. Managing
these people and applications—your groov View users—is the key to maintaining security. Here are some
examples:

People—You may want a line operator to monitor and control equipment on the line, while a supervisor can
see widget production but has no control over the equipment. Or you may want a central station to monitor
equipment at remote sites, and field technicians to control it from a tablet.

Software—It's not just people who may need access to data in groov View. You may also want software
applications to access the data in a groov Data Store, using the groov API (application programming interface).
For example:

«  Acompany database could write daily sales totals for managers to see on their phones.

«  Acustom application you've written in C++, .NET, JavaScript, or another programming language could
share operational data from remote automation equipment, which then appears to technicians in groov
View.

«  Acloud data service like AT&T M2X or Amazon Web Services (AWS) could provide data on trucks and
freight containers to logistics personnel.

«  ANode-RED flow you build could tweet status to operators when pressure is unusually low. (For more
information on Node-RED, see the groov EPIC User’s Guide or the groov Box User’s Guide.)
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MANAGING USER ACCESS

Software clients that need to access data in groov View must be added as users in Build mode. We
recommend that each software client be assigned a unique username, password, and APl key. That way, if
multiple software applications are using the APl and one becomes compromised, the others can still operate
securely.

Because security is a top priority, you will restrict access to your groov View data and interface—or to parts of
it—to make sure that only authorized people and software can use it, and only in the ways you intended. Here
are three ways you can manage access:

Create an account for each user. Each person or software application that uses your groov View
operator interface or accesses its data must have an account with a username and password. When
people use your groov View interface, their passwords are encrypted. When applications access groov
View data, they must use their assigned API key to verify their identity.

Make sure all users understand the importance of security, keep their passwords and AP keys safe, and
understand how to change them.

See "Creating a User,” below.

Create user groups to control page access. With multiple users, groups are an easy way to define who
sees which pages. For example, you could create one user group for central station monitoring personnel
and two groups for field technicians, and then assign each user to the correct group. The Central Station
group sees pages showing all remote sites for monitoring. The Field Technicians West group sees pages
with controls for their geographic area; the Field Technicians East group sees similar pages for their area.
See "Managing User Groups”on page 80.

Create pages for specific purposes. If a line operator needs to monitor and control equipment, but a
supervisor only needs to monitor it, create two pages, one for each purpose. The operator’s page
includes controls; the supervisor's doesn't. See “Working with Pages”on page 20.

Creating a User

You must be an Admin user to create or change users.

1.

In Build mode, choose Configure > Accounts. Then click the Users tab.

Manage Accounts

€ Close

Users Groups Pages Create New User

Username Role Email API Key Groups

jean Admin moFUvgdejmXnhuVwnCjFkxaHoNCdIrny

Click Create New User.
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Create New User

Username | |
Email optional@example.com
Role Operator AN )

New Password

Confirm

Groups
| Line operators

Create User Cancel

Enter a username for the new user.

If this user will receive email notifications from groov View, enter the email address to use.
See Chapter 5: Using Events and Notifications.

Select a Role based on the security level for this user (Admin, Editor, Operator, or Kiosk).

For example, if you want a user to be able to log in and out of groov View and change their password,
choose the Operator security level. If you want a user to use View but not be able to log out or change
their password, choose Kiosk.

For software users, choose Admin or Editor. Lower levels cannot access a groov Data Store.
This table shows the privileges available for each security level:

Security Level

Admin Editor Operator Kiosk

Use and interact with the gadgets in groov ° ° P P
View
Log out and back in, and change their ° ° P

password in groov View

Use Build mode to add devices, make or ° °
change pages, & set groups on pages

Use the groov API to securely access ° °
data in a groov Data Store

Create users and groups, assign users to °
groups, and generate new API| keys

* Only for the user groups an Operator or Kiosk user belongs to. See page 80.

6.

For Operator or Kiosk users, if you have already configured groups, select the groups the user belongs to.

Groups are used to restrict access to particular pages. For example, if a page is restricted to members of
the group called West Wing, then an Operator or Kiosk level user must be in the West Wing group to
access that page. See “Managing User Groups”on page 80.

Click Create User.
The user appears in the list.
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Manage Accounts
L 3

€ Close
Users Groups Pages Create New User Filt

Username

A Role Email API Key Groups
Li

Bob Phang Operator Y8zJd9TX dtWH2obbstr7uHuapk3ag7fk e ra n
operators

jean Admin pFBfELXXAI7KYZMEDUG4Ss TMHRIVNAMNZ ra
Li

Jose Alvarez  Operator  jalvarez@company.com TDgEZP2c2YReNZX2kEgKIqg87Q6LEPHY u;:raturs ra u

Weather Editor ydvvMefPyaMfjL3gAxakByVND3cAHGM ra n

8. Give the username and password (for a person) or APl key (for software) to the user.
APl keys are automatically generated. To change an APl key, see “Changing a User’s Settings,” below.

Finding a Software User’s API Key

You must be an Admin user to see APl keys.
1. InBuild mode, choose Configure > Accounts. Click the Users tab.

Manage Accounts

»
€ Close
Users Groups Pages Create New User Filt me
Username
- Role Email API Key Groups
Li
Bob Phang Operator ¥8zJd9TXdtWH2obbstr7uHuapk3ag7fk i ra u
operators
jean Admin pFBfELXXAI7KYZMEDUG4Ss TMHRIVNAMNZ ra
Li
Jose Alvarez  Operator  jalvarez@company.com TDgEZP2c2YReNZX2kEgKIqg87Q6LEPHY u;:raturs ra u
Weather Editor ydvvMefPyaMfjL3gAxakByVND3cAHGM ra n

2. Find the user in the list (if you have a long list of names, use the Filter by name field to help). Read across
from the username to the API Key column.

Changing a User's Settings

You must be an Admin user to change user settings.
1. InBuild mode, choose Configure > Accounts. Click the Users tab.
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Manage Accounts

L 3
€ Close
Users Groups Pages Create New User Filt
Username
A Role Email API Key Groups
Li
Bob Phang Operator Y8zJd9TX dtWH2obbstr7uHuapk3ag7fk e ra u
operators
jean Admin pFBfELXXAI7KYZMEDUG4Ss TMHRIVNAMNZ ra
Li
Jose Alvarez  Operator  jalvarez@company.com TDgEZP2c2YReNZX2kEgKIqg87Q6LEPHY u;:raturﬁ ra u
Weather Editor ydvvMefPyaMfjL3gAxakByVND3cAHGM ra n

2. Find the user you want to change (if you have a long list of names, use the Filter by name field to help).
Click the editbutton = g | in line with the user's name.

Edit user 'Jose Alvarez'

Username Jose Alvarez
Email jalvarez@company.com
Role Operator )
API Key FeXnSNrSaAp4zmSRmwwL9svNjhPEEkwL Generate

Any key change takes effect after selecting Update User.

New Password

Confirm

| Require password change at next login

Groups

Update User Cancel

3. Change the user’s settings as needed. (See more information in “Creating a User” on page 76.) Note two
things you can do here that weren't available when you first created the user:

—  APIKey (applies to software users)—Click Generate to assign a new APl key (you cannot create
your own). After you update this user and return to Manage Accounts, you'll see the new APl key.
The old key is automatically disabled.

- Password change—You can assign the user a new password here, or check the box if you want to
force the user to change their password the next time they log in. (Note that the user’s current
password is not visible. There is no way to retrieve a user’s current password, but you can assign a
new one or require them to change theirs.)

4. (lick Update User.
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Deleting a User Account

You must be an Admin user to delete a user account.

A deleted user will no longer be able to log in.
1. InBuild mode, choose Configure > Accounts, then click the Users tab.

2. Inthelist, find the user you want to delete (if you have a long list, you can use the Filter by name field to
find it). Click the trash can button n in line with the user's name.

A confirmation message appears.
3. (lick OKto confirm.

Managing User Groups

You must be an Admin user to create or change groups.

Groups are used to restrict access to particular pages for Operator and Kiosk level users. For example, if a page
is restricted to members of the group called West Wing, then an Operator or Kiosk level user must be in the
West Wing group to access that page.

1. To work with groups, in Build mode choose Configure > Accounts. Then click the Groups tab.

Manage Accounts

€ Close

Users Groups Pages Create New Group Filter by name

Name Members Pages

- Todelete an existing group, find the group name in the list (if you have a long list, you can use the
Filter by name field to find it). Click the trash can button n in line with the group name.

- To create a new group, click Create Group.

- Toeditan existing group, find the group name in the list and click the edit button & | in line with
the group name.

Create Group

Group Name |

Group Members 3
jean
Bob Phang
Jose Alvarez
Weather

Access Pages
| Pump room

Refrigeration
Line 1 Operation
Line 1 KPIs
Main

Tanks - Field

Create Group Cancel
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2. Enteror change the Group Name, select the users to be included in the group, and select the pages this
group should see.

NOTE: You must have already designated page permissions as Limited Access, or the page will not appear here.
To change a page’s permissions, cancel this dialog box. In Manage Accounts, click the Pages tab. Find the page
you want to change and click the edit button in line with the page name. Under Access Rights, choose Limited
Access. For more information on page permissions, see “Changing Page Properties” on page 21.

3. Click Create Group (or Update Group).

Changing a User’s Password

How passwords are changed depends upon the user's security level.

«  An Admin level user can change any user's password; see “Changing a User's Settings” on page 78.
«  Admin and Editor level users can change their own passwords in either Build or View.

«  Operators can change their passwords in View.

m Changing your password in Build mode:

Log Out 'jean’
Log Out All Users...
Change Password...m

Choose Security > Change Password.

‘ Events ¥ Menu

B Siitchito Baldimade Changing your password in View:

~ Click the gear icon and select Change Password.
& (Change password

B

View logs

i About groov View

& groov Admin
= Sign out jean’

Fill in the form with the old
Change password for user 'jean’ and new passwords; then

click Change Password.

Original password:
New password:

Confirm password:

Cancel
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Logging Out Users

An Admin user can log out all logged-in users in one step. The users will no Help
longer be able to get gadget updates, write values, or change pages. ,

Log Out 'jean’
In Build, choose Security > Log Out All Users. Log Out All Users...

Change Password...

MANAGING IMAGES IN THE IMAGE LIBRARY

All images you use in your groov View project are stored in the Image Library. You can use the same image in
any number of places in your project, and if you change the image, it is updated everywhere it appears.

groov View accepts many different kinds of images, including photos, drawings, and logos with file types of
BMP, GIF, PNG, JPG, and SVG. You can even use an animated GIF. For best performance, use images no larger
than 2000 x 2000 pixels at 72 dpi with 8-bit color information, or a total of less than 300 KB in size per image.

You can upload images you make or obtain yourself and any of the drawings in the SVG Library on the

Opto 22 website. If you have Microsoft Visio 2003, you can also make a compatible image using any of our free

Visio libraries.

You can use images in a variety of ways:

«  Use multiple images in the Image Indicator to show status or value (see page 117).

«  Putyourlogo in the caption bar at the top of the page (see Groov View Styling in “Changing the General
Project Settings”on page 89).

«  Orient your users by showing an image of the location or device they're monitoring.

o Skin a button with an image (see page 109, page 110, and page 111).

«  Useanimage as a link to another page or Internet location (see page 102).

One caution: It's easy to overdo the use of images. Make sure you don't clutter your operator interface with

unnecessary graphics. Animations are especially distracting for users and should be avoided. Use images that
will help your users, not distract them from what's important on the screen.

Adding Images

You can add images to the Image Library directly, or you can add them while you're assigning properties to
gadgets.

Adding Images Directly to the Image Library
1. Toadd images directly to the Image Library, in Build mode choose Configure > Image Library.

€ Cancel Add New Images
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2. Either click Add New Images and browse to the location of the image or images you want, or just drag
the image(s) from their current location into the Image Library.

Image Library

4 Close Add New Images

Notes Notes

D

tank_fullyfull.jpg
Created

2016-02-29, 09:37:50
GMT-08:00

D

tank_partiyfull.jpg
Created
2016-02-29, 09:37:50
GMT-08:00

Base Size

W: 220px, H: 465px

Base Size
W: 220px, H: 465px

[ ID Notes
tank_empty.jpg

Created

2016-02-29, 09:37:50

GMT-08:00

ID Notes
icecube.svg

Created

2016-02-25, 14:02:29

GMT-08:00

Base Size

W: 95px, H: 89px

Base Size
W: 220px, H: 465px

.. Motes,

3. (Optional) Click inside the Notes area to add your own notes about the image.

Adding an Image to a Gadget

1. Toadd animage while you're setting the gadget’s properties, make sure the gadget is highlighted. In the
Properties panel (upper right), depending on the gadget, click Add Image or choose Display Mode >
Image and click the broken image button.

2. Inthe Image Library, select the image you want. Or click Add New Images, browse to the image, click
Open, and then select it in the Library.

The library closes and you return to the main workspace to choose image properties. See Chapter 4:
Gadget Reference for details on each gadget.

Changing Image View

To see more details about the images in the library, or to view more images in the same space, choose a
different view at the top of the library.
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84

Image Library

# Close

Image Library

4 Close

groov View User's Guide

Image details view (default)

Wi 220px, H: 465px

Wi 220px, H: 465px

Add New Images E
Notes D Notes
tankﬁpalﬂyfu\l._]pg tank_fullyfull.jpg
Created Created
2016-02-29, 09:37:50 2016-02-29, 09:37:50
GMT-08:00 GMT-08:00
Base Size Base Size
W: 220px, H: 465px W: 220px, H: 465px
D Notes D Notes
tank_empty.jpg icecube.svg
Created Created
2016-02-29, 09:37:50 2016-02-25, 14:02:29
GMT-08:00 GMT-08:00
Base Size Base Size
W: 220px, H: 465px W: 95px, H: 89px
._[D._ Bates,
Image basics view
Add New Images =
jin) jin) jin)
tank_partlyfull.jpg tank_fullyfull.jpg tank_empty.jpg
Created Created Created
2016-02-29, 2016-02-29, 2016-02-29,
09:37:50 GMT-08:00 09:37:50 GMT-08:00 09:37:50 GMT-08:00
Base Size Base Size Base Size
Wi 220px, H: 465px

jin)

icecube.svg
Created
2016-02-25,
14:02:29 GMT-08:00
Base Size

W: 95px, H: 89px

jin)
electricity_red_288x1
92.png

Created
2016-02-25,
15:52:28 GMT-08:00
Base Size

W: 288px, H: 192px

=

jin)
waterTank_off.svg
Created
2016-02-26,
10:21:18 GMT-08: 00
Base Size

Wi 260px, H: 260px
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Image thumbnails view

Image Library

€ Close Add New Images

Changing an Image

If you change an image, you can upload the new version to replace the r—

older one in the Image Library. You must have already made the change to s -

the image in another software program. é—n’

1. Choose Configure > Image Library and locate the image you want to
change.

2. (lickthe pencil icon at the left of the image and browse to the new
version of the image. Click Open to replace the image.

Deleting an Image

1. Choose Configure > Image Library and locate the image you want to
delete.

2. (lickthe trashcan icon at the left of the image.
The image is deleted.

ADDING A PAGE CATEGORY

If you have a large project, you can organize pages in the operator interface by creating categories and
assigning pages to them.

For example, if you have a multi-story building, you could make a category for each floor, and then add pages
to it that apply only to that floor. Or categories can represent individual machines, or rooms, or any number of
things.

When you create a new category, make sure to add at least one page to the category. Otherwise, the category
will be deleted automatically when you save and open View. Also see “Working with Pages”on page 20.

1. InBuild mode, click Add Category under Pages on the left side.
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86

P ow

-

» Headquarters
¥ Factory

Line 1
Operation =

Add Page...
Add Catego_ry'a[h:I

Type a new name for the category.

Add Category
Name:

OK Cancel

Click OK.

To put existing pages in the new category, in the Pages panel, use your mouse to drag and drop them
below the new category name.

s e

¥ Headquarters

¥ Headquarters

Refrigeration Refrigeration
Pump room Pump room
Main™® Main™®

Line 1 KPT* jt X
¥ Factory

Line 1 Operation™

¥ Factory
\ Line 1 Operation™®

Deleting a Category

Drag existing pages below the
new page category.

The process for deleting a category is similar to deleting a page. However, you can only delete a category that
doesn't have any pages assigned to it. To delete a category with pages, first move or delete the pages.

1.

2.

Hover over the page or category name in the Pages panel, then click the red X that appears.

‘ @H— Click the red X.

Click OK.

¥ Processing
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Delete Category

Delete category "Processing"?

‘. OKJH}‘ Cancel
| Jmy

Renaming a Category

1. Right-click the name and select Rename.

Rename h

Boiler Ro

CHAPTER 3: MANAGING GROQV VIEW

2. Enteranew label, and press Enter or left-click in the work area.

VIEWING THE TAGS IN USE

Level 2| "

To see all the tags being used in your project, select View > All Tags. The Tags in Use dialog box shows the tags
in use and the gadget or event they are used in, the device, and the page in your groov View project.

€ Close

Tag Name Gadget/Event
float32 Variable A Event: Tank A Level
float32 Variable B Range Indicator
float32 Variable B Range Indicator
float32 Variable B Range Indicator
float32 Variable B Range Indicator
Ramp A (0 to 10, 30 sec) Round Gauge

Tags In Use

Device

Data Simulator

Data Simulator

Data Simulator

Data Simulator

Data Simulator

Data Simulator
e I B T e S, L VAN S g

‘ Sort by = ‘

Tag

Device

Page Page

Gadget
Go to Events

Refrigeration
Refrigeration
Refrigeration
Refrigeration

Refrigeration

Click “Sort by"in the upper right to sort tags alphanumerically by tag name, device, page, or gadget.

In the Page column, you can click the page name to go to the page. To return, choose View > All Tags again.
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VIEWING LOG MESSAGES

groov View continually logs messages about what it's doing, including all activity that occurs while you are
using groov View, as well as events and event notifications. Seeing these messages in the Log Viewer can help
you troubleshoot issues or track groov View progress. All messages are logged, but you can choose what you
want the Log Viewer to show.

All users can view Events. For instructions, see “Viewing Events”on page 131.
Only Admin or Editor level users can see the Log Viewer.

To open the Log Viewer:

«  From Build mode, choose Help > View logs. (Note that the Log Viewer opens in View mode in a new tab;
to return to Build mode, close the tab.)

«  FromView mode, choose Menu > View logs.
The Log Viewer opens in a new browser tab, showing the most recent 500 messages. New messages are

added to the Viewer as they occur and continue to be added until you close the Viewer. If you reopen it later, it
will again show the most recent 500 messages; older messages will not appear.

To view older messages, scroll to the top of the log and click Fetch older entries. Each time you click it, the
viewer shows an additional 100 older entries.

= Pages A(:RIIE A Events n £ Menu
w Tail Log | @ Clear Viewer | Z'Reload = 4 Configuration... | & Downlead Logs
Time Logger Message
11/14/2019 4:59:37 PM Browser groov View version B4.2a (r57236), built Tuesday, November 12, 2019 12:14:58 AM UTC, is loading in
a browser.
11/14/2018 4:59:37 PM Browser Browser info - Platform = 'Win32', User Agent = 'Mozilla/5.0 (Windows NT 10.0; Win64; x64)
AppleWebKit/537.36 (KHTML, like Gecko) Chrome/78.0.3904.97 Safari/537.36".
11/14/2019 4:59:37 PM Browser GroovClientApp:onModuleLoad - Mo mobile bootstrap info available,
11/14/2019 4:59:37 PM ClientServicelmpl User 'jean’ is viewing page 'Refrigeration’.
11/14/2019 4:59:37 PM SubscriptionManager createSubscription - An existing subscription info was present, but the backing subscription was

missing. Creating a new one,

11/14/2019 4:59:37 PM SubscriptionCoordinator Tracking 3 subscriptions, scanning 15 tags on 3 devices.
11/14/2019 4:59:37 PM DeviceCantroller Connecting to device OpcUa@opc.tcp://127.0.0.1:4096/
11/14/2019 4:59:37 PM TepConnection /127.0.0.1:4096 Connecting

11/14/2019 4:59:37 PM TcpConnection /127.0.0.1:4096 Connected

11/14/2018 4:59:37 PM SecureChannelTep 23 Closed

11/14/2019 4:59:37 PM TcpConnection /127.0.0.1:4096 Closed

L

To save all messages to a text file, click Download Logs. You can open the text file in Notepad or save the
text file. Downloading the logs saves all of the messages, not just the ones currently in the Viewer. The
downloaded file may also include additional information on some errors, which is not shown in the Log
Viewer.
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?

— Y =
=rages ACME
+ TailLog | o Clear Viewer | &' Reload | 4 Configuration... | & Download Logs §
3
Time Logger Message i
{
11/14/2019 4:59:37 PM Browser groov View version B4.2a [

a brow:

TR —

"] groovLags (1).xt - Motepad

File Edit Format View Help
flov 14, 2019 1:27:@8 PM INFO com.opto22.groov.scanner.core.DeviceController - Waiting 1.8 seconds until trying to reconnect to dev,
Nov 14, 2019 1:27:10 PM WARN com.allen_sauer.gwt.log.client.log - ShapeGadget::tagUpdated - Value update for tag TagReference {Id:
GENERIC_ERROR, but I don't have any visual error reporting.
Nov 14, 2019 1:27:18 PM WARN com.allen_sauer.gwt.log.client.log - ShapeGadget::tagUpdated - Value update for tag TagReference {Id:
GENERIC_ERROR, but I don't have any visual error reporting.
Nov 14, 2819 1:27:18 PM INFO com.opto22.groov.scanner.core.DeviceController - Connecting to device System-1
Nov 14, 2019 1:27:18 PM INFO com.opto22.groov.scanner.core.DeviceController - Connected to device System-1
Nov 14, 2819 1:27:18 PM WARN com.opto22.groov.scanner.core.DeviceController - An unknown error occurred while communicating with d
java.lang.ClassCastException: com.opto22.groov.scanner.simulator.SimulatorTagDefinition cannot be cast to com.opto22.groov.server.
at com.opto22.groov.server.scanner.system.SystemScanner. readTag(Unknown Source)
at com.opto22.groov.server.scanner.system.SystemScanner. readTagBatch(Unknown Source)
at com.opto22.groov.scanner.core.DeviceController.lambda$null$4(Unknown Source)
at com.opto22.groov.scanner. core.DeviceController.wrapRequest (Unknown Source)

LA com.00t022.grooy. scanner, corg, DaviceController. 1 issyesubscriptionRe; Unkno,

Ay P
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To clear the messages currently in the Log Viewer window, click Clear Viewer. This action does not clear all
logged messages; you can see them again by clicking Reload or retrieve them by clicking Download Logs.

To filter messages in the window, for example for a key word within the message, type the word or phrase in
the Filter field. The list immediately changes to show only those messages. To see older messages, too, click
Fetch older entries.

To diagnose problems when working with Opto 22 Product Support, the support engineer may ask you
to click the Configuration button to display a file that provides special features. Follow instructions from the
engineer to modify the file.

Modifications to this file change the priority level of the data shown. When changes to the file are saved, logs

having a priority below the selected level will not be shown. For example, selecting WARN excludes all INFO,

DEBUG and TRACE level logs from the display. Here are the possible levels:

»  TRACE: Extremely fine-grained information. This level is primarily for diagnosing problems with the help
of Opto 22 Product Support.

«  DEBUG: Fairly fine-grained information. Primarily for diagnosing problems with the help of Opto 22
Product Support.

« INFO: Messages about the general progress of the app.

«  WARN: Information about unusual situations that may indicate a problem in groov View or that groov
View is improperly configured.

«  ERROR: Errors within groov View that typically don't affect how the program runs.

«  FATAL: Problems that cause groov View to crash.

CHANGING THE GENERAL PROJECT SETTINGS

This section describes the General Settings for your project. To set up a groov View email account, see “Setting
Up Notifications”on page 133.
1. InBuild mode, choose Configure > Project.
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CHANGING THE GENERAL PROJECT SETTINGS

Project Settings

€ Close Save Settings
General Settings Email Settings
Default video gadget refresh 0.5 seconds SMTP server hostname: server.hostname.com
period:
The minimum video refresh rate is 0.5
seconds. SMTP server port: 25
The SMTP port is a number between 1
Do not expire Kiosk user login o and 65535. Common ports are 25 and 587
sessions: for mail servers using STARTTLS or no
Takes effect the next time the user logs connection security, and 465 for those
et using SSL.
Allowed Cross-Origin Request Connection security: None -

Domains: ex. hitps://my.app.cor | ==
Most larger services nowadays will use
STARTTLS.

Set of external domains that may access
the REST interface for this groov. See also Allow untrusted certificates:

HTTP Access Control (CORS) on the web. . )
Use this if your internal mail server uses a

self-signed certificate.

Sender address: groov@localhost

Groov View Styling

The email address you want groov to
send as. Some services might ignore this.

P Bt e SV VU P S e NP PP B R

2. Inthe General Settings box, configure the following options:

—  Default video gadget refresh period—Sets how often in seconds groov refreshes the image from
an IP camera. Use this option to set the default refresh period for video gadgets. The minimum
video refresh rate is 0.5 seconds. Every instance of the video gadget will use this refresh period
unless a different refresh period is set for an individual instance. To set an individual instance, see
“Video Gadget”on page 104. For more information on how to use this setting, see “Changing the
Video Gadget Refresh Period” on page 165.

— Do not expire Kiosk user login sessions—Use this setting if you want kiosk users never to be
logged out. This is helpful for TVs or other displays not associated with a particular user that need to
remain on for long periods of time. Normally, a login lasts two weeks. If you have kiosk users, also see
“Automatic Refresh” on page 143.

- Allowed Cross Origin Request Domains—If you have developed a JavaScript application that
uses the REST API for groov and runs on a different domain, you may need to enter that domain here
in order to allow it to access groov data. For more information, see the groov REST API/cors section
on the Opto 22 Developer website.

3. To change the look of your groov project (colors, logo, and so on), scroll down to the Groov View Styling
box.
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Groov View Styling

show in groov View: |# Page List
¥ greovlogo
Freeze caption bar:

Select to prevent the caption bar from
scrolling off the page.

Logo: ® Default

Custom

Menu color:

Caption bar color: .

Configure the following options:

Show in groov View
Page List—If you uncheck this option, any user using View can see only the first viewable page. All
other pages will not be available to view.

groov Logo—Uncheck this option to hide the groov logo. You can replace it with your own or have
no logo.

Freeze caption bar

Check this box if you want the top bar (with or without a logo) to remain fixed at the top of the
page, even when your user scrolls down.

Logo

Default—tEither the groov logo or no logo will appear, based on your choice above.

Custom—To show a logo other than grooy, click Custom and then click Choose Image. In the Image
Library, locate or upload the image you want to use. A logo larger than 135 x 35 pixels will be resized
smaller.

Menu color and Caption bar color

Click the box to change the default colors to match your brand or taste. Choose colors from the
samples shown.

Scroll to the top and click Save Settings, and then click Close.

groov View User's Guide 91
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SAVING YOUR PROJECT AND OPENING groov VIEW

Click the File menu and select one of the following.

I Edit View  Configure  Security Help

Save All Changes
Save All Changes and Switch to groov View L\}

Switch to groov View
Open groovView in New Tab

Save All Changes—Saves your latest changes, but it does not update any open iterations of View.

Save All Changes and Switch to groov View—Saves your latest changes and opens an updated groov
View. All new and updated pages for groov View are automatically updated and refreshed for all users.

Switch to groov View—Opens groov View without incorporating any changes you have made since your
last save.

Open groov View in New Tab—Use this option if you want to have both Build and View modes open at the
same time in separate tabs.

To back up your groov View project, see the next section.

BACKING UP AND RESTORING YOUR PROJECT

You should back up groov View frequently, because there is no automatic backup. During backup, your project
is saved to a file on your computer. groov View project backups are interchangeable among groov EPIC, groov
Server, and the groov Box. So you can restore to groov EPIC a project you backed up from a groov Box, for
example, or vice versa.

If you have two groov View installations at different versions of groov View and you want to move a project to
the older version, it will usually work only between lettered versions. For example, moving a project from a
groov Box at R3.4b to a groov Server at R3.4a should be OK, but moving from R3.4 to R3.3 is not likely to work.
It's safest to keep your groov View software at the same release if you can.

If you are using a groov Box, you can also back up using groov Admin. For more information, see form 2104, the
groov Box User’s Guide for GROOV-AR].

IMPORTANT: Your groov View project files are not encrypted or masked in any way. This means that most of the
project information in them (except for the groov View user passwords) can be read, including the following:

SMTP account info (including password)

User email accounts (does not include the groov View user passwords, which are securely encrypted before
being stored)

Device addresses
Tag address information (PAC tag names, Modbus addresses, OPC node-id, etc.)

Opto 22 recommends that you secure your backup files using file- or disk-based encryption provided either by the
operating system or other software/hardware.

Also, be aware that if you send project files to Opto 22, our personnel will have access to the information listed above.

To back up your project:
1. Choose File > Backup Project to Computer.
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S Edit View Configure Security Heg

Save All Changes
Save All Changes and Switch to groov View

Switch to groov View
Open groov View in New Tab

Backup Project to Computer
Restore Project from Computer %
Backup Project to Computer

Save a copy of your project that can be restored onto this or another groowv View instance.

#| Include trend data
#| Include event nofifications

Exclude users

Download Project Close

2. Checkthe boxes to include trend data and event notifications in the backup or to exclude user data.

You might want to exclude user data, for example, if you are sending the backup to Opto 22 Product
Support for help with an issue.

3. Click Download Project.

A backup file is downloaded to your computer.

To restore your project from a backup file:

CAUTION: Restore your project only if you have to. You will lose all work done since the last backup, and all users
will be logged out.

4. Select File > Restore Project from Computer.

FW Edit View Configure Security Hd

Save All Changes
Save All Changes and Switch to groov View

Switch to groov View
Open groov View in New Tab

Backup Project to Computer
Restore Project from Computer%

5. Inthe Restore Project dialog box, browse to the location of your tar.gz backup file.
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Restore Project

Project Backup
(*.tar.gz):

Browse...

Please provide the username and password of the admin account
associated with this project.

Username

Password

Restore Cancel

6. Enter the username and password for the Admin account.
7. Click Restore.
The following warning appears.

Restore project?

Your current project will be lost and all users will be logged out. Any accounts not present in the backup will be deleted. Are you sure you want to proceed?

0K Cancel

8. Ifyou're ready to proceed, click OK.
When the restoration process is complete, the restored project opens in groov View.

RESETTING YOUR groov PROJECT

If you need to start a new project, you can reset your project. Resetting deletes all your devices, pages, and
trend data, so you can start over fresh. This feature is useful for system integrators or others who work on
multiple projects for different customers or locations.

To reset your project:

1. Back up your existing groov View project (see page 92).

2. Choose File > Reset Project.
You return to a blank project. You can start a new project or choose File > Restore Project from Computer
to restore one you backed up earlier.

UPDATING groov

94

You are eligible to receive groov View updates as long as your license is active. Updates add new capabilities
and fix issues that may arise.

Each groov View installation (each EPIC or Box or Server) is treated independently; updates are valid for a
specific groov View installation only.

To see your version of groov View:
«  InBuild mode, choose Help > About.
«  InView, click the gearicon E and choose About.

Checking for Updates

To check for updates, go to manage.groov.com.
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1. Loginand click Manage.
2. Find your groov product in the list and click the Manage button next to its name.
3. Ifyou have not installed one of the latest updates, click the filename to download the file.

In a groov Box or groov Server, if updates are available, an icon appears next to the groov logo in the
upper-right corner of Build mode. (This icon does not appear in a groov EPIC. )

mwyr=a
(\ , Mew updates are
<y available.

Click the updates icon (or select Help > Check for Updates). The Check for Updates dialog box opens, telling
you what kinds of updates are available. Follow the onscreen instructions to download an update file or view a
list of changes in the latest groov View readme.

To install an update file, follow the instructions below for your groov product.

Installing Updates on groov EPIC

To install updates on a groov EPIC processor, use groov Manage on a computer. The update uses a single file to
update groov View, PAC Project, CODESYS, Node-RED, Ignition Edge, groov Manage, and firmware for the EPIC
processor. Installing the update requires careful planning. Follow instructions in form 2267, the groov EPIC
User’s Guide.

Installing Updates on groov Server for Windows

1. Back up your groov View project (page 92).
2. Double-click the downloaded update file and run the installation.

Installing Updates on a groov Box

To install updates on a groov Box, use groov Admin. For more information about groov Admin, see form 2104,
the groov Box User’s Guide for GROOV-AR]. (For the GROOV-AT1, see form 2077.)

To update groov Admin or Ignition Edge, follow steps in the groov Box User’s Guide.
To update groov View, follow these steps:

1. Back up your groov project (page 92).
2. Toopen Admin, from Build mode, select Configure > groov Admin.

3. Click Quick Start and then the Update groov View button.
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v

Update groov View \

Help... Update groov View

Currently running version.IRB.zb (r38148) | October 06, 2016 10:17 AM

Update groov View

From Downloaded File:

Choose File | Mo file chosen

Update Warning: Clicking "Update” will restart any groov View updates in progress.

. Click Choose File, navigate to the update file you downloaded, and then click Open.
5. Click Update.

Wait while the application is installed and restarted automatically, which may take several minutes. When
the operation is complete, a success message appears.

Update groov View

Updating groov View...
Restarting groov View...

Q Update from version R3.2b (r38148) | October 06, 2016 10:17 AM to version R4.0c (r48713) | June 20,
2018 4:38:45 PM PDT successful.

UPDATING YOUR LICENSE/RENEWING groov MAINTENANCE
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NOTE: This section applies to groov Server for Windows and groov Box only. It does not apply to groov EPIC.

In order to install groov View updates on groov Server for Windows or a groov Box, your license must be up to
date. You may need to download and install a new license. For more information, see the groov Maintenance
Technical Note.

IMPORTANT: You must be logged into groov Build mode as an Admin in order to update your license. (If you're
using a groov Box, make sure you use the Admin username and password for groov View, not for the Box.)

To check the enabled options and expiration date, select Configure > Licensing (this menu item appears
only if you are logged into Build mode as an Admin user). The expiration date appears under License type.
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M
Accounts... Current License Information

Devices and Tags... License type: s
» groovEnterprise, maintenance expires Nov 21 2017

# Show license expiration notice.

Image Library...
License identifiers: To purchase, upgrade or renew a license, you

Events.. can contact Opto 22 on the web at:
* MAC: BCB9A5171247 Manage.groov.com
N  Activation key: KWCIP4GYHXR6 3
PrD]e‘Ct. i ) or over the phone at.‘
Enabled options: 800-321-OPTO (6786)
qrooy Admin « Core Features (Opto 22 Controllers, Modbus Devices)

£ = = Any number of configured devices.
Licensing... I:E + OPC-UA

Close

License agreement
expiration date

When your license is about to expire, we send a reminder to the email account you used when you first
purchased this groov Server or Box. Also, a small notice appears when you first open Build mode to remind you
to renew. Once the license has expired, you'll see a similar notice:

Configure  Security  Help Click in the middle of the notice to go to the
Licensing dialog box and renew your license. Or if
you're not ready to renew, click the gray x to dismiss
the notice.

Your license has
expired.

Renewing your license

1. Loginto manage.groov.com and click Manage.
2. Locate your groov product in the list. Click its Maintenance Expiration Date (in red) to see renewal options.

o groov View Maintenance Renewal

Why renew your groov View maintenance?

Renewing maintenance for your groov Server for Windows or groov Box gives you updates
for groov View software. Updates may include new features, enhancements, and patches.

Maintenance is free. but to install updates you must "buy” maintenance and apply the
updated license file

NOTE for groov EPIC: You do not need to purchase maintenance for groov EPIC. EPIC
includes unlimited groov View maintenance.

Renewal Options

Choose the option you want and apply it to any groov Server or groov Box you own. (Since maintenance is free, choose the 10-year option!)

10 Years: GROOV-MNT-10YR
‘Your groov View maintenance agreement will be extended for 10 years from the maintenance expiration date of the product.

3 Years: GROOV-MNT-3YR
Your groov View maintenance agreement will be extended for 3 years from the maintenance expiration date of the product.

1Year: GROOV-MNT-TYR
Your groov View maintenance agreement will be extended for 1 year from the maintenance expiration date of the product.

Lrar ramaural vemarkoe

3. Under Renewal Options, click the part number for the length of time you want to renew. (Because
renewal is free, we recommend GROOV-MNT-10Y, which renews maintenance for ten years.)

International customers: Please contact your local Opto 22 Distributor to purchase renewal.
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4. Add the product to your cart or call your distributor to order.

When the order is complete, you receive an email or printed certificate with the Activation Key for the
renewal. The Activation Key in your email or printed certificate is not specific to an individual groov
product; you can apply it to any groov Server or groov Box you own.

5. When you have your Activation Key from the email or printed certificate, go to manage.groov.com.
6. Log in using the email address and password you used when you first activated your groov product.

Manage groov

What would you like to do?

Activate a new groov product, license, or training Manage existing groov products

> groov EFIC » Complete your activation by adding a MAC address or serial

» License for groov EPIC or groov RIO numper

> groov EPIC Premiurn Factory Training Get groov updates and see the latest README files

» groov Box Edge Appliance Download your license file

> groov Server for Windows Change or cancel your groov EPIC Premium Factary Training class

Manage your groov maintenance
Required to activate: Your Activation Key from the certificate See all your groov preducts in one place
packed in the box with your groov, or sent to you by mail or email

when you bought your groov product.

WO W W e w

Transfer a groov product to someone else

7. Click the blue Activate button. Follow instructions on the screen to enter your Activation Key and apply
the maintenance renewal to your groov Server or Box. Choose carefully to make sure it's the right one.

8. Inyour groov product’s Profile page, click Download License File and save the file to your computer.

9. IngroovBuild mode, come back to the License Management dialog box (Configure > Licensing) and click
the Select License File button.

10. Browse to the new license file, highlight it, and then click Open.
11. An Upload Successful message appears in the License Management dialog box.
12. Click Close.

Your renewal is complete.
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4: Gadget Reference

Build mode provides a collection of gadgets that allow you to create a graphical, on-screen operator interface.

This chapter provides details on how to configure gadget properties.

Gadget Go to

D Group Header

AbC_ [ine Header

Divider

l: |
=1
o

Page Navigator

b
=1

Auto Navigator
Video

Image

Rectangle

Oval

LED

Checkbox

Button

Command Button
Momentary Button

Slider

(6EBExcO0DEE |

Level Indicator

Text Text Area

Text Box

L:12 value

Image Indicator
Round Gauge
=== Range Indicator

Trend

page 100

page 101

page 101

page 102

page 103

page 104

page 105

page 106

page 106

page 107

page 108

page 109

page 110

page 111

page 112

page 113

page 114

page 115

page 116

page 117

page 118

page 119

page 120
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GROUP HEADER GADGET

GROUP HEADER GADGET

Use the Group Header gadget to visually define a group of objects. Group related gadgets in the same area

and place a Group Header as a box behind them. The box ties them together visually so operators know at a
glance that they are related.

TIP: Ifyou need to move a Group Header (or any other gadget) behind another gadget, right click it and choose Send
to Back.

Silo 1

Group Header Gadget Properties
Group Header

gadget Label

| . Header %

réssure Control |250.00

Other qadaets placed on to (Optional) For an explanation of this .
gadgetp P property, see “Making a Gadget Visible isniatrls
Based on aTag”on page 71.

Enter a title for —
the group. Visibility

% | Mo tag selected %

=E = = %
Text size
12 r %
Align title at the left, center, or right. Default is left. EnnE
Choose title text size. Default is 12.
Choose title font. Default is Arial. ————————————" Ara ®
Make titlg bold, italics, orpoth. Default is bold. \ et v
Change title text color (click the rectangle and choose). L
B I
Text color
NOTE: For any property with a link button, you can click to break the . %

link and choose the property value independently for Desktop &
Tablet versus Handheld layouts. See “Properties and Layouts” on
page /0.
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LINE HEADER GADGET

Use the Line Header gadget to provide a label or title for organizing gadgets on a page.

Com pFESSOFS Line Header Gadget Properties
Label
Enter title text. ———— Lzhel %
Visibili
(Optional) For an explanation of this Iy
property, see “Making a Gadget Visible I % | Mo tag selecied %
Based on aTag”on page 71.
Alignment
Align title at the left, center, or right. Default is left. L E | = = %
Leave title text size at Auto or choose size in pixels. e
Choose title font. Default is Arial. —————————
Auto v %
Make title bold, italics, or underlined. Default is S
underlined, and the underline extends past the title .
to the full width of the gadget. Ariz v
Change title text color and background color (click Text Styling
the rectangle and choose). B I|luU
Colors
NOTE: For any property with a link button, you can click to break the o . %
link and choose the property value independently for Desktop & ey =
Tablet versus Handheld layouts. See “Properties and Layouts” on 4 '
page 70.
DIVIDER GADGET

The Divider gadget provides a simple gray horizontal or vertical line to separate groups of objects. You can
make the divider longer or shorter by selecting the object and dragging its handles.

Divider Gadget Properties
Display
# Horizontal
Horizontal or vertical Vertical

Visibility

(Optional) For an explanation of this | | % | Notag selected G,

property, see “Making a Gadget Visible

Based on aTag”on page 71.
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PAGE NAVIGATOR GADGET

Use the Page Navigator gadget to link to another page in the project, to groov View Event Status or Event Logs,
or to a web page. The gadget can be displayed as a text link, a button, or an image.

« Tolinkto a page in your groov View project, select the page from the list or search on the page name (or
partial name).

«  Tolinkto Event Status or Event Logs, just choose it in the Link To drop-down list.
« Tolinkto a web page, choose Web Page in the Link To drop-down list, and enter a full URL (for example,

http://opto22.com).
Page navigator gadget Display Modes
Link To
Choose where the link goes. —— groov Page v

Refrigeration — Link

Selected Page: New

earch Dy page name

wn

‘ Refrigeration — Button

Headquarters: Refrigeration
Headquarters: Pump room
Headquarters: Main

Image Headquarters: Tanks - Field

Factory: Line 1 Operation

Factory: Line 2 Operation

Factory: Line 1 KPIs

(Optional) For an explanation of this property, see | Visibility

“Making a Gadget Visible Based onaTag’on ™™~ & | 1o tag selected %
page 71.
Choose whether to show the link as text, Display Mode
a Button, or an Image. Link v
Label
Default %
Text Size
Foralink or a button: Auto v [%
Enter the text for the link. ————— Font

Leave link text at Auto or enter size in pixels.

| | Anal v
Choose title font. Default is Arial. e
Make title bold, italics, or both. Default is neither. —_| SRy
i I B | !
Change title text or background color
(click the rectangle and choose). \ Colors
P  Text: . o
Background: Y
For an image: it b
Click the broken image button and choose an image from Image ¥

the Image Library (see page 82). \ Image

To change how transparentanimage s, enter a value between 0 and 100.
Zero is completely transparent (invisible); 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the link and Opacity: | 100
choose the property value independently for Desktop & Tablet versus SRR
Handheld layouts. See “Properties and Layouts” on page 70.
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AUTO NAVIGATOR GADGET

CHAPTER 4: GADGET REFERENCE

Use the Auto Navigator gadget to automatically move ALL viewers of the page this gadget is on to another
page in the project. Note that this gadget is invisible in groov View. When the Bboolean tag it is connected to

becomes true, the page automatically changes.

Remember that if you need a more complex condition, you can create an Event for the condition and use the
Event tag as the trigger. For more on creating and using Events, see Chapter 5: Using Events and Notifications.

From the list, select the page that should appear
when the tag becomes true. You can search on the
page name (or partial name) if you have a long list.

Remember: this gadget will be invisible
to your groov View users.

NI Search by page name

Auto Navigator Properties

Tag
L 3 No tag selected

Selected Page:

Headquarters: Refrigeration
Headquarters: Pump room
Headquarters: Main
Headquarters: Tanks - Figld
Factory: Line 1 Operation
Factory: Line 2 Operation

Factory: Line 1 KPIs

-

Mote: This gadget will not be visible in
View mode..
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VIDEO GADGET

The Video gadget displays iFrame type video images from an IP camera; it does not interact with controller

points/variables.

For information on entering a URL and setting up IP cameras, see the appendix on page 163 and your IP
camera or server documentation.

Video gadget

(Optional) For an
explanation of this
property, see “Making a
Gadget Visible Based on
aTag”on page 71.

Video Gadget Properties

Camera URL
http:/{video.camera.com/example.j
Update period
0.5 (project default) sec
Use groovas a proxy
«| Maintain aspect ratio
Visibility

— % | Notag selected %

Test feed

Camera URL—Enter the URL of an IP camera or video server that provides access to your IP camera’s static

image feed. If you are using a video server, use the server's URL. For more information on entering a URL, see
the appendix on page 163.

Update Period—Set how often in seconds groov View updates the image from an IP camera for this
individual video gadget. To set the default update period for all video gadgets, see “Changing the General
Project Settings”on page 89. For more information about this setting, see “Changing the Video Gadget

Refresh Period”on page 165.

Use groov View as a proxy—This feature provides a secure reverse proxy service for the video gadget. This

service is useful when viewing from outside a firewall.

When the box is checked, the video
gadget requests video from groov
View, which authenticates and
forwards the request to the IP camera,
eliminating the need to configure the
firewall for each IP camera.

In this case, groov View will poll the IP
camera over the local network at the
set update period (in seconds) and
buffer the images. When you look at
your groov View project, you will see

=

the images over the same secure connection as the rest of your groov View project.

When the box is not checked, the
video gadget requests video directly
from the IP camera. You must
configure the firewall to allow the
video feed for each IP camera.
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Maintain aspect ratio—Check the box to keep the video at the same height-to-width ratio when the video
gadget is resized.

Test Feed—~Click the button to test the live IP camera feed in Build.

IMAGE GADGET

Use the Image gadget to place an image in your project. See more about using images in “Managing Images
in the Image Library” on page 82.

| aoe gadgets
/ Image
ey Click here to open the
Image Library.
geHbrery (s °

To change how transparent an image is,

enter a value between 0 and 100. —————————opacity: 100

Zero is completely transparent (invisible); Limits: 0 to 100

100 is completely opaque.

Visibility
(Optional) For an explanation of this property, see —— @ = 1o tag selected %

“Making a Gadget Visible Based on a Tag”on page 71.
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RECTANGLE AND OVAL GADGETS (SHAPE GADGET)

RECTANGLE AND OVAL GADGETS (SHAPE GADGET)

106

Use the Rectangle gadget to place a square or rectangle shape in your project, and use the Oval gadget to
place a circle or oval. Both are essentially the same Shape gadget with most of the same properties.

You can choose any color for the shape’s edge (stroke) and body (fill), and choose how transparent they are.
You can also round a rectangle’s corners.

You can use this shape for any purpose, alone or in combination with other shapes or other gadgets. In
addition, you can set the width and/or height of the shape to change dynamically, based on a tag. For
example, you could use a shape to indicate the level in a tank.

Choose the color for the edge of the shape.
To change its transparency, move the slider.
Far left is completely transparent (invisible);
far right is completely opaque.

Shape Gadget Properties

Stroke

Enter the width of the stroke (edge). ————— Width: 1 LS
To round a rectangle’s corners, increase the
corner radius value. Zero = square corners. — Corner | 0 %
radius:
Choose the color for the inside of the shape. )
To change its transparency, move the slider. —— |l EI G
Choose where the shape is drawn from. If Origin
you enter dynamic width or height, thisis the
starting point of the shape’s expansion. — Upper Left v %
Visibility
(Optional) For an explanation of this property, ——— % = [ tag salected G
see “Making a Gadget Visible Based on a Tag”
on page /1. Dynamic Width
To make the shape change in width, height, or both based —— @ | 1o tag selected
on a tag's value, choose the tag. Then enter the minimum
and maximum width or height for the shape (typically the
min and max values of the tag). o i
Min Max

A rectangle or square expands from the Origin point.

A circle or oval expands from its center, but the center is
placed at the Origin point and the rest of the circle is cut off.
For example, a circle with an Origin of Upper Left creates a
quarter circle. A circle with an Origin of Center creates a
complete circle.

You can use these shapes next to each other or on top of
each other to create more complex shapes and indicators.
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LED GADGET
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An LED is a read-only gadget that typically indicates the state of a numeric value. It can be used with Boolean
tags (on/off, true/false), with numeric values with multiple colors to indicate an exact value or a range, or with
string values with multiple colors to indicate an exact match. For boolean tags, the LED is off when the value is
0and on when the value is non-zero.

On and Off states for a blue LED
T
Vat #2 O LED on Y
No ta
LED Oﬂr Visibility
Vat #2 . (Optional) For an explanation of this __ | o 1 %
property, see "Making a Gadget Visible e
Based on aTag”on page 71. Label
LEDs with multiple colors Enter a label for the LED. __ v o
Pumps Align label on the left or right T
. 1 side of the LED. Default is left, —— |- %
Text Size
O 2 Auto v %

. 3 Font
. 4 Leave label text at Auto or enter SEW |
. 5 Choose label font. Default is Arial. Text Styling

. 6 Make label text bold, italics, or both. Default is neither. = B | I
Change label text or background color (click th e | O
ange label text or background color (click the rectangle
Text:
and choose). . a
Background: %
Leave graphic size at Auto or choose size in P ——
page grid units. -_— "
- [« Auto %
4 units %
For a boolean tag:
Click the colored circle and choose 0On/Off Colors
colors to indicate LED is on (True) or
off(FaIse . Tag == True
Color Ranges ) .
| g Range---\l\ For a non-boolean tag: Tag == False .
Click the Add Range button to set
Color: . ——— Choose the range color.
Match Type: Exact — Choose when the color should appear:
® Range Exact: Color appears for the specified value.
| MNegate

Range: Color appears for any value within a range.

Min Value: Negate: If checked, color appears if value is outside the specified
value or range.
Max Value:

Enter a specific value for Exact, or the start and end values for Range.
Close Editor Delete

| Click to close editor for this range.

To add another, click Add Range.

NOTE: For any property with a link button, you can click to break the link and choose the property value
independently for Desktop & Tablet versus Handheld layouts. See “Properties and Layouts” on page 70.
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CHECKBOX GADGET

The Checkbox gadget is a read/write binary input which your user can toggle on or off by selecting the box.
Off = zero, On = non-zero.

Outside Light | |— Checkbox gadgets
7 Tag
. . Click to require confirmation v I
Inside Light before a write, ——————————1 " Confirm writes
it
(Optional) For an explanation of this property, e ”t_v
see “Making a Gadget Visible Based on aTag” — | | ¥ | o &g selecied =
on page /1. et
Enter a label for the Checkbox. ——— Default %
Alignment
Align label on the left or right side of the LED. Default is left. —— |- - %
Text Size
Leave label text at Auto or enter size in pixels, ————— | Auto v %
Choose label font. Default is Arial. Font
Make label text bold, italics, or both. Default is neither. ~ i .
Change label text or background color (click the
rectangle and choose). it sl
Leave gadget size at Auto or choose size in B I
page grid units. Gl
Text: . %
Background: N
Graphic Size
NOTE: For any property with a link button, you can click to break the link 4 Auto %
and choose the property value independently for Desktop & Tablet versus ;
Handheld layouts. See “Properties and Layouts” on page 70. ¢ units | %
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INDICATOR BUTTON GADGET

The Indicator Button gadget is a read/write binary button which your user can toggle on or off by clicking it.
Off = zero, On = non-zero. This gadget can be displayed as a button (with an integral color to show status) or
as two images (one for On and one for Off). See more about using images in “Managing Images in the Image
Library”on page 82.

Button display—configurable color
[om i = | Tag
| Inside Light ———
| J - Mo tag selected
Button on . ' .
(Optional) For an explanation of this Visibility
_ Eropgrty, see “Making a G7a1dget Visible ™. q | o tag selected %
. . ased on aTag”on page 71.
Inside Light
‘l g J Click to require confirmation before a write. —— | Confirm writes
Button off
Display Mode
Choose whether to display a button L Button v
or images. T
For a button, enter a label for the Checkbox. —— pefault %
Text Size
For a button: | | Auto M
Leave label text at Auto or enter size in pixels. Font
Choose label font. Default is Arial. Arial v

Make label text bold, italics, or both. Default is neither.

Text Styling
Change colors for On/Off indicator, button text, and button\\ AE

background (click the rectangle and choose).
\ Colors

. [~ =
Image dlsplay On Indicator:
Off Indicator:

Text:

Button: Gy
Button off

Ay

For an image:
| Clickhere tp open the Image Library and
choose an image to show when the
button is On.
Choose a second image for when the
opacity: | 100 button is Off.

Limits: 0 to 100

Off Image Opacity: To change how transparent an image is, enter a value
between 0and 100. Zero is completely transparent (invisible);
100 is completely opaque.

Opacity: 100

e NOTE: For any property with a link button, you can click to break the link and
choose the property value independently for Desktop & Tablet versus
Handheld layouts. See “Properties and Layouts” on page /0.
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COMMAND BUTTON GADGET

COMMAND BUTTON GADGET

The Command Button gadget sends a value to a numeric or string variable. The value is sent once when the
button is pressed.

Optionally, in addition to writing a value, the button can also immediately navigate to a groov View page (a
page you've created, the Event Status page, or the Event Logs page) after successfully writing the value. The
target page opens in the same window.

This gadget can be displayed as a button or as an image. See more about using images in “Managing Images
in the Image Library” on page 82.

Command button gadgets—Display Modes
Buttons 0
Alarm Off X

(Optional) For an explanation of this
property, see “Making a Gadget Visible | Visibility
Based on aTag”on page 71. — % | No tag selected %

Enter the value to write. —___| Value

Image ) ) . ) ~ o
Click to require confirmation
before a write. ——————| confirm writes
(Optional) To also open a Link To
page, choose the type —————— no Link M
(and name) to open. iy M
Choose whether to display a —— gutton M
button or an image. e
Forabutton, enter a label | Default N
for the button. e
For a button: // Auto M| s
Leave label text at Auto or enter size in pixels. Font
Choose label font. Default is Arial. Aria M
Make label text bold, italics, or both. Default is neither. Text Styling
Change colors for On/Off indicator, button text, and button \B I

background (click the rectangle and choose). \ o
i Text: . S

Button:

PRV SR P PN

Ty W
Display Mode

Image v

Image
For an image:
| Click here to open the Image Library.

| To change how transparent an image is, enter a value
Opacity: 100 between 0and 100. Zerois completely transparent (invisible);
Limits: 0 to 100 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the link and
choose the property value independently for Desktop & Tablet versus
Handheld layouts. See “Properties and Layouts” on page 70.
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MOMENTARY BUTTON GADGET

The Momentary Button gadget simulates a normally open button. It writes a value once when it is pressed,
and another value once when released. This gadget might be used to drive a motor to raise and lower a crane,
or to start and stop a drill. You can choose to display the button as a button or as an image. See more about

using images in “Managing Images in the Image Library”on page 82.

For a boolean tag, select either True or False for the Press Value.

CHAPTER 4: GADGET REFERENCE

For integers and floats, enter both a Press Value and a Release Value. Optionally, you can also enter a Toggle
Value. When a Toggle Value is entered, while the button is pressed it will alternately write the Press value and
the Toggle Value once per second. The Press value is always written first. When the button is released, the
Release Value is written.

Momentary button gadget—Display Modes

Tag
Run ol — Buttons o | bool Varbie B
00l Variabie
(Optional) For an explanation of this -
property, see “Making a Gadget Visible | Visiility
P | Based on aTag”on page 71. — % | No tag selected %G
— Image
- For a boolean tag, select either e oks
True or False. True False
Choose whether to display a Display Mode
button or an image. —— Button v
For a button: L]
Enter a label for the button. Default %

Momentary Button Properties

Leave label text at Auto or enter size in pixels. ~| Textsiee

Choose label font. Default is Arial.

Momentary Button Properties

Tag

float32 Variable

Press Value

Toggle Value

Release Value

Display Mode

Image

Image

Opacity:

B

100

Limits: 0 to 100

Auto v %
Make label text bold, italics, or both. Default is
neither. hont
Change colors for button text and background Aria M
(click the rectangle and choose). Text Styling
B I
Colors
Text: . %
Button: Gy

aToggle Value.

failsafe if needed.

Foran integer or float, select a Press Value and a Release Value, and optionally

AToggle Value can help you detect a communication failure. Use controller
logic to detect the failure while the button is pressed, and to implement a

— Choose whether to display a button or an image.

Foranimage, click here to open the Image Library.

To change how transparent an image is, enter a value between 0 and 100. Zero is
completely transparent (invisible); 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the link and
choose the property value independently for Desktop & Tablet versus
Handheld layouts. See “Properties and Layouts”on page 70.
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SLIDER GADGET

SLIDER GADGET

The Slider gadget is a read/write gauge that displays an analog or float-type value using a horizontal or
vertical bar that fills to indicate the present position or value. This gadget is the same as the level indicator
gadget except that a user can grab and move the slider button to change the value and write it to the
controller. You might use this gadget for room temperature setpoints, alarm values, PID settings, and so on.

Label Value Precision
Process Level:\324 Tag
o % | No tag selected
Color — ! e Visibility
Button || % | Notag selected %

(Optional) For an explanation of this property, see / Write continuously

“Making a Gadget Visible Based on a Tag”on page 71.

Confirm writes

Check the box to continually write values as the slider is dragged. Ranae
If unchecked, value is written once you let go. .
Min value: 0
Check to require confirmation before a new value is written.
Max value: 10
Orientation
Enter the slider's minimum and maximum values. || Horizontal v| [fa
Choose a horizontal or vertical slider. Show ValuEAs
Choose to show the value as a value or a percent, or choose — Value b
not to show the value. Units
Enter Engineering units for the value (gallons, amps, etc). ———
Enter the number of places to the right of the decimal LAESR
point to be displayed. 2 %
Enter a title (label) for the slider. =L DG
A Label
Leave text at Auto or enter size in pixels (controls both label =
and value text, if shown). Default %
Text Size
For the label: Auto | [
Choose font. Defau!t is Arial. — P
Make text bold, italics, or both. Default is neither, —8 —— h —
nc Alla v

Change color (click the rectangle and choose). ——— |
Styling: B I

For the value (if shown): L Gl . o
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither. L Drimue i
Change color (click the rectangle and choose). ———u | Pt Al Y
Styling: B I
Change the slider’s indicator color or background. ————  @lor: . E
Colors
Leave gadget size at Auto or choose size in page grid units. Track Fill: . o
Background: G
Graphic Size
%

NOTE: For any property with a link button, you can click to break the link and i
choose the property value independently for Desktop & Tablet versus c diits: [\l
Handheld layouts. See “Properties and Layouts” on page /0.
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LEVEL INDICATOR GADGET

The Level Indicator gadget is a read-only gauge that displays an analog or float-type value using a horizontal
or vertical bar that fills to indicate the present position or value. You might use this gadget for a fuel gauge or
a noise-level indicator, for example.

Label \ Value \ /Precision Level Indicator Gadget Properties

Steps Completed:19 Tag
/ ’ Y
Color ' : . AL Visibility
(Optional) For an explanation of this property, see “Making
a Gadget Visible Based onaTag”on page 71, —  — % %
Range
Min value: 0
|-
/ Max value: 10
Enter the slider's minimum and maximum values. Orientation
Choose a horizontal or vertical slider. Horizontal v %
Choose to show the value as a value or a percent, or choose not Show Value As
to show the value. value v
Units
Enter Engineering units for the value (gallons, amps, etc.). ———
Enter the number of places to the right of the decimal LEFE
point to be displayed. 2 %
Limits: 0 to 6
Label
Enter a title (label) for the slider. Default %
Leave text at Auto or enter size in pixels (controls both label UEEEEE
and value text, if shown). Auto Y
Label Style
For the label: o B —- [ .
Choose font. Default is Arial. ———————— |
Make text bold, italics, or both. Default is neither, ————————~—  styling: B I
Change color (click the rectangle and choose). ——— |
9 g T Color: . Y
Value Style
For the value (if shown): | Font: | Avial v
Choose font. Default is Arial, ————————————— |
Make text bold, italics, or both. Default is neither, ————  Stylina: | B I
Change color (click the rectangle and choose).
g ( 9 ) [ Color: . %
Colors
Change the slider’s indicator color or background, ——————  TrackFil: . %
. o . . Background: Y
Leave gadget size at Auto or choose size in page grid units.
Graphic Size
) . . . v Auto %
NOTE: For any property with a link button, you can click to break the link and
choose the property value independently for Desktop & Tablet versus 6 units | %
Handheld layouts. See “Properties and Layouts” on page 70.
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TEXT AREA GADGET

TEXT AREA GADGET

The Text Area gadget is a read-only gadget for displaying numerical or string data. Enter text just as you want
it to appear, and use enough pound signs (#) to accommodate numeric data to be displayed. For example,
##.4# could display 35.0, and ###.## could display 350.86. For string data, just use one #.

Tex Valve ()

‘ Data Source

Time to Start: 2198 ¥ | Notap seleced
/ (Optional) Foran explanation of | Visibility
Background this property, see ‘Makinga —— & | 1o tag selected a
Gadget Visible Based on a Tag”
- on page /1. i |
Greeting: ped Ente ot he
Hello World Enter text and enough pound signs —1
(#) to display the tag’s value.
Use one # for a string.
o
Formatting help 9,
Text Style
Choose text font and size. Defaults are Arial, 12. ———— Arial x 12 v %
Make text bold, italics, or both, and choose font color —1— B 1 A
("A"button). Value Style
Choose font for the value. Default is Arial. —————————— Aral v e
Choose bold, italics, and color for value. — L B|I|U|A

(Optional) To change the value style when the tag’s —  Add Conditional Format Rule

value reaches a specific level, click the button to add a
format rule. You can add multiple rules. Nuinilesicontiowed,

Horizontal Alignment

e
1]}
lih
&

Align text at the left, center, or right within the gadget. —
Default is left. Vertical Alignment

Aligntext attop, middle, or bottom withinthegadget. — L 7 & + L %
Default is middle.

Change text or gadget background color (click the
rectangle and choose). Color %

Background

v

Add Conditional Fermat Rule

equal to YL (Choose the condition from the dropdown list.
Boolean tags show only True/False.
———— Entervalues for the condition.
A ———— Choose the style and color to indicate this condition.

i)

B | I

=

NOTE: For any property with a link button, you can click to break the
link and choose the property value independently for Desktop & Tablet
versus Handheld layouts. See “Properties and Layouts” on page 70.
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TEXT BOX GADGET

The Text Box gadget is a write-only field that your user can change to send numerical or string data. When the
user clicks in the Text Box, a dialog box pops up for entering data. Data is sent when the OK button is clicked or

tapped.
o
Tag
Value : :
| % | int32 Variable B
. X Visibility
Greeting: [Hello World l
L %
(Optional) For an explanation of this property, see R
Making a Gadget Visible Based on a Tag”on page 71. | ok [ o
For numerical data, enter the minimum and
maximum values your user can enter. Max value: 100
Pre-prompt Pre-prompt
Enter pre- and post-prompts for the Edit Value <——
dialog box. The pre-prompt appears above the e —
Stz 1 e \t/)allue the%/ enter. Thle pos‘t—grompt appears
elow it, for example to indicate units.
[Heio worid Format
Enter the format of the text your user ———  z.22
i ' Cancel should enter. For a string, use one #. ——
Select a text box size for user input. If you  ——— medium T %
choose Unlimited, you cannot enter a label.
Label
Enter a label (title) for the Text Box. ———— Default %
Alignment
Align the label at left or right side of value. Default is left. Lo o
Leave text at Auto or enter size in pixels (controls both label EIEE
and value text). Auto v %
Label Style
For the label: L Font: | Aria v
Choose font. Defaultis Arial, ————————— |
Make text bold, italics, or both. Default is neither, ———————  Sting: B [
Change color (click the rectangle and choose). ———— | el . =
Value Style
For the value (if shown):
. i T Font: Arial v
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither, ——— stling: B I
Change color (click the rectangle and choose). ———— |
T Color: . o,
Change gadget background color. — | BT el
i %

NOTE: For any property with a link button, you can click to break the link and
choose the property value independently for Desktop & Tablet versus
Handheld layouts. See “Properties and Layouts” on page 70.
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VALUE GADGET

VALUE GADGET

116

The Value gadget is a read-only gadget for displaying numerical or string data. It has a uniform width to make
it easy to line up multiple gadgets. The text format changes depending on the tag type, so you don't have to
configure it manually. For example, a float-type tag will have #.##, while an integer tag will have just #.

If you use a boolean tag, you can use the default ON and OFF text for true and false values, or enter your own
labels, such as Running and Stopped. In the Label text box, enter text just as you want it to appear.

.
Level: 5.12 e

Label

Fan status:

Value

On text

Off text

Data Source

% | bool Varizble D

For boolean tags, these are the strings
shown when the tag's value is true or

Data Source
Value % | Ramp B (0 to 10, 60 sec)
Visibility
OFF (Optional) For an explanation of this L o 1, ;o0 %
property, see “Making a Gadget Visible 2
Based on aTag"on page 71. Label
Enter label name —— efaut %
Choose label font and size. Defaults: Arial, 12 +—  Aria v AT
Make label bold, italics, or underlined,and —— B 1 U A
}J&hthtvf # _#™ s a~e=| choose font color ("A”button). —
- Value formatis entered foryou basedonthe L~
tag you choose. To add precision on a float, ik
enter additional pound signs (#) after the Formatting help
deomal‘pomt. Field Width Medium ¥ %
\ For a string, use the default of #.##
Forbooleantags, you can customize the true Alignment | Valueon ¥ | %
and false text.
false,.respectively. . . Arial v %
= eeere rer=d Choose the width and alignment for the ——
value field. Change font, format, and color. B|I|U|A

- Add Conditional Format Rule

(Optional) To change the value style when the tag's
value reaches a specific level, click the button to add a

format rule. You can add multiple rules. No rules configured.
Background

Add Conditional Format Rule Change gadget baCkground color. —~

@ T Color G
equal to v ©  Choose the condition from the dropdown list.
; Boolean tags show only True/False.

T Enter values for the condition.
BlI|lU Choose the style and color to indicate this condition.
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IMAGE INDICATOR GADGET

CHAPTER 4: GADGET REFERENCE

With the read-only Image Indicator gadget, you can use multiple images to represent the changing values of
a tag. For example, you can use one image to indicate that a pump is on and one to indicate that it's off. Or
show different images of a tank depending on how full the tankis.

The Image Indicator can be used with boolean tags (on/off, true/false), with numeric values with multiple
images to indicate an exact value or a range, or with string values with multiple images to indicate an exact

match.

You choose each image you want to use from the Image Library and assign the status or value range to that
image. (See “Managing Images in the Image Library”on page 82.)

Image Indicator gadget changes the image based on the

value of the tag (only one image appears).

90 gallons

|

Level Control - Tank 1

48 gallons

H
[

Level Control - Tank 1

15 gallons &

@

Level Control - Tank 1

Image Indicator Properties

Tag

% | No tag selected

Visibility
(Optional) For an explanation of this —— % | 1o fag selected %
property, see “Making a Gadget
Visible Based on a Tag”on page 71.
Images

Click to add image.

Add Image...

Image currently added
Click to change this image. ~

To change how transparent the image is,

Select Image
enter a value between 0 and 100. Zero is
completely transparent (invisible); 100 is T opacity: | 100
completely opaque. Limits: 0 to 100
Choose when the image should appear: — 1 Match Type: @ Exact
Exact: Image appears for specific value. ) Range
Range: Image appears for any value within (] Negate
arange.
Negate: If checked, image appears if the Value: | 0
value is outside the specified value Close Editar || Dalete

orrange.

Enter exact value; or for a range, enter
Minimum and Maximum Values.

Click to close editor for this image.
Click Add image again to add the next image.
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ROUND GAUGE GADGET

ROUND GAUGE GADGET

The Round Gauge gadget is a read-only gauge that displays an analog or float-type value using a rotating
needle and decimal numerical display to indicate the present value. Possible uses include water or gas
pressure gauges, the speed of a conveyor belt, and so on.

Range End Value

Needle color
Range color

Min Value

Range Start Value

NOTE: For any property with a link button, you can
click to break the link and choose the property
value independently for Desktop & Tablet versus
Handheld layouts. See “Properties and Layouts”
on page /0.

More on Markers

For both major and minor intervals, if you use the
default (0), groov View calculates the optimum
number and spacing of tic marks to show on the
gauge. If the Custom intervals you enter create
more than 200 tic marks (major and minor
combined), groov Viewoverrides your entries and
sets the number and spacing so markers and values
are legible. (Your Custom entries still appear in the
Properties panel but are not used.)

Panel continued from right.

Color Ranges

Invalid range .

Color: .

Min Valus:
Max Value:

Close Editor Delete

L— Choose the range color.

(Optional) For an explanation of this
property, see “Making a Gadget Visible
Based on aTag”on page 71.
Max Value o
Enterthe gauge’s minimum and
CurrentValue  mayimum values.

Units

If the value is very large (for
example, 50,000 kilograms), you
can scale the value so numbers
are more readable.

Check to display the value in the gadget. —

Enter Engineering units (gallons, PSI, etc.). —

Enter the number of places to the right of
the decimal point to be displayed.

For the current value:

Round Gauge Properties

Leave at Auto or choose size.

Choose font. Default is Arial. —— |
Make text bold, italics, or both. Default is bold. —__|
Change color (click the rectangle and choose). \\

For the markers around the gauge:

Leave at Auto or choose size. ——— |

Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

| add Range. ~'—— Click here to add a color as a range
. indicator on the gauge.

Choose colors for the ——

needle and the gauge’s
background.

——1 Enter the start and end values for this
range. These must be not more or less than
the gauge’s Min and Max values.

the default tic marks. See
descriptions above left.

Choose Custom to override A

' Click to close editor for this range.
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To add another, click Add Range.
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<4— Panel continues at left.

Tag
No Tag Selected »
Visibility
— % | MNotag selected %
Range
——  Min value: 0
Max value: 10
Scale Factor
— 1
Use to scale the value. For
example, to go from g to kg,
use a scale factor of 0.001.
Make sure to adjust units as
well.
Display
— |« Show Value
Units
Precision
— 2 %
Limits: 0 to 6
Value Style
Size: Auto v %
— Font: Arial v
Styling: B I
~—_
Color: . Y
Marker Style
— Size: Auto v %
Font: Arial v
\
Styling: B I
Color: . %
Colors
Needle: . %
Background: Y
Markers
Display: Auto v
Major interval: 0
Minar interval: 0
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RANGE INDICATOR GADGET

Use the Range Indicator gadget to show on a horizontal or vertical scale where data appears in a range of
numbers. This gadget is commonly used as a thermometer, but it can indicate any kind of data within a range.
If you arrange several of these together on a page, an operator can tell at a glance if a machine is operating
correctly or see the status of several similar devices.

Range Indicator

217.00°C 76.69 °F 2,198.00 ppi 47.40 Al— Units
500~ 90~ 3000~ 80~ ™~ yalue Tag
c g 3 (Optional) Foranexplanationof| g 1, 12 selecte
ST & 2800~ ¥ this property, see “Making a
: 85- g 70 o Visibility
450- : : i Gadget Visible Based on a Tag”
o 2600-: e on page 71. — % | Mo tag selected
425-5 < 2400~ - Range Enter the gauge’s Range
& & i i minimum and maximum S e
400 <4 75 : 2200-| 4 50~ < color vallies. - in value 0
375= 70_: 2000_: 40_' Max value: | 10
350- - | Minortic If the value is very large Scale Factor
: 65- 1800': 30_'\\ (for example, 50,000 ~ 4
3257 : : : Majortic  kilograms),you canscale | |
A | KN U the value so numbers are Sl 4 5o fica b ko
200 60 1500 20 more readable. 3 doalc o ne 0 E_".E'?'l_'_
Internal Ambient Pressure X-Factor — Label ':19:7‘ e in i S o
Select a horizontal or L EUEIELT
[ Marker Styie For the markers on the gauge: vertical gauge. — Horizontal v [
1 Choose font. Default is Arial.
Font: | Arial v o Choose to show the value as a value, a Showiplcls
| Make text bold, italics, or both. ercent. or not o show it | e m
Styling: | B | I — | Defaultis neither. P ' : 2
| Change color (click the Enter Engineering units (for example, | YMits
Color: . % rectangle and choose). degrees, GPM, PSI). —
Eachunamcioloy Enter the number of places to the right | Precision
% Change background color of the decimal point to display. 11 2 %
for gauge. —
Markers Limits: 0 to 6
Display: | Auto v —t Choose Custom to override the Label
default tic marks. label for th
tenainer el o See “More on Markers”on Enter a label for the gauge. ——  Default %
. Text Si
Minor interval: | 0 page 120. For the label. 1ze
o Leave at Auto or choose size. — Auto Y|
Graphic Size Choose font. Default is Arial. Label Style
¥ Auto —— % 1 |eave gadget size at Auto or Make text bold, italics, or both. T = e =
. choose size in page grid Default is bold. :
- ungs . units. Change color (click the rectangle |7 stling: B I
and choose). —— |
Color: . G
locgangess . , For the current value: Value Style
| addrange . —— Clickheretoaddacoloras Choose font. Default is Arial, —————L _
: arange indicator on the Make text bold, italics, or both | A !
Change color (click the rectangle .
T Color: %
Color: . L Choose the range color. and choose). == Lo
Min Value: —+— Enter the start and end values for this
range. These must be not more or less than : : : .
e the gauge’s Min and Max values, NOTE: For any property with a link button, you can clickto
break thelink and choose the property value independently
Close IIEditgr Delete Click to close editor for this range. for Desk(op & Tablet versus Handheld layouts. See
To add another, click Add Range. Properties and Layouts”on page 70.
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More on Markers

For both major and minor intervals, if you use the default (0), groov View calculates the optimum number and
spacing of tic marks to show on the range indicator.

If the Custom intervals you enter create more than 200 tic marks (major and minor combined), groov View
overrides your entries and sets the number and spacing so markers and values are legible. (Your Custom
entries still appear in the Properties panel but are not used.)

TREND GADGET

120

Use the Trend gadget to create a trend that shows how a variable changes over time. You can configure up to
4 pens (variables) per trend, each with a different tag.

Trending starts in groov View when you save your changes. If a page contains a Trend gadget that has
accumulated data, when the page is opened in View, the Trend gadget immediately has data. The scanned
values are retained if groov EPIC, groov Server, or the groov Box is restarted.

In groov View, you can download data from each pen to a .csv file, which you can open in an application like
Microsoft Excel. See “Downloading Data from a Trend” on page 125.

Classic or Interactive

When you configure the Trend gadget, you can choose between a Classic Trend or an Interactive Trend.

Classic Trend. For simple trends with a relatively small number of data points collected over a period of up
to 7 days. You can hover over or touch a spot on the trend to see data for that time.

Production =+ Download
30 Data button
Tthsday Jul 28, 10:03 .
Llne 1:21.237066 = Trend title
20
o
=
=
5]
~ 10
0
10:01 10:02 10:03 10:04 10:05
‘ | —Line 1 —Line 2 |
| L I ) ]
! |
Left axis Time Pen legend Hover or touch to see trend details
at any point.

Interactive Trend. For showing a large number of data points or data over a longer period (up to 5 years).
You can zoom in and out on the trend to see details. Because interactive trends can hold much more data,
groov View provides additional navigation aids and manages the display of data differently than a classic
trend.

«  groov View displays raw data as a line chart when the zoom level matches the rate that the data is
sampled (sampling rate). This is the default zoom level when you switch from Build mode to View mode,
so you will see a line chart when you switch to View mode.

«  Ifyou switch to a zoom level that is larger than the sampling rate, then groov View displays data that is
averaged, as well as minimum and maximum values. groov View displays the averaged values as a solid
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line, with the minimum and maximum values creating a shaded region around the line (see A Zoom
tabs, below).

A B

(9]

(System CPU Usage - 4 Hour Period )

Zac(‘m 15m 5m Al

30

5

© 20 2

d‘f A ® CPU Usage: 14.86146095717884 % .
10

15:58:45  15:59:00  15:59:15  15:59:30  [regfomisssercas

2 )
O T M

16:00:00 16:0...

I A A Ay

AN VA A A AN vhd
! “1\‘3:50“’/‘ 1330 LMV‘M‘”W‘T}&S A ng

¢ /

F G

A Zoom tabs. Click a tab to zoom in on data. groov View generates these tabs and assigns the time
period based on the trend’s period.

- Ifyou click on the tab with a time period that is close to the sampling rate, then groov View
displays the trend as a line chart (like the one above).

- Ifyou click on the tab with a time period that is larger than the sampling rate, then groov View
displays an average, along with minimum and maximum for each point. The trend will look like
a line chart with additional shading around the line, like this one:

System CPU Usage - 4 Hour Period

Zoom 15m 5m Al

N W
o o

Percent

=
o

0

-1
‘?3:32 13:34 13:36 13:38 13:40

13:44 13:46

Ny
TUUY PO r S U Oeye | I ISOTN I TOU AP SN e L

Trend title. You create the title; for reference, you may want to include the trend period in the title.
Download Data button. Downloads all data for the period, not just the current view. For more
information, see “Downloading Data from a Trend” on page 125.

Navigator line. Displays a thumbnail of the trend through one trend period, or as much as has been
collected up to the current date/time.

Date and time scale. Depending on the trend'’s period, it may show only time or only date.

Hover or touch on the trend to see pen names and trend details at any point.

- Ifthe period is close to the sample rate, groov View shows the raw data. The example at the top
of the page shows the raw data of a data point taken on Monday, January 11, at 3:59 PM.

O OW

mm
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- Ifthe period is larger than the sampling rate, then groov View shows three points of data:
average, minimum, and maximum. (The example below shows the details of a data point
taken on Monday, January 11, at 1:42 PM (1).) The box that points to the center data point (2)
shows the average value. The box that points to the bottom data point (3) contains the
minimum and maximum; the minimum value applies to the bottom data point and the
maximum value applies to the top data point.

[
AL ”I“. AVAYA ‘ AVWavaiisvawavavaiavawawmaVN|

® CPU Usage Min/Max: 1.2315270935960592 - 27 455919395465994
1

Monday, Jan 11, 13:42:03.547

13:36 13:38 13:40

G Data navigator. Helps you adjust the amount of data you see on the screen. To zoom in or out, drag
the handles on either side (1). To keep the same zoom level but see a different date/time, put your
cursor in the center of the navigator (2) and drag it to the left or the right. Or just click or tap on
another date/time on the navigator line to see the data at that date/time.

1

ot [ L i A 1= T.\

gy VA %m%ﬂﬁf@{ T Y Ve

In the example at the top of the page 121, you can click or tap 13:30 to see the same limited view of
data around that time. This method works especially well on mobile devices, where a finger may not
fit inside the zoom section.

To return to the current date/time, drag the navigator to the right until it stops.

After you drag or tap, wait for the data to fill in.

Note that there is no room in the interactive trend for a pen legend. If your users view your groov View
interface on a device (such as a TV) where they cannot hover over a data point, use the Text Area gadget to
add a legend next to the trend, indicating pen colors.

122 groov View User's Guide



Trend Gadget

Enter a title for the trend. (For an Interactive trend, you can Title
include the trend period in the title for reference.) S
Style
Choose the type of trend (see “Classic or Interactive”on page 120 @ Interactive
Classic
Tags

(Optional) For an explanation of this property, see “Making a Gadget Visible
Based on aTag”on page 71.

CHAPTER 4: GADGET REFERENCE

_

Click here to add pens. See “Configuring Pens” below.

Configure Data Sources

Visibility

Background Color

Choose the trend’s background color.

Days
Sec

Auto
Arial

B

Auto
Arial
B

Auto

Left

Auto

0

Enter the Period (maximum 7 days for a Classic trend, LI
5 years for an Interactive trend). 496
Enter how often you want data captured. No data is captured between intervals.
A red text box indicates that you have entered a value less than the minimum. Update Interval
The minimum varies based on the Period you entered. 30
Classic trends: A longer Update Interval uses less memory and may give Minimum 30 seconds.
better performance on a cell phone. Recommended interval is for a PC. Title Style
Size:
For the trend title: / =
Leave at Auto or choose size. /
Choose font. Default is Arial. Styling:
Make text bold, italics, or both. Default is neither. —
Change color (click the rectangle and choose). ———] 1"
Marker Font
For the markers: // Size:
Leave at Auto or choose size.
Choose font. Default is Arial. ——————— FOuk:
Make text bold, italics, or both. Default is neither. Styling:
Change color (click the rectangle and choose).
9 ( 9 ) | .
olor:
For the axes: g
Leave text size at Auto or choose size, ——— Size:
Select the axis you want to configure (left or right) —__| St
Enter the axis title. To enter a degree symbol, see — :
Appendix D. S Tite:
Choose Custom to set the Minimum and Maximum values that make sense —— [Value limits:
for the configured tag (pen). Auto sets these values for you; in View the trend _
will zoom in or out to accommodate the real-time range of the pen. Also see AR
“Configuring Value Limits and Min/Max Values”on page 124. M

NOTE: For any property with a link button, you can click to break the
link and choose the property value independently for Desktop & Tablet
versus Handheld layouts. See “Properties and Layouts” on page 70.

groov View User's Guide

1

1

v

Minimum 1 minute, maximum 5 years.

v [
%

NES
%

v [
123



TREND GADGET
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Configuring Pens

You can configure up to four pens for each trend. To add and configure a pen, do the following:

1.

3.
4.
5.

In the Trend Properties panel, click Configure Data Sources.

Edit Data Sources

Remaining Delete
Tag: ai_I0_0302

'Convenience Store' at 10.192.54.110
Title: Remaining Color: .
Axis: Left v
Line Type: Line v Fil: 4]
Rate Delete
Tag: ai_I0_0401

'Convenience Store' at 10.192.54.110
Title: Rate Color: .
Axis: Right v
Line Type: Smoothed Line v | Fil:

Add Pen
Done

For the first pen, select a tag, enter a title, and choose either Left or Right axis, depending on where you
want the axis located for this pen. Multiple pens can use the same axis.

Choose the line type, color, and whether you want to use afill.
For each additional pen, click Add Pen and configure it as desired.
Click Done.

Z-Order. The pens are displayed in the order you configure them here. The first pen configured will be on the
bottom of the z-order, and the last one will be on top. If you need to change the z-order, the quickest way is to
change the tags configured for each pen. For example, if you want the bottom pen’s tag to appear on top,
re-configure the top pen with that tag and move the other tag to the bottom pen.

Configuring Value Limits and Min/Max Values

The Minimum Value and Maximum Value change automatically even when Value Limits is set to Custom,
because groov View automatically adjusts the actual scaling lines and labels for optimum readability. For
example, they may change when you do any of the following:

Change the size of the gadget in Build

Adjust the size of your browser in either Build or View
Switch from Build to View

Change the Minimum or Maximum values on the other axis
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Downloading Data from a Trend

You can download the data from any pen to a .csv file, which can be used by other applications or opened in
an application like Microsoft Excel. The file consists of a Java/JavaScript timestamp and a value for each data
update (determined by the trend’s update interval) during the period of the trend.

For example, if you have a classic trend with a period of 24 hours and an update interval of 60 seconds, the
data you download will be for the latest 24 hours and show a data value for each 60-second interval.

If you have an interactive trend with a period of 1 year and an update interval of 60 seconds, the data you
download will be for the latest year and show a data value for each 60-second interval (a lot of data!). When
downloading data from an interactive trend, remember:

«  The download includes all data for the trend’s period, not just the time period you're viewing.
«  Dataisforone pen only.
To download trend data:

1. IngroovView, click the Download Data button = in the upper-right corner of the trend and choose the
pen you want.

2. When the file has been downloaded, save it in the location you want.
If you open the file in Excel, it looks something like this:

A B C
1 |timestamp value
2 1.46981E+12 14.412952
3 1.46981E+12 18.98415
= 1.46981E+12 19.626297
5 1.46981E+12 9.533747
& 1.46981E+12 13.5955965
7 1.46981E+12 13.389323
8 1.46981E+12 19.766735
9 1.46981E+12 16.010696
10 1.46981E+12 12.363201
E 1.46981E+12 14.523704

3. ThevalueintheTimestamp column isn't really a date and time; it's actually just a number of seconds. You
can use Excel to convert it to a number that Excel can then format into a date and time.

a. Foreach row of data, copy and paste the following formula to an unused column in the
spreadsheet. This formula converts the seconds into a (UTC time zone) date and time.
=(A2/1000 + ("™1/1/1970"-"1/1/1900"+1) * 86400) / 86400
(Optional) To convert the UTC time to local time, add or subtract the number of hours that your time

varies from UTC. For example, if your time zone is 10 hours ahead of UTC, you can use either of these
formulas:

=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 +(10/24)
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 + TIME(10,0,0)

b. Then, use Excel's Format Cells feature to format the resulting number as a date value, according to
the way you'd like to see it displayed.
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X d9- =
Home Insert Page Layout Farmulas Data Review View Acrobat
d Cut Arial -0 AN == =hiwrap Text
_ 53 Copy ~ _
K 3 Format Painter 2T = = =3 Merge & Center
Clipboard x Fant - Alignment
c2 - I =|[A2j'1000 + |["1,*’1}'15?D"—"lfl,flSDD"+1} * 86400) / 86400
A B C D E F G
1 |timestamp value date & time
2 1.46981E+12 14.412952' 7/29/16 5:05 F'MI
3 1.46981E+12 18.98415 7/29/16 5:05 PM
4 1.46981E+12 19.626297 7/29/16 5:05 PM
5 1.46981E+12 9.533747 7/29/16 5:05 PM
i) 1.46981E+12 13.595965 7/29/16 5:05 PM
7 1.46981E+12 13.389323 7/29/16 5:06 PM

.
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5: Using Events and Notifications

Use this chapter to set up event conditions in groov View and to view event logs. All events are logged, and
authorized groov View users can see them at any time from either View or Build mode. In addition, all events
appear as tags in the tag browser, so you can use an event as an input for a gadget.

This chapter also shows you how to set up optional email or text notifications when an event occurs. For
example, if a machine’s temperature is critical, you can create an event and notify a maintenance technician
via email or text message when the machine overheats. The technician can click a link in the notification that
leads to the groov View screen with more data on the machine.

You can customize messages, send them to groups or individuals, and include time/date stamps and other
information. A notification can be sent when the event becomes active, inactive, or both.

In this chapter:

Creating Events

Viewing EVents ...
Setting Up Notifications...........cc.cc....
Event Condition Types Reference.......

Using Multiple Conditions

groov EPIC,

Events and Notifications

Control system

groov Server
for Windows,
or groov Box

Tank level
If Full

—» [mailme
If Empty ——— £mail me

Boiler Temperature
[fToo Hot! ————m= Text me

All data from devices in groov View is ‘
available for logging events and sending
notifications ~

~—
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CREATING EVENTS

You can create events based on one or more conditions.
1. InBuild mode, select Configure > Events.

Security

| Devices and Tags...
| Image Library...

Events... % —» ‘ € Close Create New Event

| Project...

groov Admin
Licensing...

2. Click Create New Event.

« Return to Event List Create Event

Event Properties

Event Name | |

Tag  None Selected This event is active when | any ~ of the conditions below are
Condition Not Equal - true
Comparison Value True v
Debounce Time seconds
Clear Add New Condition

U S Ve S T U M SR S L SN s e

3. In Event Properties, give the event a name.
4. In Event Conditions, follow steps below to create one or more conditions that define the event. (For help
in understanding the conditions and the fields to complete, click the Info icon m )
a. Tag—Click None Selected. In the Select Condition Tag dialog box, browse to a tag to monitor for
this condition. If the tag is an array, also enter the array index. Then double-click the tag or click
Select Tag.
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Select Condition Tag

No Tag

Mysgl database
B Line 1 LC-R1
Manual Tags
2 Auto Tags
= Module 0 (4-channel digital)
B State
diDoughLevelSwi STATE
diChipLevelSwitch STATE
dilnspectionPassFailSwitch STATE
diEStop STATE
Latches

& Madula 1 fA.channal diaitall

Array index:

Select Tag Cancel

b. Condition—Click the drop-down menu and choose the condition type for the event. (For Boolean
true/false or state tags, the condition Equal is chosen for you.)

Equal =
For details on conditions, see “Event Condition Types
-------- Reference”on page 138.

Not Equal

Above Limi
Below Limit
Outside Range

Inside Range

c. Complete additional fields as needed for the tag type and condition type you chose.
For example, for state tags you choose True or False. For analog or numeric tags you enter a
comparison value. For Above Limit, you enter the limit and choose whether the event should occur
when the value is greater than the limit, or greater than or equal to the limit. In some cases you may
also want to enter hysteresis values or debounce times. For more information, see “Event Condition
Types Reference” on page 138.

d. When you've completed the fields, click Add New Condition to save your entries. The new condition
appears at the right (or below on a smaller screen).

NOTE: Be sure to click Add New Condition. If no conditions appear, you'll receive an error message when you try
to save the event.

e. Ifyou want the event to depend on additional conditions, choose another tag, complete the fields
for it, and then click Add New Condition again.
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Event Conditions [i]

Condition

Tag

Limit Value

Inclusive [
Limit

Hysteresis

Debounce Time

Above Limit

None Selected

This event is active when  Any

below are true

uint64 Variable 1> 128

Edt | Delete \

fDoughPressureSetpoint > 3
Edtt | Delete

- of the conditions

—— New conditions

f.  Ifthe event depends on more than one condition, complete the “This event is active when..."
sentence. Choose All if all of the conditions must be true to trigger the event. Choose Any if only one
of them needs to be true to trigger the event. Also see “Using Multiple Conditions”on page 140.

5. (Optional) To show a custom message in the event log, scroll down to Notification Messages.

The event message you will see in the log (and in an email or text notification, if you send one) contains
default text to identify the event. Default text includes the event name, date/time, and whether the event
began or ended. You can enter a custom message in this section if you wish.

6. Click Create Event to save the new event. Click Close to return to the main workspace.

As soon as you save an event it is enabled, so if the event conditions become true it will be logged. groov EPIC,
groov Server for Windows, and the groov Box continually scan for the event tags and monitor for event

conditions, even if groov View is closed.

When an event occurs, the events icon in the upper-right corner of groov
View changes, showing the number of events that have occurred. To view

event status, click the icon. Also see "Viewing Events”on page 131.

Using Events as Inputs for Gadgets

Once you have created an event, it becomes a read-only Boolean tag
that you can use as an input for a gadget. To see these event tags, go to
the Gadget Palette. Click the Tags tab, and then click the Events device

(see image at right).

Enabling and Disabling Events

When a configured event is enabled, the event is logged (and

notifications are sent, if applicable) when the event conditions are met.
To enable or disable an event, choose Configure > Events and find the

event you want. Then click its Enabled/Disabled button.
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Gadget Palette
Tags |[RecLhES

Configure Devices & Tags...

'Cookies' at 10.192.55.67

Data Simulator

Edge server

i\\)Events
Refrigeration alarm

Line 1 LC-R1

Modbus power

Mysql database

System
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« Close Create New Event
Click here  —————Fnabled Check Pump Pressure
Complex Wave'8
Edit | Delete

Process Recycle on Station 3

Complex Wave A
Edit | Delete

VIEWING EVENTS

As soon as you create an event, it is enabled; when the event occurs, it is logged. To view, sort, and filter
logged event messages, click the Events icon (the bell) in the top right corner of either Build or View mode.

Z ‘ Events n £¥ Menu
ey .

A list of configured events appears next to a menu of viewing options.

To see the status of all events, choose Current Status. You see a list of configured events and whether
they are active (meaning that the event conditions have been met) or inactive. The text and indicator turn
blue for events that are active; black for inactive.

= Pages A‘:Nl]a ‘ Events u £+ Menu

. Refrigeration alarm
Enabled - Active

Active event

Events

Current Status

To see a list of all logged event messages, choose Message Logs.

= Pages A(:Nl]?l ‘ Events ¥ Menu

END - Refrigeration alarm

Events 2019-11-14, 15:48:22 GMT-08:00

The event 'Refrigeration alarm' ended at 2019-11-14, 23:48:22 GMTZ
BEGIN - Refrigeration alarm

2019-11-14, 15:48:09 GMT-08:00

The event 'Refrigeration alarm’ began at 2019-11-14, 23:48:09 GMTZ

Message Logs

END - Refrigeration alarm

2019-11-14, 15:47:46 GMT-08:00

The event 'Refrigeration alarm’ ended at 2019-11-14, 23:47:46 GMTZ
BEGIN - Refrigeration alarm

2019-11-14, 15:31:00 GMT-08:00

The event 'Refrigeration alarm’ began at 2019-11-14, 23:31:00 GMTZ
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To sort logged event messages when looking at Current Status, click Sort By and choose Event Name,
Active/Inactive, or Enabled/Disabled.

Events

Current Status

Sort Ey“v An active event is one that is enabled and is occurring right now. You can
enable or disable events in Build mode (see page 138).

To see only some events when looking at Message Logs, choose Filters and complete the fields.

Events

Message Logs

Filters ¢ You can use one or a combination of these filters.

& Event Name Filter

_ « Inthefields for Event Name Filter and Message Filter, enter a text

string.

B Message Filter . . . . )
h « Inthe Start and End boxes for Time Range Filter, click in the field
and select a date and time for each one.

B Time Range Filter

To download a text file of all logged messages, click Log Controls and choose Download Logs. You
can open the text file in a text editor like Notepad or save the file for later viewing.

NOTE: ifyou are using the groov View REST API, you can also download logs to the APl endpoint using any HTTP client
in either standard text or JSSON format. (For more information on the REST API, visit developer.opto22.com.)

| groovEventl ogs.txt - Notepad - u] 'Y
File Edit Format View Help

2018-04-07T20:56:08Z Process Recycle on Station 3 [3] ENDED The event 'Proc
2018-04-07720:56:16Z Process Recycle on Station 3 [3] BEGAN The event 'Proc

Message Logs 2018-04-07T720:56:20Z Check Pump Pressure [1] BEGAN The event 'Check Pump F
2018-04-07T20:56:21Z Low Fuel Warning [2] BEGAN The event 'Low Fuel Warning

Log Controls ~ 2018-04-07720:56:23Z Process Recycle on Station 3 [3] ENDED The event 'Proc
2018-04-07T20:56:24Z Low Fuel Warning [2] ENDED The event 'Low Fuel Warning

D°“’"'°ad$°95 2018-04-07T20:56:267 Check Pump Pressure [1] ENDED The event ‘Check Pump F
< >

To delete all event messages from the log, click Log Controls and choose Clear Logs. Only users with a
security level of Admin can clear logs.
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Event Message Log Capacity

groov View checks the size of the Event Message Log every 30 minutes. If it is more than 200 MB (typically over
a million entries), the oldest 25% of entries are trimmed. If this occurs, a message is posted to the Log Viewer
noting that the oldest entries have been removed. For more on the Log Viewer, see “Viewing Log Messages”
on page 88.

SETTING UP NOTIFICATIONS

You can choose to notify one or more authorized groov View users when an event occurs, at the beginning of
the event, the end of the event, or both. These steps assume you have already created the event (if not, see
“Creating Events”on page 128).

Follow these steps to set up notifications:

1. Set Up the groov View Email ACCOUNT ......oococeevcceeeceeeeeeeeeeen 133
2. Set Up groov View Users To Receive Event Notifications......... 135
3. Add Notifications to Events .... 137

1. Set Up the groov View Email Account

This section sets up the account that groov View will use to send email and text notifications. If you want groov
View to send from a Gmail account, use the setup instructions on page 134 instead.

1. Create an email account that's used just for this groov View.

A separate email account makes it clear where the email is coming from, and it provides a record of all
successfully sent notifications in the Sent Mail folder of the groov View account. (Currently, groov View
does not buffer notifications that failed to send.)

Also, by creating a separate account for this groov View, you can change email settings and not impact
your business or personal email account settings.

2. InBuild mode, choose Configure > Project.

Project Settings

€ Close Save Settings
General Settings Email Settings
Default video gadget refresh 0.5 seconds SMTP server hostname: m
period:
The minimum video refresh rate is 0.5
seconds. SMTP server port: 25
The SMTP port is a number between 1
Do not expire Kiosk user login o and 65535. Common ports are 25 and 587

sessions: for mail servers using STARTTLS or no
Takesiaflert thie: neot-imethestiser togs connection security, and 465 for those
in.

using SSL.
Allowed Cross-Origin Request Connection security: None .
Dofnains: ex. hitps://my.app.cor | 4+
Most larger services nowadays will use
STARTTLS.
Set of external domains that may access
the REST interface for this groev. See also Allow untrusted certificates:

HTTP Access Contral (CORS) on the web. . i
E Use this if your internal mail server uses a
self-signed certificate.

Sender address: groov@localhost

Groov View Styling

The email address you want groovto
send as. Some services might ignore this.

T i ST VNP P PP S e

3. Inthe Email Settings section on the right, set up the groov View email account as follows:
SMTP server hostname—_Enter the SMTP server address.
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134

SMTP server port—Consider the following:

—  The SMTP port is a number between 1 and 65535. Common ports are 25 and 587 for mail servers
using STARTTLS or no connection security, and 465 for those using SSL.

- Ifyou are outside a company network, you may need to try port 587. Other email servers might
need different port numbers. Check with your IT group if you are using a company email server to
send the emails.

Connection security—Choose STARTTLS if you are using a large service such as Yahoo. Other email
servers may need a different setting.

Allow untrusted certificates—Check this if your internal mail server uses a self-signed certificate.

Sender address—-Enter the email address of the groov View account you created previously. Some
services might ignore this.

Username—£Enter the username for the groov View email account.

Password—Enter the password associated with the groov View email account.

Send a test email—Enter an email address that can receive a test email and that you can easily check.
4. C(lick Send Test Email to test your connection settings.

If a message in green letters appears that says Test message sent!, make sure it arrived in the
inbox of the email account you sent the message to. If you see a red error message, try different settings
in the groov View email account.

5. Scroll to the top and click Save Settings, then click Close.

Continue with step 2 on page 135.

Setting Up the groov View Email Account Using Gmail

Follow these steps if you are using Gmail for the account groov View sends email from. If you are using an
email service other than Gmail, see the more general guidelines starting on page 133.

1. Create a Gmail account that's just used for this groov.

A separate email account makes it clear where the email is coming from, and it provides a record of all
sent notifications in the Sent Mail folder of the groov View account. The Sent Mail folder thus functions as
a kind of automatic cloud-based log file. Also, by creating a separate account for groov View, you can
change email settings and not impact your company or personal email account settings.

2. Make sure to enable the account to send email by what Google calls “less secure apps.”
Follow these steps:
a. Open a new incognito window in Chrome, or a private window in Firefox.
b. Go to the following link:
https://www.google.com/settings/security/lesssecureapps
c. Login to the Gmail account you created for groov View.
d. Nextto “Access for less secure apps,” select “Turn on.”
3. InBuild mode, select Configure > Project.
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Project Settings

« Close Save Settings

Default video gadget refresh
period:

sssssss

Allowed Cross-Origin Request
Domains:

General Settings

Email Settings

0.5 seconds SMTP server hostname: server.hostname.com

The minimum video refresh rate is 0.5

seconds. SMTP server port: 25

The SMTP port is a number between 1
d ort: d

Takes effect the next time the user logs o
L. using SSL

Connection security: None -
ex. https://my.app.co -+
Most larger services nowadays will use
STARTTLS.

Set of external domains that may access
the REST interface for this groov. See also
HTTP Access Control (CORS) on the web.

Allow untrusted certificates:

Use this if your internal
self-signed certificate.

mail server uses a

Groov View Styling

Sender address: groov@localhost

The email address you want groov to
me services might ignore this.
e et et

In the Email Settings window, set up the groov View email account as follows:
SMTP server hostname—_Enter smtp.googlemail.com.
SMTP server port—Consider the following:

—  The SMTP port is a number between 1 and 65535. Common ports are 25 and 587 for mail servers
using STARTTLS or no connection security, and 465 for those using SSL.

- Ifyou are inside a company network, you probably need port 25.

- Ifyou are outside a company network, you may need to try port 587.

Connection security—Choose STARTTLS.

Allow untrusted certificates—Make sure this option is not selected.

Sender address—Enter the Gmail address of the groov View account you created previously.
Username—©tnter the Gmail address, the same as the Sender address.

Password—Enter the password associated with the groov View Gmail account.

Send a test email—Enter an email address that can receive a test email and that you can easily check.
Click Send Test Email to test your connection settings

If a message in green letters appears that says Test message sent!, make sure it arrived the inbox
of the email account you sent the message to. If you see a red error message, try a different SMTP server
port setting.

Scroll to the top and click Save Settings, then click Close.

2. Set Up groov View Users To Receive Event Notifications

IMPORTANT: Before setting up notifications, make sure you and your users understand any limitations and
charges that will apply to those who receive text or email notifications. Limitations and charges vary by carrier, plan,
and country.

This section shows you how to set up email addresses for all groov View users who should receive event
notifications, either as email or text messages.

Text message notifications are valuable when cell coverage is weak and you can receive only phone calls and
plain text messages (SMS); even when your email client can't update, you'll still get important notifications.
SMS messages are generally limited to 160 characters, but limits vary by carrier and country, so check with
your local carrier.

1.
2.

In Build mode, choose Configure > Accounts. Then click the Users tab.
Find the user's name in the list and click the pencil icon next to the name to open the Edit dialog box.
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Edit user "Bob Phang'

Username Bob Phang
Email
Role Qperator v @
API Key Y8zJd9TXdtWH2obbstr7uHuapk3aq7fK Generate
New Password
Confirm
Require password change at next login
Groups R
#| Line operators
Update User Cancel

3. Enterone of the following in the Email field:
- For email notifications, enter a valid email address. For example BPhang@foomail.com

For text message notifications, enter the user's phone number followed by the domain used by
the carrier to send text messages to phones. For example, to send a text message to a Verizon
phone, use the recipient’s mobile phone number followed by “@vtext.com” If the phone number is
555-123-4567, you type 5551234567@vtext.com

For a list of carriers and email addresses, see the next section, “Email Addresses for Text Messaging.”

NOTE: if you want the same person to get both email and text message notifications, you will need to create two
user accounts.

4. C(lick Update User. Notice that the email or text address is now shown in the list of users.
Email Addresses for Text Messaging

By using an email-to-SMS (Short Message Service) email address you can send a text message notification
from groov View. Check with your carrier for SMS character limits.

Here is a list of common cell phone carriers in the U.S. and Canada and the email-to-SMS email addresses they
use for sending text messages via email to a cell phone. Choose the carrier for the phone you want to receive
event notifications.

Carrier Email-to-SMS Email Address

AT&T 10digitphonenumber@txt.att.net

Comcast 10digitphonenumber@comcastpcs.textmsg.com
MCI 10digitphonenumber@pagemci.com

Nextel 10digitphonenumber@messaging.nextel.com
Qwest 10digitphonenumber@qwestmp.com

Sprint 10digitphonenumber@messaging.sprintpcs.com

T-Mobile 10digitphonenumber@tmomail.net
US Cellular  10digitphonenumber@email.uscc.net

Verizon 10digitphonenumber@vtext.com

For carriers not listed here, see the following websites:

http://martinfitzpatrick.name/list-of-email-to-sms-gateways/
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http://www.emailtextmessages.com/

3. Add Notifications to Events

1.
2.
3.

In Build mode, choose Configure > Events.
Click the name of the event you want to send a notification for.
Scroll down to Notification Recipients.

Notification Recipients (Optional)

Send Email On Event... ¥ Begin ¥ End

|| Send to every user with an assigned email address

To: | Search by name

a. Check the boxes to send the email when the event begins, when it ends, or both.
b. Do one of the following:

- Select “Send to every user with an assigned email address.” The To: list is ignored.
- (lickin the text box next to To: and select the users who should be notified.

All recipients must have an email address configured to receive event notifications. You can add users
who don't have email addresses, but they'll receive notifications only after addresses have been assigned.
To assign and edit user email addresses, choose Configure > Accounts and edit the user (see page 135).

TIP: If you have configured a group, you can add the group to your list, and all the users in that group will receive
the notification.

Customize your message in the Notification Messages window. If you leave the subject line or message
empty, a default subject line or message will be used.

Notification Messages (Optional) (i)

Custom Event Begin Message Custom Event End Message
Subject Line Subject Line
> ®» o > » (o]
1
gy —\'\MN-

You can add Condition Tags, Project Tags, or a Time stamp to a message. When you add a Condition Tag
or a Project Tag to a message, the < Tag Name > placeholder will be replaced in the email by the tag's
value at the time of the event beginning or end.

Condition Tags Project Tags Time-stamp

|
|
S ® 0
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EVENT CONDITION TYPES REFERENCE

Condition Tags—The tags that you have referenced in the conditions for this event. When using
condition tags, if you alter the conditions for this event, make sure that your tag references in these
messages are updated to match.

Project Tags—All of the device tags in this groov View project.

Time stamps—All < Time-stamp > placeholders are replaced in the email by the current local time of
the event's beginning or ending.

—  Onagroov EPIC processor, the time stamp is from the processor. To adjust the time and date, see
Chapter 10 in the groov EPIC User's Guide.

- Ingroov Server for Windows, the time stamp uses the local time that the PCis set to.

- Onagroov Box, make sure your time zone is correctly set in groov Admin. By default, the groov Box is
set to UTC. If you change the time zone in groov Admin, you must restart the groov Box for the
change to propagate through groov View. Once restarted, event time stamps use the configured
time zone. For more information, see “Changing the Time Zone”"in form 2104, the groov Box User’s
Guide for GROOV-ART. (For the GROOV-AT1, see form 2077.)

5. Scroll back up to the top of the window and click Update Event. Then click Close to return to Build mode.

Once you save or update an event it becomes active, so if the event conditions become true a notification will
be sent to groov View even while you are in Build mode. groov View continually scans for the event tags and
monitors for event conditions, even if you have groov View closed.

When an event occurs, the events icon in the upper-right corner of groov
View changes, showing the number of events that have occurred. To view Beventsf] £ Menu
event status, click the icon. Also see "Viewing Events”on page 131.

EVENT CONDITION TYPES REFERENCE

138

Use the information in this section when creating events (page 128). If you want to use multiple conditions,
also see "Using Multiple Conditions”on page 140.

Not Equal

The event is active when the tag value is not equal to the Comparison Value. The event is inactive when the
tag value is equal to the Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does
not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Equal

The event is active when the tag value is equal to the Comparison value. The event is inactive when the tag
value is not equal to Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag'’s value must satisfy
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does
not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.
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Above Limit

The event is active when the tag value is greater than (or equal to) the Limit value. To become inactive, the tag
value must drop to the Limit minus the hysteresis offset or below.

Hysteresis. A hysteresis offset value is used to determine when an active event may be considered inactive.
It establishes an offset from the condition limit that the tag must reach before the event may transition from
an active state to inactive.

For Above Limit conditions with hysteresis, the tag value must drop below the Limit value minus the
hysteresis offset. For example, if you want to know if a boiler's temperature exceeds a safe limit of 200 degrees,
you could create an Above Limit condition that monitors the tag assigned to the boiler temperature sensor.

Setting the Limit Value to 200 and a Hysteresis to 20 indicates that if the boiler temperature exceeds 200
degrees, it should not be considered safe/stable until the temperature drops to 180 degrees or below, rather
than the maximum 200 degree limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does
not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Below Limit

The event is active when the tag value is less than (or equal to) the Limit value. To become inactive, the tag
value must rise up to the Limit plus the hysteresis offset or above.

Hysteresis. A hysteresis offset value is used to determine when an active event becomes inactive. It
establishes an offset from the condition limit that the tag must reach before the event changes from an active
state to inactive.

For Below Limit conditions with hysteresis, the tag value must rise above the Limit value plus the hysteresis
offset. For example, if you want to monitor a settling pond to determine when it is below capacity and is ready
to receive more water, you could create a Below Limit condition that monitors the tag assigned to a water
level sensor.

Setting the Limit Value to 4 (meters) and a Hysteresis of 2 indicates that if the pond drops below 4 meters in
depth, it should not be considered to be at capacity until the level reaches 6 meters or greater, rather than the
minimum 4 meter limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag's value must satisfy
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does
not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Outside Range

The event s active when the tag value is less than (or equal to) the Lower limit or greater than (or equal to) the
Upper Limit. To become inactive, the tag value must rise up to or above the Lower Limit plus the Lower
Hysteresis, or drop to or below the Upper Limit minus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They establish a value
range that the tag must reach before the event changes from an active state to inactive. The Upper Hysteresis
and Lower Hysteresis are independent of each other and either one may be left blank.
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Also, for an Outside Range condition, hysteresis must be less than the difference between the Upper Limit and
Lower Limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag'’s value must satisfy
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does
not satisfy the condition, the event will not become active (or inactive).

Debounce time is an integer value in units of seconds.

Inside Range

The event is active when the tag value is between the Lower and Upper limits. To become inactive, the tag
value must drop to or below the Lower Limit minus the Lower Hysteresis, or rise up to or above the Upper
Limit plus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They establish a value
range that the tag must reach before the event changes from an active state to inactive. The Upper Hysteresis
and Lower Hysteresis are independent of each other and either one may be left blank.

USING MULTIPLE CONDITIONS

140

Using multiple conditions for a single event is a good way to reduce event duplication and to capture events
that depend on the state of multiple tags. When using more than one condition for an event, the “event is
active when"statement has the following effect:

Any: The event is active when condition 1 is active OR condition 2 is active OR condition 3 and so on. The
event becomes inactive only when ALL of the conditions are inactive.

Example uses:
«  Youhave multiple tags that all monitor the same type of condition.

«  You want to be notified of a problem in your process that could be caused by any one of a number of sub
processes.

All: The event is active when condition 1 is active AND condition 2 is active AND condition 3 and so on. The
event becomes inactive when ANY of the conditions is inactive.

Example uses:

«  Multiple components along a process line turn off sequentially when not in use. It is normal to have
some components off at any given time. If all of the components are off at the same time, however, that
may indicate a problem.

«  You have a system monitoring multiple boilers. If any one of those boilers becomes too hot, a separate,
per-boiler event notification is sent to your on-site technicians. If several boilers all become too hot at the
same time, a notification is sent to your on-call technicians and your engineers.
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6: Viewing Your Operator
Interface

The operator interface developed in Build mode can be securely accessed by an authorized user who is using
groov View from any of the following:

« agroovEPIC's integral touchscreen
« acomputer's web browser
« asmartphone, tablet, or other mobile device that has the groov View mobile app or a web browser.

In this chapter:

OPENING VIEW ..o 141
OPENING @ PAGE ... 142
LOGGING QUL ctvrvvrrivierresssiessnsssssiessssssssissssssssssssssessssssssss s sssseee 142
Changing YOUT PaSSWOIT ........ooccvvveeeeveseseesssseesssssesssseesssssesssssesssssens 143
Refreshing the Operator INTerface ... 143
Automatic Refresh 143
Setting Up groov View Mobile APDS ... 144
Using groov View over the Internet 152

OPENING VIEW

From the groov EPIC touchscreen

1. Loginto the EPIC’s touchscreen.
2. Tap groov View.

From a computer or mobile device's web browser

1. Open your web browser. (To use the groov View mobile app, see “Setting Up groov View Mobile Apps”on
page 144.)

2. Type https:// andthe groov EPIC, groov Server, or groov Box's hostname as the URL.
Make sure you type the s: https://

a. Ongroov EPIC, use the EPIC's hostname (chosen when the EPIC was initialized).

b. If groov Server is installed on the same computer you're using, type https://localhost
If groov Server is installed on a different computer, type https:// and the computer's hostname. For
example, if the computer’s hostname is RStarr-w10, you type https://RStarr-wl0
You can use the IP address of the host PC instead of the hostname. However, if the PCis on a
network with DNS and DHCP, the IP address is subject to change.
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OPENING A PAGE

c.  Onagroov Box, the default hostname is printed on the bottom of the Box. For example, if the
hostname is opto-00-d2-dc, you type: https://opto-00-d2-dc
If you've assigned a static IP address to the Box, use the IP address instead of the hostname.

3. Login with your username and password. For groov EPIC, select groov View.
groov View opens.

OPENING A PAGE

1. Click the navigation icon in the upper left of the screen to see the pages and page categories.

Icon = Refrigeration —————— Page you're
currently viewing
Page
category — — Headquarters
Refrigeration
Page — Pump room
Main
Tanks - Field

Factory
Line 1 Operation
Line 2 Operation
Line 1 KPIs

Pumps

2. Select the page you want to open.

LOGGING OUT
1. Click the gear Menu at the top right.

‘ Events ¥ Menu

Switch to Build mode

Change password

W 2 &

View logs

About groov View

Refresh groov View

* O

groov Admin
Sign out @n

2. (lick Sign out ‘Username.
The login dialog box appears.

¥
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CHANGING YOUR PASSWORD

1. Click the gear icon on the top right-hand side and choose Change Password.

‘ Events £+ Menu

[# Switch to Build mode

& (Change password
B View logs @ \

i About groov View S

Change password for user 'jean’
& groov Admin

= Sign out jean’ Original password:

New password:

Confirm password:

Cancel Change Password

2. Enter the current password and the new password (twice).
3. (lick Change Password.

REFRESHING THE OPERATOR INTERFACE

If changes have been made and saved in Build mode, you can refresh View at any time and the new changes
will appear.

1. Click the gear Menu on the top right-hand side.
2. (Click Refresh groov View.

.‘ Events £+ Menu

-

Switch to Build mode

Change password

W 2 &

View logs

About groov View

Refresh graou@w
groov Admin

et e

O

AUTOMATIC REFRESH

New and updated interface pages

Starting with groov View version R3.5a, any changes you make to your groov View operator interface are
automatically pushed out to all users. Users do not need to refresh their screens.
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Updated groov View versions

Starting with version R3.2a, when your groov version is updated (for example, from R3.2a to R3.2b), clients are
automatically updated as well.

SETTING UP groov VIEW MOBILE APPS

144

Opto 22's free groov View apps for iOS and Android are the best way to view your operator interfaces on your
iPhone, iPad, or Android smartphone or tablet. In the mobile app you can see one or more groov installations
in full-screen mode without the address bar, toolbars, and other things you see in a browser.

To connect to groov View the first time:
1. Download the app:
- groov View for iOS
- groov View for Android
2. Install the app on your iOS or Android device.
3. Tapthe groov icon to start the app.

Continue with the instructions for iOS or Android:
“Using the i0S Mobile App” (below)
“Using the Android App”on page 149

Using the iOS Mobile App

In this section:

“Adding a Connection to a groov Device or Server in the iOS App”

“Connecting, Editing, and Setting a groov Connection as the Default in the iOS App”
“Configuring i0S App Settings”

“Navigating Through the groov View iOS App”

Adding a Connection to a groov Device or Server in the i0OS App

Follow these steps in your iOS app to connect to a groov EPIC processor, a groov Edge Appliance (groov Box), or
groov Server for Windows. Do these steps to create the first connection and every time you want to connect to
a new groov device or server.

1. Tap the groov View icon to open a list view for adding one or more connections.

wil Verizon 3111 PM

+ 15 groov View
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4.

CHAPTER 6: VIEWING YOUR OPERATOR INTERFACE

Tap g to add a new connection.

wil Verizon & 3:112 PM

Cancel Add New Connection

Hostname: | https:/ ‘
Display Name:| \
Port: | 243 |
Username: | \

Password: ‘ ‘

Full Screen: ()

Passcode:

Ignore SSL Warnings

Enter the following information. (Tap on the screen outside of the text boxes to hide the keyboard and
reveal any hidden options.)

Hostname—Type https:// and the hostname or IP address of a groov EPIC processor, groov Box, or
groov Server for Windows.

NOTE: If you are within the company network and have a valid hostname that is registered with
the domain server, you still might have to type the fully qualified domain name. For example, if
the hostname is “petrovsgroov” and the domain name is “somecompany.com’, you would type
"petrovsgroov.somecompany.com’

Display Name—_Enter a name that will appear in the connection list.

Port—Enter the port number, usually 443.

Username and Password—Enter the username and password for this connection.

Full Screen—Enable this option to hide navigation to the groov View list. (With this option
enabled, swipe right to go back to the groov View list.)

Passcode—FEnable this option to add another security layer by requiring a passcode each time this
connection is viewed on this device. The next time you connect to this groov device or server, you
will be prompted to enter this new passcode.

Ignore SSL Warnings—\When enabled, the device will ignore browser security warnings.
Handheld Layout (iPad only)—Enable this option to force the display to use groov View's
handheld layout rather than the desktop layout.

Tap Done.

Connecting, Editing, and Setting a groov View Connection as the Default in the iOS App

Follow these steps in your iOS app to connect to a groov device or server, edit the connection settings, or set a
default connection.

1.

Start the groov View app to open a list of connections.
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If you haven't connected a groov device or server, see “Adding a Connection to a groov Device or Server in
the i0S App."If you have set and enabled a default connection, groov View automatically attempts to
connect to the default groov connection. To return to the list view, swipe right.

2. Tap aconnection in the list to open its Options.

groov View Options

Connect

Edit

Set as Default

Delete

Cancel

—  Connect—Connects to the selected connection.

- Edit—Opens the selected connection so you can edit connection settings. The screen is filled with
the data from the selected connection, and the title is the Display name (if configured) or the
hostname of the connection. For information about the options, see “Adding a Connection to a
groov Device or Server in the iOS App.”

- Setas Default—Sets the selected groov connection as the default so that when you start the groov
View app, it bypasses the connection list and opens the default connection automatically. For this to
work, also tap the Settings icon at the top of the screen and turn on Enable Default Connection (see
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“Configuring iOS Mobile App Settings”). The default connection is indicated with a check mark.
Only one connection can be the default.

wil Verizon 3:14 PM -

+ 18 groov View Default

groov demo

Irrigation v Default connection

Work Box

Pt A n P i P NNt O il PN )

—  Delete—Deletes the selected connection from the list.
- Cancel—Exits groov Options.

Configuring i0OS Mobile App Settings

To configure the iOS groov View app settings, tap the gear icon.

Gear icon

= 3:14 PM -

+ 1 groov View Default

1] ail Verizon & 3:156 PM

groov View Settings

groov demo

| Hide Status Bar

Connection TImeout 2000

Enable Default Connection

Irrigation

Work Box

Lock Settings

Require Passcode

i A P P NN N e i NS o IS ]

«  Hide Status Bar—Hides the status bar that normally appears at the top of the screen.

«  Connection Timeout—Sets how long the app will spend trying to connect to the groov device or
server. The timer starts as soon as the Connect menu option is selected.

«  Enable Default Connection—Use this option if you want to bypass the connection list when starting
the groov View app and go directly to the default connection. You will also need to assign a default
connection in groov Options. See “Connecting, Editing, and Setting a groov Connection as the Default in
the iOS App.”

«  Lock Settings—When enabled, no connections can be added, modified, or deleted, and the settings
themselves can't be changed. When using this option you'll also want to require a passcode. Otherwise,
anyone can unlock the settings.

«  Require Passcode—\When enabled, a user on this mobile device must enter a passcode to change the
settings, or add, modify, and delete connections. You'll be prompted to enter a new passcode when you
enable the option.
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Navigating Through the groov View i0OS App

To return to the connection list without closing the current groov connection, simply swipe right. This
works in normal view or with Full Screen enabled (see “Adding a Connection to a groov Device or Server
in the i0OS App”). The active connection is shown in green.

w1l Verizon = 4:23 PM -

+ 15 groov View Default
groov demo

Irrigation

Work Box active connection

L Y S N L

To return to the current connection, do one of the following:

- Swipe left from the connection list.

—  Tap the active connection and choose Resume from the menu.

To disconnect from the current connection, tap the connection in the list, and choose Disconnect.

When you navigate to an external webpage that opens when you tap a URL link in a groov View HM|,
use the navigation bar at the bottom of the page to return to groov View: tap the groov View icon.

Support
SHARE

Support
PRODUCT SUPPORT IS FREE

Our Product Support Team,
located in the United States at
our corporate office in California,
is available to answer your
questions Monday-Friday, 7 a.m.
to 5 p.m. Pacific Time.

Phone: 951-695-3080
Toll-free (in the U.S.): 800-835-

< & OO — Retumn to groov View
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Using the Android App

In this section:
“Adding a groov Device or Server to the Android App”
“Connecting, Editing, and Setting a groov Connection as the Default in the Android App”

“Navigating Through the groov View Android App”

Adding a groov Device or Server to the Android App

Follow these steps in your Android app to connect to a groov EPIC processor, a groov Edge Appliance (groov
Box), or groov Server for Windows. Do these steps to create the first connection and every time you want to
connect to a new groov device or server.

1. Tap the groov View icon to open a list view for adding one or more connections.

My groov

demo.groov.com

Steve's groov

05 i, ammmanal

2. Tap to add a new connection.

Add New groov

Hostname: \https://

Display Name:
Port: 443
Username:

Password:

Full Screen
Require Passcode

Handheld Layout Yes

Cancel OK

3. Enter the following information.
—  Hostname—Type https:// and the hostname or IP address of the groov device or server.
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NOTE: If you are within the company network and have a valid hostname that is registered with
the domain server, you still might have to type the fully qualified domain name. For example, if
the hostname is “petrovsgroov” and the domain name is “somecompany.com’, you would type
"petrovsgroov.somecompany.com’.

—  Display Name—Create a name that will appear in the connection list.
- Port—Enter the port number, usually 443.
—  Username and Password—Enter the username and password for this connection.

- Full Screen—Enable this option to hide navigation to the groov View list. (With this option
enabled, swipe right to go back to the groov View list.)

- Require Passcode—\When enabled, the next time you connect to this groov device or server, you
will be prompted to enter a new passcode which will then be needed each time you attempt to
view this connection.

- Handheld Layout—Enable this option to force the display to use groov View's handheld layout
rather than the desktop layout.

4. TapOK

Connecting, Editing, and Setting a groov Connection as the Default in the Android App

Follow these steps in your Android app to connect to a groov device or server, edit the connection settings, or
set a default connection.

1. Start the groov View app to open a list of connections.

If you haven't connected a groov device or server, see “Adding a groov Device or Server to the Android
App."If you have set and enabled a default connection, groov View automatically attempts to connect to
the default groov connection. To return to the list view, tap the back button or swipe right.

2. Tapaconnection in the list to open its Options.
My groov

T— > Connect
demo.groov.com * ;/ Edit
Steve's groov &/ Set as Default
T s ﬁ Delete

@ Cancel

- Connect—Starts the selected connection.

- Edit—Opens the selected connection so you can edit connection settings. The configurator screen
is filled with the data from the selected connection, and the title is the Display name (if configured)
or the hostname of the connection. For information about the options, see “Adding a groov Device
or Server to the Android App.”

—  Setas Default—Sets the selected groov connection as the default so that when you start the groov
View app it bypasses the connection list and opens the default connection automatically. For this to
work, also tap the Settings icon at the top of the screen and turn on Enable Default Connection (see
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“Configuring Android Mobile App Settings”) The default connection is indicated with a check mark.
Only one connection can be the default.

My groov &/ Default connection

demo.groov.com

Steve's groov

—  Delete—Deletes the selected connection from the list.
- Cancel—Exits groov Options.

Configuring Android Mobile App Settings

To configure the Android groov View app settings, tap the gear icon.

Tapthe |

o] B4 & 1:2
GROOV VIEW SETTINGS

. . Enable Default Connection
gearicon My groov V . Automatically launch default groov

connection

demo.groov.com ) :
Connection Timeout...

Steve's groov Timeout in msec. (currently: 1500)

Lock Settings

Lock groov View and groov O
connection settings

Require Passcode...

Require a passcode to edit groov 0
View and groov connection

settings

VERSION INFORMATION

Enable Default Connection—Use this option if you want to bypass the connection list when starting
the groov View app and go directly to the default connection. You will also need to assign a default
connection in the groov Options. See “Connecting, Editing, and Setting a groov Connection as the Default
in the Android App.”

Connection Timeout—Set how long the app will spend trying to connect to the groov device or server.
The timer starts as soon as the Connect menu option is selected.

Lock Settings—When enabled, no devices can be added, modified, or deleted, and the settings
themselves can't be changed. When using this option you'll also want to require a passcode. Otherwise,
anyone can unlock the settings.

Require Passcode—\When enabled, a user on this mobile device must enter a passcode to change the
settings, or add, modify, and delete devices. You'll be prompted to enter a new passcode when you
enable the option.

Navigating Through the groov View Android App

To return to the connection list without closing the current groov connection, simply swipe right. This
works in normal view or with Full Screen enabled (see "Adding a groov Device or Server to the Android
App."The active connection is shown in green.
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My groov /| active connection

jmorris-groov.opto22.com

demo.groov.com

lights.opto22.com

i e e e

«  Toreturn to the current connection, do one of the following:
- Swipe left from the connection list.
—  Tapthe active connection and choose Resume from the menu.
« Todisconnect from the current connection, tap the connection in the list, and choose Disconnect.

«  When you navigate to an external webpage that opens when you tap a URL link in a groov View HM|,
use the navigation bar at the bottom of the page to return to groov View: tap the groov View icon.

Return to groov View

"o e o

USING groov VIEW OVER THE INTERNET

If you're using a PC or mobile device to communicate with groov View over the internet rather than from
inside your local area network, we recommend you use a VPN for security. Talk with your IT Department to get
a VPN set up. For more information on using a VPN, see form 2161, the Guide to Networking groov Products.
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7: Troubleshooting and
Additional Help

This chapter provides troubleshooting information and answers questions you may have about groov View.

In this chapter:

Troubleshooting 153
Working with groov View 160
Opto 22 Systems 161

TROUBLESHOOTING

In addition to the questions and answers in this chapter, see “Viewing Log Messages” on page 88. Admins for
groov may also find it useful to create an Admin-only page to show system information, such as uptime,
number of user sessions, CPU usage, and so on. See “Adding System Tags”on page 51.

Q: In groov View on my laptop/HDTV/phone/tablet, all | see is a blank page.

A: There are two possibilities:

«  Your web browser may not fully support the modern standards groov is based on. Try downloading the
latest version of your browser. Or try a different browser. We generally recommend Firefox or Chrome, but
your device might work better with Safari or Edge.

«  You may be logged in as a user who doesn't have access to any pages. Go to Build mode and check your
users and groups to make sure the user has access. See “Managing User Access”on page 75 for help.

Q: In groov View on my mobile device, | can't get the pages to load.

A: If pages won't load, first, make sure you have at least the minimum OS for your device:
e Android: 4.0.7 (Ice Cream Sandwich)
«  i0S:50

If you're still having problems, here are some things to try.

«  Tryadding your own company domain to the hostname of the groov EPIC controller, groov Edge
Appliance (Box), or groov Server for Windows. Sometimes the DNS (domain name server) won't resolve
the hostname unless you add your domain. Example: instead of https://opto-02-81-c2 try
https://opto-02-81-c2.opto22.com (Your domain will be different. Note the period
between the hostname and domain.)

«  Try adding the port number to the hostname. Port 443 is the default; port 8443 is the secondary, so try
them in that order. For example: instead of https://opto-02-81-c2 try
https://opto-02-81-c2:443 (Note the colon between the hostname and port.)
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Q: In groov View, why are some gadgets grayed out with a yellow triangle?

A: If a gadget is grayed out with a yellow triangle, one of these communication problems is occurring:
«  groovView isn't communicating with the groov EPIC, Server, or Box.

«  groovView isn't communicating with the device the tag comes from (for example, PLC or PAC, OPC UA
server, etc.).

« Ifyou're using the Ignition Edge free trial, the trial has probably expired. See the groov EPIC User's Guide or
the groov Box User’s Guide for steps to restart it or license Ignition Edge.

«  The device the tag comes from (for example, OPC UA server or PLC) is not communicating with your
control system or equipment.

Click the yellow triangle to display an information dialog box.

Click the yellow
triangle

« Ifthe information box says that a tag is not available on a SNAP PAC controller, make sure the strategy
running on that controller matches the idb.txt you have associated with that IP address.

«  Ifthe information box reports “Bad_ShelvingTimeOutOfRange,” your Ignition Edge trial has probably
expired, and the internal OPC UA server cannot be reached.

Once you've fixed communications, groov View will automatically restore the gadget to working order.

NOTE: groov View polls the device (for example, PAC/PLC or OPC UA server) for data once per second. This frequency
cannot currently be changed.

Q: In groov View, why are some gadgets grayed out with a manila tag?

A: If a gadget is grayed out with a no-tag symbol, the gadget does not have a properly configured tag
associated with it.

No-tag symbol

Once you've configured a tag for the gadget, groov View will automatically restore the gadget to working
order.

Q: Why am | not receiving event notifications for properly configured events?

A:You may have lost connection with the device that has the tags (Modbus/TCP device, EPIC, PAC or PLC, OPC
UA server, etc.). If so, groov View cannot check the tags it's supposed to be watching, so you won't receive
event notifications for those tags.

Click the Events (bell) icon to open the Events Viewer. If you see the “Could not connect...”error, you'll need to
track down what happened to your lost connection. Also see “Viewing Events”on page 131.
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2 ‘ Events n o ] Menu"
s

—~—

. Process Recycle on Station 3
Enabled - Inactive
A Event Tag Errors ~

o Could not connect to the controller. groov will keep trying to connect.

Q: In Build mode, where are the dialog box buttons?

A: If you can't see dialog box buttons, your browser's font size may be set too high. Reduce the browser's font
size so that you can see them.

Q: I have groov Server and I'm not able to open groov View.

A: There might be a conflict with another service running on your computer. In this case, you might need to
change one or both of the ports groov Server uses to run.

To change a port number, first consult with your IT manager, and then do the following:

1. Open the jetty.conf file installed on the groov Server computer. You'll find the file in Opto22\groov\jetty.

" jetty.conf - Notepad - O *
File Edit Format View Help
Isslpor't=443

2. Change the port as necessary.
3. Save and close the file.
4. Restart groov Server and try again.

To restart groov Server:
5.  Open the Windows Task Manager and click the Services tab.
6. Right-click groov Server and choose Restart from the pop-up menu.

17l Task Manager - O *
File Options  View

Processes Performance App history Startup Users Details Services

Mame PID Description Status Group G
. gupdatem Google Update Service (gupdatem) Stopped

L gupdate Google Update Service (gupdate) Stopped

£ groov Se o groov Server Running

% FontCact g Windows Presentation Foundation F...  Running

o Fax Stop Fax Stopped

5 EFS Rstarll} Encrypting File System (EFS) Stopped

. diagnost . Microsoft (R) Diagnostics Hub Stand...  Stopped

iy Open Services g

4 DbxSve 5 DbxSve Running

. dbupdat Eeacbionhine Dropbox Update Service (dbupdatem)  Stopped g

e Go to details I W N . - L

Fewer details / Open Services
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Q: I cannot locate my groov EPIC, groov RIO, or groov Box on the network.

A: If your browser can't connect to your groov RIO module, groov EPIC processor, or groov Box using its
hostname, you can use groov Find to locate groov devices on your network. You must use groov Find if your
network does not provide DHCP and DNS services.

For Windows
1. Download groov Find from our website (go to www.opto22.com and search for groov Find). Save the file
to your computer.
2. Open groov Find.
3. Ifyou have User Account Control (UAC) turned on, a message appears asking if you want Find to be
allowed to make changes to your computer. Click Yes to proceed.
®) User Account Control *
Do you want to allow this app from an unknown
publisher to make changes to your PC?
Program name:  groovFind.exe
Publisher: Unknown
File origin: Hard drive on this computer
() Show details Yes
Change when these notifications appear
NOTE 1: If you are using a Windows account that does not have Administrator privileges (such as Guest), you
will need to enter the Administrator User Name and Password in order to use groov Find. If you do not have this
information, contact your IT department.
NOTE 2: Clicking Yes permits Find to have temporary administrative privileges to create an additional temporary
IP address for each network interface on the computer. This enables Find to locate a groov device on a network
that does not have DNS and DHCP. If the network does not have DNS and DHCP, you will need to assign a static
IP address to the groov device in order to maintain communication. (See the device’s user’s guide.) If the network
does have DNS and DHCP, the temporary IP address is not used and is removed when you exit Find.
4. C(lickYes.
groov Find opens and automatically searches for groov devices on the network.
5. Locate the serial number on the groov device.
- On groov EPIC, open the LCD display and look at the label on the back of the display.
—  Onagroov RIO unit, the label is on the unit's side. The serial number is indicated by SN.
- Onagroov Box, find the label on the bottom of the Box.
6. Locate the matching serial number in Find.
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7.
browser: https://<ip address>
the software you want to open.
For Macs
1.
Apple Store ID and password.
2. Click Open.
and displays them in a list.
3. Locate the serial number on the groov device.
4.
Q

A: Try Microsoft Edge, IE11, Chrome, or Firefox instead, if those browsers are available. If you have to use
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@ groov Find

groov Find

Search For Devices

Use the Search For Devices button to find all of the groov Devices that this computer can access.

Find the serial number of your groov Device and select one of its links.

OPTO o2 N

Device Type Serial Hostname 1P Address Open in browser...
Number
GROOV-ARL 695550 opto-03-58-ed 10.192.0.92 groov Admin | groov View
GRV-EPIC-PR1 742527 opto-04-28-57 10.192.32.57 Click to start groov
Manage
GRV-R7- 770617 opto-04-d2-76 10.192.0.7 Click to start groov
MM1001-10 Manage

T
Serial number

On a groov Box, find the label on the bottom of the Box.

Locate the matching serial number in Find and note the groov device’s IP address. Enter this IP address
instead of the hostname as the URL in your browser: https://<ip address>

If you do not see the serial number right away, wait 60 seconds and click Search For Devices.
Note the groov device's IP address. Enter this IP address instead of the hostname as the URL in your

On groov EPIC, open the LCD display and look at the label on the back of the display.
On a groov RIO unit, the label is on the unit’s side. The serial number is indicated by SN.

:I'm having trouble using Internet Explorer 10 with groov View.

Or you can click the link for groov Manage, groov Admin, or groov View, depending on your device and

Go to the App Store and search for Opto 22. On the groov Find app, click Get. If requested, enter your

Within a minute, groov Find begins locating groov RIOs, groov EPICs, and groov Boxes on your network

Internet Explorer 10, do the following steps to make sure the browser is not reverting back to version 9 mode;

groov View is not compatible with Internet Explorer 9.
Open Internet Explorer 10.

If the menu bar is not already showing, right-click anywhere in the top border of the browser and select
the Menu bar option.

1.

2.

v Menu bar
Favorites bar
Command bar
Status bar
Snagit

Adobe PDF P
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3. Open the Tools menu, and make sure that Compatibility View is not selected.

Tools

Delete browsing history... Ctrl+5Shift+Del
InPrivate Browsing Ctrl+Shift+P
,T\rashng Protection... . 3 .’.

smartScreen Filter 4
Manage add-ons

Make sure this optionis — Compatibility View

not selected. Compatibility View settings

Subscribe to this feed...

4. SelectTools > Compatibility View settings.
5. Inthe Compatibility View Settings dialog box, make sure that no groov IP addresses or hostnames are
listed under “Websites you've added to Compatibility View.”

6. Also, make sure that the compatibility options at the bottom of the dialog box are not checked.

Compatibility View Settings (=

Im You can add and remove websites to be displayed in
m Compatibility Yiew.

Add this website:

Add
Websites you've added to Compatibility View:
Make sure no groov IP R —
addresses or hostnames
are listed.

|| Display all websites in Compatibility View
Make sure these <—|:| Display intranet sites in Compatibility View
Sl,?;lcoknesda re not \Dbownload updated compatibility lists from Micresoft
Learn mare by reading the [nternet Explorer privacy statement

Close

7. (lick Close

Q: My cell phone disconnects from groov View after about 30 seconds (groov
Box).

A: The settings on your phone can cause a connection to the soft access point on the GROOV-AR1 to
disconnect.
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If you are a Sprint customer: Try turning off the Connections Optimizer. On your phone, go to Settings >
More... > Mobile Networks > Connections Optimizer and uncheck the box for this feature.

If you are not a Sprint customer: On your phone, go to Settings > Wifi > Advanced and make sure that the
“Avoid poor Internet connection”and “Internet Unavailable” options are not checked.

Q: | can’t read (or write to) my Modbus/TCP device OR the data | get from my
Modbus/TCP device doesn't make sense.

A: Modbus/TCP devices, though based on a standard protocol, may be set up differently from one another.
Some use zero-based addressing and some use one-based addressing. Some devices don't support all
Modbus functions. Modbus/TCP devices also vary in the way they present float data. And device
documentation sometimes doesn't specify how the device is set up.

If you're having trouble reading or writing to your device, or if the data is clearly wrong, start by reading the
explanations in “Adding a Modbus/TCP Device”on page 33. Consult your device's documentation for help,
and change the settings for your Modbus device in Configure > Devices and Tags. You may need to try
different combinations of settings to see what works.

If data from the Modbus device doesn’'t make any sense (looks like garbage or is completely abnormal),
change the “Use base one addressing”setting. Or change the combination of Value Orders.

Probably the best way to figure out how to connect with any Modbus/TCP device and get the data presented
in the right format is to use a Modbus/TCP test utility, like ModScan32 from www.Win-Tech.com. Our Product
Support Group recommends this utility.

You can also use the utility Wireshark (www.wireshark.org) to see the Modbus/TCP traffic between your
devices, so you know exactly what message was sent and what the specific reply was.

If you need help, be sure to contact Opto 22 Product Support (see page 7). Product support is free.

Q: I want to check when my license expires or renew my license, but | don't
see the Licensing item in the Configure menu.
A. If groov View is running on a groov EPIC processor, your license does not expire.

For groov Server or a groov Box, you must be logged into Build mode as an Admin security level user in order
to see licensing information or update your license. If you're logged in as an Editor, you won't see Licensing in
the Configure menu.

NOTE: If you're using a groov Box, it’s easy to confuse groov Admin, the software that administers the Box, with the
Admin user security level in groov View. For licensing, use the Admin username and password for groov View.
Q: Is there a forum for groov View?

A: Yes! There's a groov OptoForum. Find it at www.opto22.com: click Community > Opto Forums and choose
groov from the categories dropdown list. This is the place to ask and answer questions. Experienced engineers
and integrators all over the world contribute to OptoForums, so it's a great way to get help at any time.
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Q: How safe is groov View in terms of information security?

A: groov products use the same security as your bank: the latest 256-bit encryption, plus authentication with
usernames and passwords. For communications over the internet, we recommend a virtual private network
(VPN).

Q: Can | VPN into my groov EPIC?

A: Yes. The groov EPIC processor includes an OpenVPN client. See the groov EPIC USer’s Guide for information
on setting it up.

Q: Can | VPN directly into my groov Box?

A: The groov Box is not a VPN server. Find out if your company network has a VPN server. Many do, usually to
let employees safely access the network from home or a remote site. Most smartphones have a VPN client
built into them. For more information, see form 2161, the Guide to Networking groov Products.

Q: How often does the groov View operator interface update its data?

A: Your interface in groov View polls tags once per second by default. You can change this rate for each device
as needed. See “Working With a Device”on page 27 and follow the steps for your type of device.

Q: Can | change more than one tag with a single gadget, or stack gadgets to
do two things at once?

A: Sorry, not for control. Currently groov View supports only one tag per gadget. And if you stack gadgets, the
one on top wins: it's the only one that will be functional.

From a monitoring standpoint, though, if indicators on the gadget at the back are still visible with another
gadget in front, stacking gadgets can work. See Chapter 4: Gadget Reference for details on each gadget,
including transparency (opacity) options and using images or colors to indicate values within a range.

Q: Can gadgets be restricted to particular operators?

A: Operator permissions are based on a page, so everything on one page must be OK for everyone in a user
group to see and change. If some operators should be able to see a gauge and some should not, for example,
just create two pages—one that includes the gauge and one that doesn’t. Then assign user rights to the
pages appropriately. See “Managing User Groups”on page 80.

A page can be different for operators using it on a desktop or tablet versus those using it on a handheld
device, however. You can stash individual gadgets so they don't appear in one view while still visible in the
other. See “Using the Page Stash” on page 23.

Q: Can you choose who can edit which pages?

A: At present anyone designated as an Editor can edit all pages in one groov View installation (groov EPIC,
groov Server, or groov Box). A second groov product would give you the option to assign different Editors to
different pages.
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OPTO 22 SYSTEMS

Q: I'm talking to Opto 22 equipment and can't find my strategy .idb.txt file.

A: Your groov EPIC or SNAP PAC controller is running the control program (strategy) you built in PAC Control.
When you saved that strategy, the .idb.txt file was automatically created on your PC in the same directory as
your other strategy files. If you're now using a different PC, you'll need to get the .idb.txt file from the other
computer.

If your computer hides common file type extensions (some do), you'll see two files with the same name, the
name of your strategy. Just select the file that does not have the PAC Control icon next to it.

NOTE: Ifyou're using groov View with an OptoEMU Sensor, you can get the OptoEMU Sensor.idb.txt file on
opto22.com.

Q: What's the minimum PAC firmware requirement for groov View?

A: The SNAP PAC controller your groov EPIC, groov Box, or groov Server connects to must be running R9.2 or
higher firmware. If you're using groov View with an OptoEMU Sensor, you need update file R3.0a or higher.

Q: If a PAC controller is connected to B3000 serial brains, can | get those tags
in groov View?

A: Yes. If the tag is in the controller, it can be displayed in groov View.

Q: Can | use groov View to access I/0 points on my SNAP PAC brain?

A: Yes, as of version R3.5a, groov View can access memory map tags on a SNAP PAC I/0 unit. See “Adding an
Opto 22 1/0 Unit"on page 29.

If you need to access legacy I/0 units, it's possible to do so using KEPServerEX (see next question).

Q: Can | use groov View with my FactoryFloor system? | have an Ethernet
card.

A: Yes, but not directly. groov View works with all groov EPIC processors, with SNAP PACs running 9.2 firmware
or higher (SNAP PAC S-series controllers, SNAP PAC R-series controllers, SoftPAC software-based controller),
and with OptoEMU Sensor energy monitoring units running update file R3.0a or newer.

groov View does not work with Opto 22 FactoryFloor, SNAP Ultimate 1/0, SNAP-LCSX, or other legacy
controllers, or pre-9.2 SNAP PACs.

However, it’s still possible to use groov View with these legacy systems by installing KEPServerEX with the OPC
Connectivity Suite. Connect to your FactoryFloor OPC Server (which is an OPC-DA server). Then groov View
(which is an OPC UA client) connects to KEPServerEX, and you can import your tags.

Q: Can | use tables in groov View?

A:You can select individual elements (indexes) of a table. groov View supports all of these data types: integer,
float, and string variables and tables, and analog and digital 1/0.
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OPTO 22 SYSTEMS

Q: How do | use timers/PIDs/Scratch Pad in groov View?

A: groov View supports integer, float, timer, and string variables and tables, and analog and digital I/0. To use
elements in a PID loop, memory-map Scratch Pad elements, or other data you need in a groov View interface,

just periodically move the data you want into a variable.
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A: IP Cameras

The Video gadget works with IP cameras that can serve a single image in response to an http request without
the need for an ActiveX control. Make sure that the IP camera or server is configured to provide a single frame
at a time. IP cameras serve content in a variety of ways, but single-frame display is a very common
configuration option.

We have successfully used the following IP cameras in our projects:
«  Foscam Fi8910w

«  Foscam Fi9802w

«  Vivotek FD8361

«  Vivotek IP8352

If you are using a make or model IP camera other than ones listed here, you can try using one of the example
URLs described in the sections below.
In this appendix:

Serving a Single Image in Response to an HTTP request ..., 163
Setting up the IP Camera’s Username and Password
Foscam IP Cameras
Vivotek IP Cameras
Viewing an IP Camera Outside the Network
Changing the Video Gadget Refresh Period

SERVING A SINGLE IMAGE IN RESPONSE TO AN HTTP REQUEST

groov View does not support streaming. Instead it uses a web browser to retrieve a sequence of images from
an IP camera. Therefore, when you set up a Video gadget you cannot simply paste the IP camera’s IP address
(like you can in your browser). Nor can you use the link that leads to the IP camera video stream. Instead you
need to construct a link that will retrieve a single image from your IP camera is. Your link will look something
like this: http://123.123.123.123/snapshot.cgi

Every IP camera is different, so you will have to look in your IP camera’s documentation to find out what your
specific IP camera uses. It might be called either a snapshot or single shot.

TIP: To find URL information for your IP camera on the Internet, try doing a search using your IP camera model
number and the word “snapshot.”
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SETTING UP THE IP CAMERA'S USERNAME AND PASSWORD

SETTING UP THE IP CAMERA’'S USERNAME AND PASSWORD

If your IP camera requires a password, you will need to include the user name and password in the URL that
the browser passes to the IP camera.

NOTE: Not all IP cameras use the same format, so you will need to refer to your IP camera’s documentation for the
exact syntax.

1. Construct the URL to include the user name and password.
For example:

http://123.123.123.123/snapshot.cgi?user=yourusername&pwd=yourpassword

Make sure to use your IP camera’s IP address and link information, and use the appropriate user name and
password to replace yourusername and yourpassword. If you do not provide the user name and password
in the URL, View will display an empty box instead of the image and prompt you for the user name and
password.

NOTE: The link will not be secure because you are passing the username and password in plain text, so it is easy
to sniff.

2. Openthe URLin a new browser tab.
You should see a static picture.
3. Tryclicking Refresh or Reload in the browser.
If the static picture updates to a new picture, this means you have an IP camera and a URL that will work
with groov View.
4. Copy and paste the URL into the video gadget, and then save the project.
In View the image is refreshed at the rate you set in Configure > Project in Build mode.

NOTE: Itis the browser, not groov View, that polls the IP camera. So the browser (not groov View) needs to have
network access, permissions, and so on to access the IP camera.

If you use this procedure and cannot get the web browser to display a static image from the IP camera, it is not
an issue with groov View. Check the IP camera itself and its configuration, the browser and browser settings,
the network and subnet, and network permissions. For more information, see “Viewing an IP Camera Outside
the Network”on page 165.

FOSCAM IP CAMERAS

Foscam Fi8910w

Sample URL:
http://123.123.123.123/snapshot.cgi?user=U0UU&pwd=PPPP

Change the IP address to match your internal or external IP address. Change UUUU to the username for the IP
camera, and change PPPP to the password for the IP camera.

Foscam Fi9802w
Sample URL:

http://123.123.123.123/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

1. Change the IP address to match your internal or external IP address.

164 groov View User's Guide


http://0.0.0.0/snapshot.cgi?user=yourusername&pwd=yourpassword

CHAPTER

2. Change UUUU to the username for the IP camera, and change PPPP to the password for the IP camera.
3. Ifyouare using a different port than port 80, you will need to add that to the URL.
For example, some Foscam IP cameras use port 88, so 88 is added to the URL as follows:

http://123.123.123.123:88/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

VIVOTEK IP CAMERAS

IP cameras tested:
o Vivotek FD8361
«  Vivotek IP8352

For details on how to construct a URL for a Vivotek IP camera and configure security, see the documentation
that came with the IP camera.

Example URL:
Here is an example of a URL to use with a Vivotek IP camera that is compatible with groov View.

http://opto22.groov.com:8082/cgi-bin/viewer/video.jpg?channel=1&resolution=640x480&quality=3

This IP camera is on port 8082, and it has been configured with a user (viewer) that has no username or
password. Your IP camera may be configured differently.

VIEWING AN IP CAMERA OUTSIDE THE NETWORK

If you wish to view your IP camera image from outside your network, you have two options.

«  Option 1: Make sure your IP camera can be accessed from outside the local area network it is configured
on. Discuss access with your IT department so they can set up a VPN or allow a port forward on your
router to the IP camera.

«  Option 2: Use the Proxy option for the video gadget. In this case groov View will poll the IP camera over

your local area network and present the updated video frames to the client at the rate (in seconds) set on
the video gadget.

CAUTION: Be aware that anyone with access to Build mode can view the username and password to the IP camera
in clear text. This should be accounted for when setting up access to Build mode and access to the IP camera.

CHANGING THE VIDEO GADGET REFRESH PERIOD

The video gadget refresh period sets how often in seconds groov View refreshes the image from an IP camera.
You can set the default update period for all instances of the video gadget, or you can set the refresh period for
an individual instance.

If you have a fast Internet connection and are not concerned about data use, then you can use the fastest
setting (0.5 seconds) for a smoother video. However, if you have a slower connection, the video might not be
able to keep up, and you should set a slower rate by entering a higher value. Also, if you have a data use cap,
you should probably set a slower rate.

Satellite or cell modem networks may require refresh rates of 5 seconds or slower. For example, the default 0.5
seconds may be too fast for some ADSL connections.

To set the default update period for all video gadgets, do the following:
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CHANGING THE VIDEO GADGET REFRESH PERIOD

1. InBuild mode, choose Configure > Project. In the General Settings section, enter a value for the “"Default
video gadget refresh period.”

General Settings

Default video gadget refresh 0.5
period:

seconds

The minimum video refresh rate is 0.5 seconds.

2. C(lick Save Settings (top of page), and then click Close.
To set the update period for an individual video gadget, do the following:

In Build mode, click the video gadget to display the Video Properties. Enter a value for the Update Period.

Video Gadget Properties

Camera URL

.cgi?usr=admin&pwd=masterpassw

pdate period
| p.5 (project default) ‘ SeC

|| Use groovas a proxy

|# Maintain aspect ratio

Test feed
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B: OPC UA Data Types Supported

The table below shows the official Browse Name for OPC UA data types and the corresponding names used in
groov View. The official OPC UA data type names are defined in the UA Specification (Part 5, Section 12). For
information about the data types supported by a specific OPC UA server, see that company's documentation.

OPC UAType groov

Boolean Boolean

String String

SByte Signed Byte

Int16 16-bit Signed Integer
Int32 32-bit Signed Integer
Int64 64-bit Signed Integer
Byte Unsigned Byte

Uint16 16-bit Unsigned Integer
UInt32 32-bit Unsigned Integer
Uint64 64-bit Unsigned Integer
Float Single Float

Double Double Float
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C: Data Simulator Tags

BASIC TAGS

The tags provided with groov View's built-in Data Simulator allow you to experiment with adding tags to

gadgets, configuring the tags, and running your project in groov View. This appendix lists the Data Simulator

tags and briefly describes what they do. The first section describes the Basic Tags. For Advanced Tags, see

page 172.

"Variables” (below)

“General”on page 170

“Square Waves"on page 171

“Sine Waves"on page 172

Variables

Unlike many other tags in the Data Simulator, you can read and write these basic variable tags. There are five

each of boolean, float 32, integer 32, and string data types.

Variable Name Data Type

bool Variable A
bool Variable B
bool Variable C
bool Variable D
bool Variable E
float32 Variable A
float32 Variable B
float32 Variable C
float32 Variable D
float32 Variable E
int32 Variable A
int32 Variable B
int32 Variable C
int32 Variable D
int32 Variable E

boolean
boolean
boolean
boolean
boolean
32-bit float
32-bit float
32-bit float
32-bit float
32-bit float
32-bit integer
32-bit integer
32-bit integer
32-bit integer
32-bit integer
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BASIC TAGS

170

Variable Name Data Type

string Variable A string
string Variable B string
string Variable C string
string Variable D string

string Variable E string

General

The complex and jagged waves have various ranges so that they don't overlap too much when placed on the

same Trend.

Variable Name Data Type Description

Complex Wave A 32-bit float A.complex but smooth wave, composed of various sine waves,
with values ranging from -6 to 6.

Complex Wave B 32-bit float A_complex but smooth wave, composed of various sine waves,
with values ranging from 2 to 14.

Complex Wave C 30-bit float Alcomplex but smooth wave, composed of various sine waves,
with values ranging from 0 to 40.

Complex Wave D 32-bit float A.complex but srpooth wave, composed of various sine waves,
with values ranging from -10 to 10.

Jagged Wave A 32-bit float A jagged wa.lve, composed of various sawtooth patterns, with
values ranging from O to 15.

Jagged Wave B 32-bit float A jagged wgve, composed of various sawtooth patterns, with
values ranging from 5 to 25.

Jagged Wave C 32-bit float A jagged wgve, composed of various sawtooth patterns, with
values ranging from 10 to 40.

Ramp A (0 to 10, 30 sec) 32-bit float A ramp pattern, from 0 to 10, with a 30 second period.

Ramp B (0 to 10, 60 sec) 32-bit float A ramp pattern, from 0 to 10, with a 60 second period.

Sawtooth A (0 to 10, 30 sec)  32-bit float A sawtooth pattern, from 0 to 10, with a 30 second period.
Sawtooth B (0 to 10, 60 sec) 32-bit float A sawtooth pattern, from 0 to 10, with a 60 second period.
Stepper A (0 to 4, 30 sec) 32-bit integer  Steps from values 0 to 4 over a period of 30 seconds.
Stepper B (0 to 9, 60 sec) 32-bit integer  Steps from values 0 to 9 over a period of 60 seconds.
Stepper C (0 to 9, 90 sec) 32-bit integer  Steps from values 0 to 9 over a period of 90 seconds.

Sample Stepper, Sawtooth, and Ramp Waves

Steppers

09:57:00 09:57:30 09:58:00
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Sample Complex and Jagged Waves

- Complex Waves (A and B) - Complex Waves (C and D)

-10

-
14:00 14:00 14:02

Jagged Waves

14:00 14:01 14:02

Square Waves

Variable Name Data Type Description

Square Wave A (1 sec true/false)  boolean

Square Wave B (2 sec true/false)  boolean

Square Wave C (5 sec true/false)  boolean

Square Wave D (10 sec true/false) boolean

Square Wave E (Random period)  boolean

Square Wave F (Random period)  boolean

Square Wave G (Random period)  boolean

A square wave with a period of 2 seconds: TRUE for 1 sec-
ond then FALSE for 1 second

A square wave with a period of 4 seconds: TRUE for 2 sec-
onds then FALSE for 2 seconds

A square wave with a period of 10 seconds: TRUE for 5
seconds then FALSE for 5 seconds

A square wave with a period of 20 seconds: TRUE for 10
seconds then FALSE for 10 seconds

A square wave with random TRUE/FALSE periods. Each
TRUE and FALSE state will be within 2 and 4 seconds.

A square wave with random TRUE/FALSE periods. Each
TRUE and FALSE state will be within 4 and 8 seconds.

A square wave with random TRUE/FALSE periods. Each
TRUE and FALSE state will be within 6 and 12 seconds
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Sine Waves

Wave Name Data Type Description

Cosine (30 sec)  32-bit float Cosine wave with a 30 second period and amplitude of 1
Cosine (60 sec)  32-bit float Cosine wave with a 60 second period and amplitude of 1
Sine (15 min) 32-bit float Sine wave with a 15 minute period and amplitude of 1
Sine (30 min) 32-bit float Sine wave with a 30 minute period and amplitude of 1

(
(
Sine (30 sec) 32-bit float Sine wave with a 30 second period and amplitude of 1
Sine (5 min) 32-bit float Sine wave with a 5 minute period and amplitude of 1

(

Sine (60 sec) 32-bit float Sine wave with a 60 second period and amplitude of 1

Sample Sine Waves

ADVANCED TAGS

“Variables (Extra)” (below)
“Arrays”on page 173
“User Controllable”on page 173

“Static Values”on page 174

Variables (Extra)

These variables have data types that are used less often. Unlike many other tags in the Data Simulator, you can
read and write these variable tags. There are three of each type.
Variable Name ‘ Data Type

float64 Variable A 64-bit float

float64 Variable B 64-bit float

float64 Variable C ~ 64-bit float

int16 Variable A 16-bit integer

int16 Variable B 16-bit integer

int16 Variable C 16-bit integer

int64 Variable A 64-bit integer

int64 Variable B 64-bit integer

int64 Variable C 64-bit integer
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Variable Name ‘
int8 Variable A
int8 Variable B
int8 Variable C
uint16 Variable A
uint16 Variable B
uint16 Variable C
uint32 Variable A
uint32 Variable B
uint32 Variable C
uint64 Variable A
uint64 Variable B
uint64 Variable C
uint8 Variable A
uint8 Variable B
uint8 Variable C

Data Type

8-bit integer

8-bit integer

8-bit integer

16-bit unsigned integer
16-bit unsigned integer
16-bit unsigned integer
32-bit unsigned integer
32-bit unsigned integer
32-bit unsigned integer
64-bit unsigned integer
64-bit unsigned integer
64-bit unsigned integer
8-bit unsigned integer
8-bit unsigned integer

8-bit unsigned integer

Arrays

CHAPTER

The arrays have the most common data types. Like the variables, you can read and write to the elements in

the array tags.

Array Name Data Type

bool Array [100]
float32 Array [100]
int32 Array [100]
string Array [100]

boolean table
32- bit float table
32-bit integer table

string table

User Controllable

There are two user-controllable waves (or patterns) that provide you something to interact with in the groov

View interface.

Ramp A: 0 to 10 is a ramping float32 value that you can start and then clear back to 0.

Sine is a sine wave that you can control for period and amplitude. You can also disable the sine wave, during
which time it has a value of 0.

Wave Name Data Type
Ramp A: 0 to 10 (Clear Flag) boolean
Ramp A: 0 to 10 (Current Value)  32-bit float
Ramp A: 0 to 10 (Start Flag) boolean
Sine (Amplitude, 1 to 1000) 32-bit float
Sine (Enabled Flag) boolean
Sine (Period, 1 to 1000 sec) 32-bit float
Sine (Value) 32-bit float

Notes
A boolean flag to clear the ramp
The current value of the ramp
A boolean flag for starting the ramp
The amplitude of the sine wave (0 to 1000)

The enable flag for the sine way (Setting this tag to False
will disable the sine wave and set its current value to 0.)

The period of the sine wave (1 to 1000 seconds)

The current value of the sine wave.
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ADVANCED TAGS

Sample Ramp and Sine Waves

Ramp A: 0 to 10 (Current Value)

Sine (Value)

14:14 1416 14:18 14:20

Static Values

Start Ramp

Clear Ramp

Period:

Amplitude:

Enabled:

These tags have static values, which means that they never change.

Static Value Name ‘ Data Type Notes
bool Always False boolean Always boolean “false”
bool Always True boolean Always boolean “true*
float32 Always +INF 32-bit float Always float32 “+INF”
float32 Always -INF 32-bit float Always float32 “-INF”
float32 Always 0.0 32-bit float Always float32 “0.0"
float32 Always 1.0 32-bit float Always float32 “1.0*
float32 Always NaN 32-bit float Always float32 “NaN”
float64 Always +INF 64-bit float Always float64 “+INF”
float64 Always -INF 64-bit float Always float64 “-INF”
float64 Always NaN 64-bit float Always float64 “NaN”

int32 Always 0
int32 Always 1

32-bit integer
32-bit integer

Always an int32 “0“
Always an int32 “1“

string Always ABC string Always a string of “ABC*

string Always Opto 22  string Always a string of “Opto 22“
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Index

A B

above limit, 139 backing up project, 92

access Bad_ShelvingTime, 154
limiting users, 77, 80 below limit, 139
logging out all users, 82 blank page, 153
password, 76 browsers, 6

adding Build mode, 2, 9
Data Store, 62 opening in groov Server for Windows, 10
devices and tags, 27 opening on a groov Box, 10
gadgets, 67 Button gadget, 109
groov EPIC controller, 27 button, normally open, 1171
images, 82 byte order, 35

Modbus tags, 36
OPC UA server, 43

Opto 22 1/0 unit, 29 C
PAC Control strategy, 27 camera, 104
page, 20 category
page category, 85 adding, 85
SNAP PAC controller, 27 deleting, 86
system tags, 51 renaming, 87
tags to gadgets, 67 changing
user, 76 APl key, 78
address gadget properties in different layouts, 70
changing device, 63 images, 85
admin security level, 77 user password, 81
aligning gadgets, 71 users, 78
Android z order for Trend pens, 124
app, 3, 144 Checkbox gadget, 108
API, 62 properties, 108
APl key, 76 checking
changing, 78 groov version, 94
finding, 78 classic Trend gadget, 120
generating, /8 Color Ranges (LED gadget), 107
apps for mobile devices, 3, 144 Command Button gadget, 110, 111
Auto Navigator gadget, 103 properties, 110
properties, 103 condition tags, 138
automatic refresh of groov View, 143 configuring

events, 128
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gadget properties, 69
notifications, 133
pens for Trend gadget, 124
controller
adding, 27
deleting, 65
disable communication, 64
editing, 63
copying
gadgets, 70
page, 25
creating
events, 128
page, 20
user, 76
CSV file, 42
downloading Trend pen data to, 125
exporting, 41
importing, 38
cutting gadgets, 70

D

data
downloading Trend pen data, 125
settings for Modbus, 35
types for OPC UA, 167
update frequency, 160
zoom in on Trend gadget, 120
data simulator, 169
Data Store, 62
debounce time, 138
deleting
controller, 65
gadgets, 70
I/0 unit, 65
images, 85
Modbus/TCP device, 65
OPC UA server, 65
page, 24
page category, 86
users, 80
desktop layout, /2
device
adding, 27
disable communication to device, 64
editing information, 63
working with, 27
disable communication
device, 64
disabling events, 130
disconnecting from groov on phone, 158
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Divider gadget, 101
properties, 101
drag page, 26
duplicating a page, 25
dynamic tags, 46

E
editing
device information, 63
images, 85
pages, 160
security level, 77
users, /8
email
setting up, 133
email-to-SMS, 136
enabling events, 130
enlarging a page, 22
equal, 138
event conditions, 138
above limit, 139
below limit, 139
debounce time, 138
equal, 138
hysteresis, 139
inside range, 140
multiple conditions, 140
notequal, 138
outside range, 139
event message log capacity, 133
events
creating, 128
enabling/disabling, 130
notifications, 133
receiving notifications, 135

viewing, 131
expiration, license, 96
exporting

interface pages, 26
Modbus tags (CSV), 41

F

FactoryFloor, 161
finding APl key, 78
firewall, 49

video gadget, 104

G

gadget
Auto Navigator, 103



Button, 109
Checkbox, 108
Command Button, 110, 111
Divider, 101
Group Header, 100
Image, 105
Image Indicator, 117
LED, 107
Level Indicator, 113
Line Header, 107
Momentary Button, 111
Oval, 106
Page Navigator, 102
Range Indicator, 119
Rectangle, 106
Round Gauge, 118
Shape, 106
Slider, 112
Text Area, 114
Text Box, 115
Trend, 120
Value, 116
Video, 104
gadgets
adding, 67
aligning, /1
changing z order, /1
copying, 70
cutting and pasting, 70
locking into position, 71
moving, 69
moving to front or back, 71
multiples, 72
properties, 69
resizing, 69
sizing, 69, 72
stacking, /1
video, 163
video refresh, 90
general settings, 89
Gmail account, 134
graphics, 82
grayed out tags, 154
grid, showing or hiding, 22
groov API, 62
groov EPIC controller, 27
groov Find, 156
groov product
locating on network, 156
groov Server can't open groov, 155
groov View, 3
changing password, 143
logging out, 142

navigation, 142
opening, 141
opening pages, 142
refreshing pages, 143
refreshing pages automatically, 143
resetting project, 94
switching to from Build mode, 92
using over the Internet, 152
groov View, mobile
Android, 3
i0S, 3, 144
groov, updating, 94
Group Header gadget, 100
properties, 100
groups of users, 80

H

handheld layout, 72
help, 153
Opto 22 Product Support, 7
Product Support, 7
hysteresis, 139

|

I/0 unit
adding, 29
deleting, 65

disable communication, 64
idb.txt file, 28, 161
Image gadget, 105
properties, 105
Image Indicator gadget
properties, 117
image library, 82
images
adding, 82
changing, 85
changing view in library, 83
deleting, 85
file types, 82
image library, 82
replacing, 85
uses, 82
importing
interface pages, 26
Modbus tags (CSV), 38
Indicator Button gadget
properties, 109
inside range, 140
interactive Trend gadget, 120
Internet Explorer, 157
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Internet, using groov, 152

i0S app, 144

IP address, 10

IP camera, 104, 163
refresh period, 90

K

KEPServerEX, 43

kiosk
automatic refresh, 143
do not expire login, 90
security level, /7

L

languages, Unicode support, 70
layout
optimizing, 72
types, /2
LED gadget
properties, 107
Level Indicator gadget, 113
properties, 113
license
expiration, 96
updating, 96
limiting
users, 77/
users by groups, 80
Line Header gadget, 101
properties, 101
locating groov product on network, 156
locking gadgets, /1
Log Viewer, 88
logging events, 131
capacity, 133
logging out
all users, 82
of groov View, 142
logo, adding, 82

M

maintenance
expiration date, 96
renewing, 96
update, 96
managing
users, /5
message log, 131
message log capacity, 133
messages, viewing, 88
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min/max values for Trend gadget, 124
mobile apps, 3, 144
mobile devices, 3, 144
Modbus/TCP
adding Modbus device, 33
adding Modbus tags manually, 36
cannot read/write data, 159
creating Modbus tags import file, 38
data, 159
data settings, 35
deleting device, 65
disable communication to device, 64
editing device, 63
exporting Modbus tags import file, 41
importing Modbus tags from CSV file, 42
scaling data, 38
slave ID, 35
tag address, 37
Momentary Button gadget
properties, 111
moving
gadgets, 69
gadgets to front or back, 71
page, 26
multiple conditions, 140

N

Namespace Index, 48
navigation, 102, 103, 110
notequal, 138
notifications, 135
configuring, 133
not being received, 154

O

On/Off Colors (LED gadget), 107
OPCUA

browse name, 167

data types, 167
OPC UA server, 43

adding, 43

deleting, 65

disable communication, 64

editing, 63

Windows firewall, 49
opening

Build mode, 9

groov View, 141
operator security level, 77
Opto 22 controller, 27
Opto 22 1/0 unit, 29



Opto 22 Product Support, 7
OptoEMU Sensor, 161
OptoMMP device
adding, 29
deleting, 65
organizing pages, 85
0S app, 3
outside range, 139
Oval gadget, 106
properties, 106

P

PAC Control
adding strategy, 27
updating tags, 29
Page Navigator gadget, 102
properties, 102
pages
adding, 20
categorizing, 85
deleting, 24
duplicating, 25
editing, 160
exporting, 26
hide grid, 22
importing, 26
navigating between, 102, 103
opening in groov View, 142
organizing, 85
renaming, 25
show grid, 22
size, 22
stash, 23
won't load, 153
password, 76
changing, 81
changing in groov View, 143
IP camera, 164
pasting gadgets, 70
pens for Trend gadget, 124
phone layout, 72
photos, 82
Product Support, 7
project, 138
backing up, 92
exporting and importing pages, 26
restoring, 92
saving, 92
settings, 89
properties
Auto Navigator gadget, 103
Checkbox gadget, 108

Command Button gadget, 110
Divider gadget, 101
gadgets, 69
Group Header gadget, 100
Image gadget, 105
Image Indicator gadget, 117
Indicator Button gadget, 109
LED gadget, 107
Level Indicator gadget, 113
Line Header gadget, 101
Momentary Button gadget, 111
Oval gadget, 106
Page Navigator gadget, 102
Range Indicator gadget, 119
Rectangle gadget, 106
Round Gauge gadget, 118
Shape gadget, 106
Slider gadget, 112
Text Area gadget, 114
Text Box gadget, 115
Trend gadget, 120
Value gadget, 116
Video gadget, 104
properties, gadget
changing in different layouts, 70
proxy, 104

R

Range Indicator gadget, 119
properties, 119
receiving event notifications, 135
Rectangle gadget, 106
properties, 106
refresh period for Video gadget, 90, 165
refresh rate, video, 90, 165
refreshing groov View, 143
automatic refresh, 143
registers for Modbus, 35
release number, checking, 94
removing
page, 24
users, 80
renaming
page, 25
page category, 87
renewing maintenance, 96
replacing images, 85
requirements, system, 6
reset project, 94
resizing gadgets, 69, 72
restoring
to older groov version, 92
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restoring groov project, 92
Round Gauge gadget, 118
properties, 118

adding System, 51
dynamic, 46

grayed out, 154

in data simulator, 169
Modbus/TCP, 42

S static, 45, 46
saving groov project, 92 updating PAC Control strategy, 29
scaling, 38 viewing, 87
security level, 77, 160 Technical Support. See Opto 22 Product Support, /
setting up test email, 135
events, 128 Text Area gadget, 114
notifications, 133 properties, 114
users, /5 Text Box gadget, 115

settings, video refresh period, 165
Shape gadget, 106
properties, 106
simulator, 169
size, of page, 22

properties, 115
text message notifications, 136
text messaging, setting up, 133
text, Unicode support, 70
time stamp, 138

sizing Trend gadget, 120
handles, 69 changing pen z order, 124
multiple gadgets, 72 classic trend, 120

slave ID, 35 configuring pens, 124

Slider gadget, 112
properties, 112
smartphone layout, 72

SMTP server, 135
SNAP 1/0 unit, 29
SNAP PAC controller, 27

downloading pen data, 125

interactive trend, 120

min/max values, 124

properties, 120
troubleshooting, 153

Bad ShelvingTime, 154

SoftPAC, 28 blank page, 153

stacking gadgets, /1 can't open groov (groov Server), 155
STARTTLS, 135 cannot read/write Modbus data, 159
stash, 23 disconnecting from groov on phone, 158
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static IP address, 10
static tags, 45
strategy
adding, 28
idb.txt file, 161
updating tags, 29
system
adding system tags, 51
requirements, 6

T

tablet layout, 72

tag address, 37

tags, 138
adding Data Store, 62
adding gadgets, 67
adding Modbus/TCP device, 33
adding OPC UA server, 43
adding Opto 22 controller, 27
adding Opto 22 1/0 unit, 29
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grayed out tags, 154

Internet Explorer, 157

Log Viewer, 88

notifications not received, 154
Opto 22 Product Support, 7
pages won't load, 153

yellow triangle, 154

U

Unicode support, 70
updating
data, frequency, 160
groov software, 94
license, 96
PAC Control strategy tags, 29
users, /8
User Account Control, 156
username, 76
for IP camera, 164



users
adding, 76
changing, 78
changing password, 81
creating, /6
deleting, 80
groups, 80
kiosk login, 90, 143
limiting access, 80
logging out all users, 82
security level, 77, 160
types, 75

\"

Value gadget, 116

properties, 116
verify tags, 46
version, checking, 94
version, restoring to older groov version, 92
Video gadget, 104

properties, 104

refresh period, 90

setting up camera, 163
video refresh period, 90, 165
video refresh rate, 90
viewing

events, 131

log messages, 88

tags used in events, 87

tags used in the project, 87
VPN, 160

W

web camera, 163
Windows firewall, 49
working with
devices, 27
Write continuously (Slider gadget), 112

Y

yellow triangle, 154

y4

zorder, 71
changing, for Trend pens, 124
zoom, 120
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